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All Rights Reserved
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BioTek® is a registered trademark, and Synergy#, Gen5#, BioStack#, and Take3# are trademarks of
BioTek Instruments, Inc. Harta# is a trademark of Harta Instruments.
Microsoft®, Windows®, and Excel® are either registered trademarks or trademarks of Microsoft
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All other trademarks are the property of their respective holders.
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Contact Information

BioTek® Instruments, Inc.

Highland Park, P.O. Box 998

Winooski, Vermont 05404-0998 USA

Global Service and Support
BioTek instrument service and repair is available worldwide at one of BioTek's International
Service Centers and in the field at your location. To arrange for service or repair of your
instrument, contact the office nearest you; visit www.biotek.com for up-to-date contact
information. For customer service, sales, and technical assistance, refer to the information
below.

Customer Service and Sales

Internet: www.biotek.com

Phone: 888-451-5171 (toll-free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-655-7941

Email: customercare@biotek.com

Service/Technical Assistance Center (TAC)

Phone: 800-242-4685 (toll-free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-654-0638

Email: tac@biotek.com

European Coordination Center/Authorized European Representative
BioTek® Instruments GmbH

Kocherwaldstrasse 34

D-74177 Bad Friedrichshall

Germany

Internet: www.biotek.de

Phone: +49 (0) 7136 9680

Fax: +49 (0) 7136 968 111

Email: info@biotek.de

BioTek Instruments, Inc.
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Revision History

Rev Date Changes

A 7/2015 Initial release to production

B 8/2016 General: Added support for the FluorescenceTest Plate PN 1400006
Preface: Changed the CE information to reflect current CE directive
titles.
Chapter 1, Introduction: Added information about the Absorbance
Test Plate PN 7260551 to the Optional Accessories, updated the
"Materials for Conducting Liquid Tests" chart.
Chapter 2, Installation: Reworded "13. Configure Dispensers" to "13.
Set Dispenser Calibration Values."
Chapter 3, Getting Started: Replaced table showing the various
modules with tables from Marketing, added a note to the "Injectors"
section about referring to the Injection System4Chemical
Compatibility Technical Note.
Chapter 4, Preventive Maintenance and Chapter 5, As-Needed
Maintenance: Updated text to add wording about wringing out the
cleaning cloth so that it is not dripping wet before wiping the
instrument.
Chapter 6, Instrument Qualification: Added information about using
the Absorbance Test Plate PN 7260551; updated R Square values to
include four digits to the right of the decimal point; for the FP Test
materials, clarified that the Invitrogen kit includes two, unused red
polarization solutions. For the TRF materials, corrected the notation
for the Upper Top Filter Cube (dual PMT instruments). For the [SF]
filter-based Sensitivity Test pass/fail criteria, corrected themismatch
between the DL column header and the Top/Bottom criteria.
Appendix D: Added new appendix with sample System Test and
Absorbance Plate Test reports.
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Document Conventions

This icon calls attention to important safety notes.

Warning!
AWarning indicates the potential for bodily harm and tells you how to avoid the
problem.

Caution
A Caution indicates potential damage to the instrument and tells you how to
avoid the problem.

Note Bold text is primarily used for emphasis.

italic
Topics that apply only to specific Synergy Neo2models are proceeded by a
notice in italic, for example, Applies only to Synergy Neo2models with injectors.

This icon calls attention to important information.

BioTek Instruments, Inc.
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Intended Use Statement

The Synergy Neo2 is a hybrid multimodemicroplate reader. The performance characteristics
of the data reduction software have not been established with any laboratory diagnostic
assay. The user must evaluate this instrument and PC-based software in conjunction with
their specific assay(s). This evaluation must include the confirmation that performance
characteristics for the specific assay(s) aremet.

l BioTek Gen5 software package provides the user with instrument control and data
reduction capabilities.

l The Synergy Neo2 can operate with standard robotic systems, such as the Synergy
Neo Stacker and BioStack 4.

l If the instrument has an "IVD" label, it may be used for clinical and nonclinical
purposes, including research and development. If there is no such label, the
instrument may be used only for research and development or other non-clinical
purposes.

Quality Control

It is considered good laboratory practice to run laboratory samples according to
instructions and specific recommendations included in the assay package insert for the test
to be conducted. Failure to conduct Quality Control checks could results in erroneous test
data.

Warranty and Product Registration

Please take a moment to review the warranty information that shipped with your product.
Please also register your product with BioTek to ensure that you receive important
information updates about the product(s) you have purchased.

You can register online through the Customer Resource Center (CRC) at www.biotek.com or
by calling 888-451-5171 or 802-655-4740.

Synergy Neo2 Operator's Manual



Warnings

Operate the instrument on a level, stable surface away from excessive humidity.

Bright light can reduce the linear performance range of the instrument.

Measurement values may be affected by extraneous particles (such as dust) in the
microplate wells. A clean work area is necessary to ensure accurate readings.

When operated in a safe environment according to the instructions in this document,
there are no known hazards associated with the instrument. However, the operator
should be aware of certain situations that could result in serious injury; these may vary
depending on the instrument model. See Hazards and Precautions.

Hazards

The following hazards are provided to help avoid injury:

Warning! Power Rating. The instrument9s power supply or power cord must be
connected to a power receptacle that provides voltage and current within the
specified rating for the system. Use of an incompatible power receptacle may
produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a plug adapter to connect primary power
to the external power supply. Use of an adapter disconnects the utility ground,
creating a severe shock hazard. Always connect the power cord directly to an
appropriate receptacle with a functional ground.

Warning! Internal Voltage. Always turn off the power switch and unplug the power
supply before cleaning the outer surface of the instrument or removing its top case.

Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage into internal
components creates a potential for shock hazard. If a spill occurs while a program is
running, abort the program and turn off the instrument. Wipe up all spills
immediately. Do not operate the instrument if internal components have been
exposed to fluid. Contact BioTek TAC for assistance.

Warning! Potential Biohazards. Some assays or specimens may pose a biohazard.
Adequate safety precautions should be taken as outlined in the assay9s package
insert. Always wear safety glasses and appropriate protective equipment, such as
chemical-resistant rubber gloves and apron.

Warning! Unspecified Use. Failure to operate this equipment according to the
guidelines and safeguards specified in this manual could result in a hazardous
condition.

BioTek Instruments, Inc.
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Warning! Software Quality Control. The operator must follow the manufacturer9s
assay package insert when modifying software parameters and establishing reading
methods. Failure to conduct quality control checks could result in erroneous test
data.

Warning! Reader Data Reduction Protocol. No limits are applied to the raw
measurement data. All information exported via computer control must be
thoroughly analyzed by the operator.

Warning! Laser Beam. Serious eye injury may occur if you stare directly into the
laser beam of the barcode scanner during operation of the scanner. This hazard is
noted by the symbol shown here. Do not look directly into the laser beam during
operation of the scanner.

Warning! Service. Only qualified technical personnel should perform service
procedures on internal components.

Warning! Accessories. Only accessories that meet the manufacturer's specifications
shall be used with the instrument.

Warning! Pinch Hazard. Some areas of the instrument or its components can present
pinch hazards when the instrument is operating. These areas are marked with the
symbol shown here. Keep hands/fingers clear of these areas when the instrument is
operating.

Warning! The instrument with all available modules weights up to 85 lbs. (38.6 kg).
Use two people when lifting and carrying the instrument.

Precautions

The following precautions are provided to help avoid damage to the instrument:

Caution: Service. The instrument should be serviced by BioTek-authorized service
personnel. Only qualified technical personnel should perform troubleshooting and
service procedures on internal components.

Caution: Spare Parts. Only approved spare parts should be used for maintenance. The
use of unapproved spare parts and accessories may result in a loss of warranty and
potentially impair instrument performance or cause damage to the instrument.

Caution: Environmental Conditions. Do not expose the system to temperature
extremes. For proper operation, ambient temperatures should remain within the range
listed in Appendix A, Specifications. Performance may be adversely affected if
temperatures fluctuate above or below this range. Storage temperature limits are
broader.
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Caution: Sodium Hypochlorite. Do not expose any part of the instrument to the
recommended diluted sodium hypochlorite solution (bleach) for more than 20
minutes. Prolonged contact may damage the instrument surfaces. Be certain to rinse
and thoroughly wipe all surfaces.

Caution: Power Supply. Use only the power supply shipped with the instrument.
Operate this power supply within the range of line voltages listed on it.

Caution: Shipping Hardware. The carrier shipping screw and filter reader shipping
bracket must be removed before operating the instrument. They must be reinstalled
before shipping the instrument. Please retain these components in the event the
instrument needs to be returned to BioTek. See Chapter 2, Installation.

Caution: Disposal. Dispose of the instrument according to Directive 2012/19/EU, <on
waste electrical and electronic equipment (WEEE)= or local ordinances.

Caution: Warranty. Failure to follow preventive maintenance protocols may void the
warranty. See Chapter 5, Preventive Maintenance.

Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the user9s responsibility
to ensure that a compatible electromagnetic environment for this instrument is
provided and maintained in order that the device will perform as intended.

Caution: Electromagnetic Compatibility. Do not use this device in close proximity to
sources of strong electromagnetic radiation (e.g., unshielded intentional RF sources),
because these may interfere with the proper operation.

Caution: Barcode Scanner Mirror. Do not scratch or damage the mirror when
unpacking or installing the barcode scanner.

BioTek Instruments, Inc.
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CE Mark

Based on the testing described below and
information contained herein, this instrument bears
the CE mark

Refer to the Declaration of Conformity for specific details.

Directive 2014/30/EU: Electromagnetic Compatibility

Emissions4Class A

The system has been type-tested by an independent, accredited testing laboratory and
found to meet the requirements of EN 61326-1: Class A for Radiated Emissions and Line
Conducted Emissions.

Verification of compliance was conducted to the limits and methods of EN 55011 3 (CISPR
11) Class A. In a domestic environment it may cause radio interference, in which case you
may need to mitigate the interference.

Immunity

The system has been type-tested by an independent, accredited testing laboratory and
found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity. Verification
of compliance was conducted to the limits and methods of the following:

EN 61000-4-2, Electrostatic Discharge Immunity
EN 61000-4-3, Radiated Radio Frequency (RF) Immunity
EN 61000-4-4, Electrical Fast Transient/Burst Immunity
EN 61000-4-5, Surge Immunity
EN 61000-4-6, Conducted Radio Frequency Immunity
EN 61000-4-8, PowerlineMagnetic Field Immunity
EN 61000-4-11, Voltage Dips and Short Interrupts Immunity

Directive 2014/35/EU Low Voltage (Safety)
The system has been type-tested by an independent testing laboratory and was found to
meet the requirements of this Directive. Verification of compliance was conducted to the
limits and methods of the following:

EN 61010-1. "Safety requirement for electrical equipment for measurement, control and
laboratory use. Part 1, General requirements."
EN 61010-2-081. <Particular requirements for automatic and semi-automatic laboratory
equipment for analysis and other purposes.=
EN 61010-2-010. <Particular requirements for laboratory equipment for the heating of
materials.<
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Directive 2012/19/EU: Waste Electrical and Electronic Equipment
Disposal Notice: Dispose of the instrument according to Directive 2012/19/EU, <on waste
electrical and electronic equipment (WEEE)= or local ordinances.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

l Product registration with competent authorities

l EN 61010-2-101. <Particular requirements for in vitro diagnostic (IVD)medical
equipment.=

l Traceability to the U.S. National Institute of Standards and Technology (NIST).

Electromagnetic Interference and Susceptibility

USA FCC CLASS A
RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits for a Class
A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference, in which case the user will be required to correct
the interference at their own expense.

In order to maintain compliance with FCC regulations, shielded cables must be used with
this equipment. Operation with non-approved equipment or unshielded cables is likely to
result in interference to radio and television reception.

Canadian Department of Communications Class A
This digital apparatus does not exceed Class A limits for radio emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadians Department of
Communications.

Le present appareil numerique n'emet pas du bruits radioelectriques depassant les limites
applicables aux appareils numerique de la Class A prescrites dans le Reglement sur le
brouillage radioelectrique edicte par le ministere des Communications du Canada.

BioTek Instruments, Inc.
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User Safety

This device has been type-tested by an independent laboratory and found to meet the
requirements of the following:

l Underwriters Laboratories UL 61010-1

<Safety requirements for electrical equipment for measurement, control and
laboratory use; Part 1: general requirements=

l Canadian Standards Association CAN/CSA C22.2 No. 61010-1

<Safety requirements for electrical equipment for measurement, control and
laboratory use; Part 1: general requirements=

For International User Safety requirements, see page xiii.

Synergy Neo2 Operator's Manual



Safety Symbols

Some of the following symbols may appear on the instrument or accessories:

Alternating current

Courant alternatif

Wechselstrom

Corriente alterna

Corrente alternata

Warning, risk of crushing or pinching

Attention, risque d'écrasement et
pincement

Warnen, Gefahr des Zerquetschens
und Klemmen

Precaución, riesgo del machacamiento
y sejeción

Attenzione, rischio di schiacciare ed
intrappolarsi

Direct current

Courant continu

Gleichstrom

Corriente continua

Corrente continua

Warning, hot surface

Attention, surface chaude

Vorsicht, heiße Oberfläche

Precaución, superficie caliente

Attenzione, superfice calda

Both direct and alternating
current

Courant continu et courant
alternatif

Gleich - und Wechselstrom

Corriente continua y
corriente alterna

Corrente continua e
corrente alternata

Laser radiation: Do not stare into beam

Rayonnement laser: Ne pas regarder
dans le faisceau

Laserstrahlung: nicht in den strahl
blicken

Radiación de laser: No mire fijamente
al rayo

Radiazione di laser: Non stare nel
fascio

Earth ground terminal

Borne de terre

Erde (Betriebserde)

Borne de tierra

Terra (di funzionamento)

Warning, potential biohazards

Attention, risques biologiques
potentiels

Warnung! Moegliche biologische
Giftsoffe

Atención, riesgos biológicos

Attenziones, rischio biologico

BioTek Instruments, Inc.
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Protective conductor
terminal

Borne de terre de protection

Schultzleiteranschluss

Borne de tierra de
protección

Terra di protezione

Caution (refer to accompanying
documents)

Attention (voir documents
d'accompanement)

Achtung siehe Begleitpapiere

Atención (vease los documentos
incluidos)

Attenzione, consultare la doc annessa

On (Supply)

Marche (alimentation)

Ein (Verbindung mit dem
Netz)

Conectado

Chiuso

Consult instructions for use

Consulter la notice d'emploi

Gebrauchsanweisung beachten

Consultar las instrucciones de uso

Consultare le istruzioni per uso

Off (Supply)

Arrêt (alimentation)

Aus (Trennung vom Netz)

Desconectado

Aperto (sconnessione dalla
rete di alimentazione)

In vitro diagnostic medical device

Dispositif médical de diagnostic in vitro

Medizinisches In-Vitro Diagnostikum

Dispositivo médico de diagnóstico in
vitro

Dispositivo medico diagnostico in vitro

Warning, risk of electric
shock

Attention, risque de choc
électrique

Gefährliche elektrische
schlag

Precaución, riesgo de
sacudida eléctrica

Attenzione, rischio di scossa
elettrica

Separate collection for electrical and
electronic equipment

Les équipements électriques et
électroniques font l'objet d'une
collecte sélective

Getrennte Sammlung von Elektro- und
Elektronikgeräten

Recogida selectiva de aparatos
eléctricos y electrónicos

Raccolta separata delle
apparecchiature elettriche ed
elettroniche

Synergy Neo2 Operator's Manual
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Chapter 1

Introduction

This chapter introduces the Synergy Neo2 Hybrid Multi-ModeMicroplate
Reader, describes its hardware and software features, and provides contact
information for technical assistance.

Product Description 2
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Product Description
The Synergy Neo2 is a hybrid multi-modemicroplate reader. Depending on themodel,
Synergy Neo2 detection modes include fluorescence intensity (FI), fluorescence polarization
(FP), time-resolved fluorescence (TRF), luminescence, UV-visible absorbance, and alpha. The
reader is modular, and upgrade options are available; contact BioTek Customer Care for
more information.

The reader is computer-controlled using Gen5 software for all operations, including data
reduction and analysis. The Synergy Neo2 is robot accessible and compatible with the
BioTek Synergy Neo Stacker and BioStack 4. Gen5 supports OLE automation to facilitate the
Synergy Neo29s integration into an automated system.

The Synergy Neo2 can perform reads using barcoded filter cubes or a monochromator.1 The
filter-based system can perform top and bottom fluorescence, luminescence, and alpha
reads. Filter fluorescence uses a xenon flash light source, along with interference filters and
dichroic mirrors for wavelength specificity and up to three photomultiplier tubes (PMTs). To
run a fluorescence polarization protocol, the filter cubemust contain polarizing filters.
Luminescence is measured through an empty filter position in the filter cube; filters can be
used if light filtering is necessary.

Themonochromator-based system, which has both top and bottom probes, is used for
absorbance, fluorescence, and luminescence spectral reads. The xenon lamp allows for both
UV and visible light measurements. Themonochromator provides wavelength selection
from 2303999 nm in 1 nm increments. Available absorbance and fluorescence read methods
are endpoint, area scan, spectral scanning, and pathlength correction. You can use the
monochromator optics for luminescence spectral scanning.

The alpha detection method can be used for endpoint reads using the top filter system in
non-synchronized platemode.

The Synergy Neo2 has 4-Zone temperature control from 4°C over ambient to 65°C. (For
alpha detection mode, the range is 3°C over ambient to 30°C.) Internal plate shaking, with
both linear and orbital modes, is supported to ensure that reagents are properly mixed
prior to reading.

The Synergy Neo2 supports the reading of 6-, 12-, 24-, 48-, 96-, 384, and 1536-well
microplates with 128 x 86mm geometry as well as the Take3 and Take3 Trio Multi-Volume
Plates.

Use ofmicroplates other than those listed here can result in positioning errors during
program execution.

Models with injectors support dual-reagent dispensing to 6-, 12-, 24-, 48-, 96-, and 384-well
microplates. An external dispensemodule pumps fluid from the supply bottles to the two
injectors located inside the instrument.

1This dual light path capability is protected by U.S. patent number 8,218,141.

BioTek Instruments, Inc.
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See Appendix A for performance and technical specifications.

Package Contents
Package contents and part numbers are subject to change. Please contact BioTek Customer
Care with any questions.

Item Part #

Synergy Neo2Operator's Manual 1351000

Power cord set (specific to installation environment):

Europe (Schuko)

USA/International

United Kingdom

Australia/New Zealand

75010

75011

75012

75013

USB cable 75108

Filter cube rack 1030541

Plastic storage bag and Velcro strips

Models with an external dispensemodule (packed separately), with the following accessories:

Injector 8040541

Inlet tubes (2) from supply bottles to syringe drives 7082121

250-µL syringes (2) 7083000

Syringe thumbscrews 19511

Priming plate 8042202

Injector tip priming trough 8042068

Dispensemodule communication cable 75107

Dispensemodule front cover 8042313

Dispensemodule box 8040579

Supply bottles (2, 30mL) 7122609

Supply bottle holders (2) 8042193

Injector tip cleaning stylus and plastic storage bag 2872304

Strap reagent racks (6) 7212035

Synergy Neo2Operator's Manual
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Optional Accessories

Accessory availability and part numbers are subject to change. Please contact BioTek
Customer Care if you have any questions or visit www.biotek.com and use the
Accessories search tool.

Item Part #

7-filter Absorbance Test Plate for absorbance
measurement testing

7260522

Absorbance Test Plate for absorbance
measurement testing at 340 nm

7260551

Synergy Neo2 Product Qualification (IQ-OQ-
PQ) package

1350526

Microplate Barcode Scanner 1030008

Take3Micro-Volume Plate TAKE3

Take3 Trio Micro-Volume Plate TAKE3TRIO

RS-232 serial cable 75034

PCR Tube Adapter Plates 6002072
6002076

BioCell Quartz Vessel 7272051

BioCell Adapter Plate 7270512

Replacement Shipping Materials 1033027 (instrument shipping box), 1033044
(accessories shipping box)
1030539 (carrier shipping bracket [1])
1032190 (carrier shipping bracket screws [2])
1030527 (filter chamber shipping hardware [3])

Fluorescence Test Plate 1400006

Luminometer ReferenceMicroplate (includes
microplate carrier adapter PN #8042263 for
Synergy Neo2)

8030015

Gas controller, CO2 control only 1210012

Gas controller, CO2 and O2 control 1210013

Filter cubes Contact BioTek or visit our website for part
numbers and availability

BioTek Instruments, Inc.
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The Synergy Neo2 is compatible with the Synergy Neo Stacker and BioStack 4. The
stacker rapidly and systematically transfers microplates to and from the instrument9s
microplate carrier. Contact BioTek or visit our website to learn more.

Materials for Conducting Liquid Tests

Manufacturer part numbers are subject to change.

Item Part Number

Absorbance Liquid Tests

BioTek Wetting Agent Solution BTI #7773002

BioTek QC Check Solution #1 (25mL) BTI #7120779

BioTek QC Check Solution #1 (125mL) BTI #7120782

Phosphate-Buffered Saline (PBS) tablets (pH
7.237.6)

Sigma #P4417

³-NADH Powder (³-Nicotinamide Adenine
Dinucleotide, reduced form)

BTI #98233 or
Sigma #N6785-10VL

Fluorescence Liquid Tests

Test Kits

Kit with microplates and test solutions for
conducting Corners/Sensitivity/Linearity (FI)
tests using Sodium Fluorescein and
Methylumbelliferone, and Time-Resolved
Fluorescence (TRF) tests using Europium

BTI #7160010 (contains 7160013, 7160012, and
7160011 described below)

Kit for FI tests using Sodium Fluorescein BTI #7160013

Kit for FI tests using Methylumbelliferone BTI #7160012

Kit for TRF tests using Europium BTI #7160011

Kit for Fluorescence Polarization (FP) test BTI #7160014 or
Invitrogen #P3088

IndividualMaterials

Sodium Fluorescein Powder, 1mg vial BTI #98155

Methylumbelliferone, 10mg vial BTI #98156

Carbonate-Bicarbonate Buffer (CBB) capsules
Sigma #3041

Synergy Neo2Operator's Manual
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Item Part Number

Phosphate-Buffered Saline (PBS) tablets, pH
7.237.6

Sigma #P4417

Sodium Borate, pH 9.18 Fisher Scientific #159532 or equivalent

Injection System Tests

BioTek Green Test Dye BTI #7773003

BioTek Instruments, Inc.
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Product Support and Service

Technical Assistance Center (TAC)
If your instrument or software fail to function properly, if you have questions about how to
use or maintain our products, or if you need to send an instrument to BioTek for service or
repair, please contact our Technical Assistance Center (<TAC=).

TAC is open from 8:30 AM to 5:30 PM (EST), Monday through Friday, excluding standard
U.S. holidays.

n Phone: (800) 242-4685 or (802) 655-4740

n Fax: (802) 654-0638

n E-Mail: tac@biotek.com

n Web:www.biotek.com

Please be prepared to provide the following information:

l Your name and company information, along with a daytime phone or fax number,
and/or an e-mail address

l The product name, model, and serial number

l The instrument software part number and basecode version (available via Gen5 for
the Synergy Neo2 by selecting System > Instrument Control > Information)

l The version of Gen5. From themain Gen5 screen, select Help > About Gen5.

l A copy of the Synergy Neo2 system test results. See page 1.

l For troubleshooting assistance or instruments needing repair, the specific steps
that produce your problem and any error codes displayed in Gen5 (see also
Appendix B, Error Codes)

If you need to return an instrument to BioTek for service or repair, please contact the TAC
for a Service Call Notice and the shipping address. Repackage the instrument according to
the instructions at the end of Chapter 2, Installation.

Applications Support
BioTek9s fully equipped Application Laboratory provides our on-staff scientists with the
means to assist you with the integration of our instrumentation and software with your
unique scientific applications. If you are having difficulty with optimizing fluorescence
sensitivity or integrating a unique data reduction transformation, or you are just looking for
a recommendation on an appropriate fluorophore, contact us.

Phone: (888) 451-5171 E-Mail: applications@biotek.com

Synergy Neo2Operator's Manual
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Product Registration
Please register your product(s) with BioTek to ensure that you receive important
information and updates about the product(s) you have purchased.

Register online through BioTek9s Customer Resource Center (CRC) at www.biotek.com or by
contacting BioTek Customer Care.

Important Pre-Installation Information

This chapter contains installation and setup tasks for a Synergy Neo2 reader
equipped with all of the availablemodules. Your Synergy Neo2may be different.
Perform the installation and setup tasks in the order presented, skipping those that
do not apply to your reader's configuration.

Materials: You will need a Phillips screwdriver to perform some of the steps in this
section. You will also need a small wrench; this item is supplied with the instrument.

Remove the shipping hardware before turning on the instrument.

Reinstall the shipping hardware before repackaging the instrument for shipping.
The carrier shipping bracket should be installed even if moving the instrument from
room to room, or to an adjacent building.

If the carrier is not secured, it will move as the instrument does, and there is a
chance of damage to the carrier assembly.

The instrument with all availablemodules weighs up to 85 lbs. (38.6 kg). Use two
people when lifting and carrying the instrument.

BioTek Instruments, Inc.
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1: Unpack and Inspect the Reader

The Synergy Neo2 should be removed from the box by two people. The instrument
with all availablemodules weighs up to 85 pounds (38.6 kg).

If the packaging materials are in good condition, keep them in case you need to ship
the reader to BioTek for repair or replacement. Using other forms of commercially
available packaging, or failing to follow the repackaging instructions, may void your
warranty. You can order replacement shipping materials (PN 1033027) if necessary. The
shipping box, accessories box, foam caps, and so on are included as a whole set under
this part number and cannot be ordered separately.

During the unpacking process, inspect the packaging, reader, and accessories for
shipping damage. If the reader is damaged, notify the carrier and your BioTek
representative. Keep the shipping boxes and the packaging materials for the carrier's
inspection. BioTek will arrange for repair or replacement immediately.

1. Open the shipping box, remove the instrument from the box, and place it on a
level, stable surface.

2. Place the packaging materials back into the shipping box for reuse if the instrument
needs to be shipped again.

2: Unpack and Inspect the Dispenser

Save all packaging materials. If you need to ship the dispenser to BioTek for
repair or replacement, you must use the original materials. Using other forms of
commercially available packaging, or failing to follow the repackaging
instructions, may void your warranty.

During the unpacking process, inspect the packaging, the dispenser, and
accessories for shipping damage. If the dispenser is damaged, notify the carrier
and your BioTek representative. Keep the shipping boxes and the packaging
materials for the carrier's inspection. BioTek will arrange for repair or
replacement of your dispensemodule immediately.

If applicable, perform these steps to unpack the dispenser.

1. Open the shipping box. Remove the accessories box and foam insert that contains
the injector tubing and bottle holders.

2. Lift out the dispenser and place it on a level surface.

Synergy Neo2Operator's Manual
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3. Open the accessories box and remove its contents. The accessories should include
the dispenser-related items listed under Package Contents and Accessories in
Chapter 1.

4. Place all packaging materials into the shipping box for reuse if the dispenser needs
to be shipped.

3: Unpack and Inspect the Gas Controller (if applicable)
If applicable, perform these steps to unpack the gas controller.

1. Open the shipping box.

2. Lift out the accessories (power supply, tubing, and manual), and set them aside.

3. Lift out the gas controller, and place it on a level surface.

4. Place all packaging materials into the shipping box for reuse if the gas controller
needs to be shipped.

4: Select an Appropriate Location
Install the reader on a level, stable surface in an area where ambient temperatures between
18°C (64°F) and 40°C (104°F) can bemaintained.

For alpha laser reads, the ambient temperature should be no warmer than 30°C (86°F).

Leave at least six inches of space between the instrument9s rear panel and any other object.
This space ensures proper air flow in and out of the instrument.

If you intend to use the bottom filter access door on the left side of the instrument,
ensure that you select a location that allows for easy access to the door.

The reader is sensitive to extreme environmental conditions. Avoid the following:

l Excessive humidity. Condensation directly on the sensitive electronic circuits can
cause the instrument to fail internal self-checks. The humidity must be in the range
of 10385%, non-condensing.

l Excessive ambient light. Bright light may affect the reader9s optics and readings,
reducing its linear range.

l Dust. Readings may be affected by extraneous particles (such as dust) in the
microplate wells. A clean work area is necessary to ensure accurate readings.

BioTek Instruments, Inc.
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If you are installing the Synergy Neo Stacker or BioStack 4 for operation with the
Synergy Neo2, you may wish to seat the instruments in their aligning plates now.
Refer to the Synergy Neo Stacker or BioStack's Operator's Manual for more
information.

5: Remove the Shipping Hardware

Remove all shipping hardware before you turn on the reader.

1. Locate the shipping hardware: carrier shipping bracket and hardware, the top filter
chamber shipping brackets, and, if equipped, the bottom filter chamber shipping
bracket.

Synergy Neo2Operator's Manual
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2. Using a #2 Phillips screwdriver, remove the screws holding the carrier shipping
bracket. Push the carrier off the rear of the bracket, and then lift and withdraw the
bracket from the instrument.

3. Remove the top filter chamber shipping bracket(s).

4. If equipped, remove the bottom filter chamber shipping bracket.

5. Store the shipping brackets and hardware with the original packaging for reuse in
case you need to ship the instrument.

The filter cubes are shipped in a protective case. TheGetting Started chapter explains
when and how to install filter cubes.

BioTek Instruments, Inc.
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6: Install the Power Supply

Power Rating. The instrument must be connected to a power receptacle that
provides voltage and current within the specified rating for the system. Use of an
incompatible power receptacle may produce electrical shock and fire hazards.

Electrical Grounding. Never use a plug adapter to connect primary power to the
instrument. Use of an adapter disconnects the utility ground, creating a severe
shock hazard. Always connect the system power cord directly to an appropriate
receptacle with a functional ground.

1. Locate the power inlet on the left side of the reader.

2. Examine the power supply's plug. It has three small holes and a small groove that
line up with the prongs and a tab inside the power inlet.

3. Insert the plug into the power inlet and finger-tighten the collar of the plug. Plug
the power supply's cord into an appropriate power receptacle.

Do not plug the power supply into a power receptacle until after the power supply is
connected to the instrument.

7: Install the Gas Controller (if applicable)
The gas controller is an external module that enables the user to control CO2 and O2
concentrations inside the attached instrument9s reading chamber. If you purchased the
module for operation with the Synergy Neo2, refer to theGas Controller User Guide for
installation instructions.

8: Install the Dispenser

Place the dispensemodule on top of the reader or on top of the gas controller (if
equipped). Do not place the dispenser next to the reader.

Synergy Neo2Operator's Manual
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Synergy Neo2 with dispenser and with dispenser and gas controller

1. Open the plastic bag containing the injector tube and tips. Remove the clear plastic
shrouds from the tubes.

2. Remove the two inlet tubes from their plastic canisters.

3. Identify the two syringe valves on the dispensemodule. Each is labeled with a left-
pointing arrow.

When installing the inlet and outlet tubes, do not use any tools. Finger-tighten only!

4. Screw the fitting of one inlet tube into the right side of the Syringe 1 valve.

5. Identify the #1 outlet tube, and screw it into the left side of the Syringe 1 valve.

6. Repeat these steps to attach the inlet and outlet tubing for Syringe 2.

It is critical that the tubing is installed in the correct ports. Otherwise, injected fluid may
miss the intended well.

7. Remove the round tubing feed-through cover from the top of the reader (2
screws). Store the cover and screws with the shipping hardware in case the reader
needs to be shipped again.

8. Thread the injector tip holder, with outlet tubing connected to both ports, through
the hole in the top of the reader.

BioTek Instruments, Inc.
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9. Open the reader's top door, and, holding the injector tip holder by the tab, insert
the injector tips into the appropriate holes inside the reader, behind the filter cube
chamber(s).

Removing any filter cubes that are installed in the filter cube chambers may be
necessary to reach the injector tip holes.

Injector tip holder in its
socket
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Amagnet located between the injector tips helps to guide the tips into place and
secures them in the reader.

10. Place the tubing feed-through cover over the hole in the top of the reader, and
finger-tighten the thumbscrews to secure it.

11. Remove the two syringes from their protective boxes. They are identical and
interchangeable.

12. Install both syringes.

l Hold the syringe vertically with the threaded end at the top.

l Screw the top of the syringe into the bottom of the syringe valve. Finger-
tighten only.

l Carefully pull down the bottom of the syringe until it rests inside the hole in
the bracket.

l Pass a thumbscrew up through this hole and thread it into the bottom of the
syringe. Hold the syringe to prevent it from rotating while tightening the
thumbscrew. Finger-tighten only.

BioTek Instruments, Inc.
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13. Locate the dispenser cable. Plug one end into the port on the back of the
dispenser. Plug the other end into the <Dispenser Port= on the left side of the
reader.

14. Locate the injector tip-cleaning stylus, packaged in a small cylinder. Attach the
cylinder to the back of the dispenser for storage.

Perform a visual inspection or a Performance Qualification test after reconnecting the
tubes.

9: Connect the Host Computer
The Synergy Neo2 is equipped with two communication ports: USB and Serial (RS-232). Both
ports are located on the left side of the reader.

l A USB cable is included in the accessories box; the RS-232 cable is available as an
optional accessory.

l Connect one end to the appropriate port on the reader and the other end to the
appropriate port on the host computer.

10: Install Gen5 on the Host Computer

The Synergy Neo2 is controlled by Gen5 software running on a host computer.
There is a certain sequence of events thatmust be followed to ensure that the
software is properly installed and configured. Please follow the instructions
provided in Gen5 Getting Started Guide to install the software.

11: Turn on the Reader

1. If Gen5 is open, close it now.

2. The reader9s power switch is located on the lower-right corner of the front panel.
Turn the reader on. The reader performs a system test. When the test is
completed, the reader extends themicroplate carrier.

The carrier eject button, located above the reader9s power switch, can be used to
extend/retract themicroplate carrier.

When the reader is idle, the light on the carrier eject button is green. When the reader is
busy (when running an assay or a self-test) the light is red. If an error occurs, the light is
red and blinking.
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12: Establish Communication

If using the USB cable, refer to the instructions that shipped with the USB Driver
Software on the Gen5 softwaremedia to install the necessary drivers.

1. Start Gen5 and log in if prompted. The default System Administrator password is
admin.

2. In the Task Manger, select Setup > Go to System Menu.

3. From the Gen5main screen, select System > Instrument Configuration and click
Add Reader.

4. Set the Reader Type to Synergy Neo2, and click OK.

5. Perform one of the following steps:

l Select Plug & Play and click on the Reader Type you are using.

A Synergy Neo2must be connected via USB to the computer and turned on to
appear in the Available Plug & Play Readers list.

l Set the Com Port to the computer9s COM port to which the reader is
connected.

If using the USB cable, the information can be found via theWindows Control
Panel, under Ports in the Hardware/DeviceManager area of System Properties
(e.g., USB Serial Port (COM5)).

6. Click Test Communication. Gen5 attempts to communicate with the reader. If the
communication attempt is successful, return to Gen59s main screen.

Communication Errors
If the communication attempt is not successful, try the following:

l Is the reader connected to the power supply and turned on?

l Is the communication cable firmly attached to both the reader and the computer?

l Did you select the correct Reader Type in Gen5?

l Did you install the USB driver software, if applicable?

l Was the reader allowed to fully complete its power-up self-test before initiating
communication with Gen5?

BioTek Instruments, Inc.
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If you remain unable to get Gen5 and the reader to communicate with each other,
contact BioTek9s Technical Assistance Center.

13: Set Dispenser Calibration Values
Applies only to models equipped with injectors.

Before using the external dispensemodule with the Synergy Neo2, you must set its
calibration values in Gen5.

The calibration values for both dispensers (#1 and #2) are printed on labels affixed to the
rear of the dispensemodule. Each label lists six target calibration value (e.g., 200, 80, 40)
with their actual measured values (e.g., 199.3, 79.7, 39.9). You will enter themeasured
calibration values into Gen5.

1. If you have not already done so, power on the instrument, and establish
communication.

2. In Gen5, go to System > Instrument Configuration, select your instrument, and
click View/Modify.

3. Click Setup, and then select theDispenser 1 tab.

4. On the keyboard, press CTRL+SHIFT+M to enter maintenancemode for the
Dispenser 1window.

5. Enter the syringe calibration values from the corresponding label on the rear of the
dispenser box (see IQ-12, Install the Dispenser).

6. Click Send Volumes, and then click Get Volumes to verify that the entered values
were sent to the instrument.

7. Select theDispenser 2 tab, and repeat steps 4 through 6 for Dispenser 2.

14: Run a System Test
Running a system test will confirm that the reader is set up and running properly, or will
provide an error code if a problem is detected.

1. Turn on the incubator:

l From the Gen5main screen, select System > Instrument Control > Synergy
Neo2.

l Click the Pre-Heating tab.

l Enter a Requested temperature of at least 37°C and click On.
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Wait until the incubator temperature reaches the set point before continuing.
The temperature is displayed on the toolbar in the instrument's icon.

2. From Gen5's main view, select System > Diagnostics > Run System Test. If
prompted to select a reader, select Synergy Neo2 and click OK.

3. When the test is completed, a dialog requesting additional information appears.
Enter the information and click OK.

If a message appears that a pending system test is waiting from the initial power-
up self-test, view the pending system test and repeat steps 2 and 3.

4. The results report appears. Near the top of the report in the Test Results area, the
text should read <SYSTEM TEST PASS.=

l You may wish to print the report and store it with your records. The report
can also be saved as a .txt file.

l The Gen5 software stores system test information in its database; you can
retrieve it at any time.

l Sign and date the report, and store it with your test documentation.

If an error code is returned, refer to Appendix B and look up the code. If the
problem is something you can fix, do so now and run another system test. If the
problem is something you cannot fix, or if the test continues to fail, contact
BioTek9s Technical Assistance Center.

5. Turn off the incubator:

l Select System > Instrument Control > Synergy Neo2.

l Click the Pre-Heating tab and click Off.

15: Test the Injector System

1. If necessary, press the carrier eject button to extend themicroplate carrier.

2. Place the tip priming trough in the rear pocket of the carrier.

3. Place the priming plate on the carrier.
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4. Fill the two reagent bottles with distilled or deionized water. Place the bottles in
their holders, and place the holders directly in front of the syringes. Insert the inlet
tubes into the bottles.

5. From the Gen5main screen, select System > Instrument Control > Synergy Neo2.

6. Click the Prime tab.

7. With Dispenser set to 1, set the Volume to 5000 µL and click Prime.
The syringe should move down and up repeatedly, drawing fluid from the bottle. The
fluid should pump through the tubing and dispense into the priming plate. Examine
the fittings; no leaks should be detected. If leaks are detected, tighten all fittings and
repeat the prime. If leaks are still detected, contact BioTek9s Technical Assistance
Center.

8. When the prime finishes, set Volume to 2000 µL and click Purge to clear the fluid
lines.

9. Set Dispenser to 2 and repeat steps 7 and 8.

10. When finished, remove and empty the priming plate.

11. Return to the Gen5main screen.

The installation and setup process is complete.

Operational/Performance Qualification
Your Synergy Neo2was fully tested at BioTek prior to shipment and should operate
properly following the successful completion of the installation and setup procedures
described in this chapter.
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If you suspect that problems occurred during shipment, if you received the reader back
from BioTek following service or repair, or if regulatory requirements dictate that
Operational/Performance Qualification is necessary, turn to Instrument Qualification now
to learn about BioTek9s recommended OQ/PQ procedures for Synergy Neo2.

A Product Qualification &Maintenance (IQ/OQ/PQ) package for the Synergy Neo2 is
available for purchase (PN 1350526). Contact your local BioTek dealer for more
information.
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Repackaging and Shipping Instructions

Important! Please read all of the information provided below
before preparing the Synergy Neo2 for shipment.

If the reader and/or dispenser has been exposed to potentially hazardous material,
decontaminate it to minimize the risk to all who come in contact with the reader
during shipping, handling, and servicing. Decontamination prior to shipping is
required by the U.S Department of Transportation regulations. See the As-Needed
Maintenance chapter for decontamination instructions.

Remove themicroplate and tip prime trough (if equipped) from the carrier before
shipment. Spilled fluids can contaminate the optics and damage the instrument.

The instrument with all availablemodules weighs up to 85 lbs. (38.6 kg). Use two
people when lifting and carrying the instrument.

The instrument's packaging design is subject to change. If the instructions in this
section do not appear to apply to the packaging materials you are using, please
contact BioTek's Technical Assistance Center for guidance.

Replace the shipping hardware before repackaging the reader. See instructions
below. If you havemisplaced the shipping hardware, please contact BioTek and
order part number 1030009, which includes the following items:

l Carrier shipping bracket [x1] (PN 1030539)

l Carrier shipping bracket screws [x2] (PN 1032190)

l Filter chamber shipping bracket [x3] (PN 1030527)

If you need to ship the Synergy Neo2 to BioTek for service or repair, be sure to use
the original packaging materials. Other forms of commercially available packaging
are not recommended and can void the warranty. You can order replacement
shipping materials (PN 1033027) if necessary. The shipping box, accessories box,
foam caps, and so on are included as a whole set under this part number and
cannot be ordered separately.
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Replace the Shipping Hardware
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1. Open the carrier door and push the carrier into the reader about 2 inches.

2. Place themain carrier shipping bracket (without the hardware) in the read chamber
so that the two holes on the horizontal surface of the bracket slip over the two
studs sticking up from the read chamber floor.

3. Pull the carrier back toward the front of the instrument until it rests against the
foam piece on the sloped part of the shipping bracket.

4. Holding the carrier against the shipping bracket, place one of the screw brackets
against one of the holes at either end of the carrier shipping bracket, so that the
screw is pointing toward the hole in the carrier shipping bracket.

5. Insert the screw so that it passes through both shipping brackets and catches the
threads in the carrier itself.

6. Repeats steps 4 and 5 to install the second screw bracket.

7. Remove all filter cubes from the instrument. Place them into plastic bags, and then
place them into the filter cube case.

8. Install the top filter chamber shipping brackets using the inner mounting screws.

9. If equipped, install the bottom filter chamber shipping bracket using the outer
mounting screw.

Repack the Instrument

1. Contact BioTek TAC for a Service Call Notice (SCN) number and the shipping
address before returning equipment for service.

2. Write the SCN number on the shipping box in large, clear letters.
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3. Include the SCN number in the shipping address label:
BioTek Instruments, Inc.
ATTN: SCN#xxxx
15 Tigan Street
Winooski, Vermont 05404 USA

4. Decontaminate the reader and, if attached, the dispensemodule, according to the
instructions provided in the As-Needed Maintenance chapter.

5. If you will also be shipping the dispensemodule, see Preparing the Dispenser for
Shipment on page 29.

If you are not shipping the dispenser, purge all fluids from the lines, and then
disconnect it from the reader.

6. Place the accessories in the accessories box, then seal the accessories box with
tape.

7. Place the instrument in the large plastic bag, then place it in the interior box,
surrounded by foam boards. Then, place the interior shipping box, surrounded by
the foam corners, into the external shipping box. Refer to the next figure.
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8. Ship the box to BioTek.

Preparing the Dispenser for Shipment

1. If you have not already done so, contact BioTek9s Technical Assistance Center for a
Service Call Notice (SCN) number and the shipping address before returning
equipment for service.

2. Write the SCN number on the shipping box in large, clear letters.

3. Include the SCN number in the shipping address label:
BioTek Instruments, Inc.
ATTN: SCN#xxxxx
15 Tigan Street
Winooski, Vermont 05404 USA

4. Decontaminate the dispenser according to the instructions in the As-Needed
Maintenance chapter. Be sure to purge the dispenser of all fluid when finished.
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5. With the reader on, start Gen5 and select System > Instrument Control > Synergy
Neo2.

6. Perform this step twice, for both dispensers: Click the Prime tab and set the
dispenser number (1 or 2). ClickMaintenance. The syringe bracket lowers itself.
Remove the thumbscrew from underneath the bracket. Carefully unscrew the top
of the syringe from the syringe valve. Lift out the syringe and store it in its original
box.

7. Fully detach the dispenser from the reader. (The screws are stored in the plastic
bag attached to the back of the dispenser.) Set the dispenser aside for the
moment.

8. Remove the tip priming trough and store it in the dispenser accessories bag.

9. Remove the two inlet tubes from the syringe valves and store them in their plastic
canisters.

10. Remove the two outlet tubes from the syringe valves. Attach the clear plastic
shrouds to the fittings of the outlet tubes. Place the tubes in a plastic bag.

11. Remove the front cover from the dispenser.

12. Insert the bottom foam end cap in the dispenser accessories shipping box and
place the accessories in the insert.

13. Insert the bottom foam end cap in the shipping box, and place the dispenser inside
the end cap.

14. Insert the foam insert that holds the reagent bottle holders and injector tubing
into the shipping box and place the bottle holders and tubing in it.

15. Slide the dispenser accessories box into the shipping box.

16. Insert the top foam end cap. Close and seal the outer box with tape, and ship it to
BioTek.
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Modular Design
The Synergy Neo2 is a multi-modemicroplate reader, with a design that allows you to
initially purchase only the detection capabilities you need and then upgrade later as your
requirements expand. Please contact BioTek Customer Care to learn more about your
upgrade options.

Gen5 software is used to control the reader. If the reader is connected and turned on, Gen5
will present only those options that apply to your reader model. For example, if your model
is not equipped with the alpha detection system, alpha will not be available as a detection
method.

Themodule letters form the part number for each Synergy Neo2model. This is indicated on
a label on the reader.

The configurations in the next table include dual top PMTs for fluorescence and
luminescence.

The configurations in the next table include a single top PMT for fluorescence and
luminescence.
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External Components

1 Upper and lower top filter cubes access door

2 Light-blocking microplate carrier access door

3 Microplate carrier eject button

4 Power switch

5 Bottom filter cube access door (if equipped)

6 Entry port for the dispense outlet tubes and injectors (if equipped)
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1: RS232 cable port

2: USB port

3: Dispenser port

4: Barcode reader cable port (with
cover installed)

5: Key for gas controller ports

6: Mixing fan power port

7: Gas controller ports (with cover
installed)

8: Instrument power inlet
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Internal Components

Component Description Page

Barcoded Filter
Cubes

The barcoded filter cubes contain excitation and emission
filters, mirrors, and polarizing filters. Preconfigured cubes are
available from BioTek.

page
36

Injector System
Applies to models with the Dispense module. The syringes
and tubing may require replacement over time. The tubing and
injectors require cleaning at regular intervals.

page
44

Shaking System
The instrument supports six different shake rates from each of
three different shake types: linear, slow orbital, and fast orbital.

page
46

Filter Cubes
The Synergy Neo2 is equipped to use up to three filter cubes to perform filter-based
fluorescence, luminescence, and alpha reads. Each cube consists of excitation and emission
filters, dichroic mirrors, polarizing filters, and/or unique apertures. When placed into the
instrument, the unique component information for each cube is automatically identified via
an internal barcode scanner.

If two or more custom filter cubes (with ID 255) are configured in Gen5, it is the
customer's responsibility to install the correct filter cube when performing a read.

The top filter cubes are accessed through the hinged door on the front of the reader. The
bottom filter cube (if equipped) is accessed through a door on the left side of the reader. See
the photo under External Components on page 34.

Each filter cube is labeled with an ID number (e.g., "107" or "61") and a short description of
its contents and purpose (e.g., "360/460, 485/528" or "FP 485/530, LUM"). Each cube also
has a barcode label that represents this information.

Be careful not to scratch the surface of the barcode label (see below). If the label is
damaged, the Synergy Neo2may have trouble reading it correctly, requiring you to
manually enter the filter cube information in Gen5.
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Filter Cubes and Gen5

Refer to the Gen5 Help system for more detailed information and instructions.

When the Synergy Neo2 reads a new filter cube barcode label, information such as cube
position type, filter and mirror specifications, and PMT location is passed on to Gen5.

You can view the filter cube's ID number by selecting System > Information Configuration >
Synergy Neo2 > View/Modify > Setup. If a location shows "?", either no filter cube is
installed or the system could not read the barcode label. You can manually enter the filter
cube ID number using the Override feature.

You can use the Gen5 Filter Cube Library (System > Optics Library > Filter Cubes) to define
all cubes that you have available at your site and to import filter cube definitions, if
necessary. Read step options in a protocol or experiment will be available for selection
based on the filter cubes that you identify as being "On Site."
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Gen5 also uses the filter cube information to prompt for filter cube installation at runtime, if
necessary.
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Installing or Removing a Filter Cube

Filter cubes can be installed or removed when the instrument is turned on or off, with one
exception:

Do not open the filter cube access doors while a plate is being read (unless Gen5
prompts you to install a particular filter cube). Doing so may affect measurements and
result in invalid data.

Open the top or side access door, as appropriate. Gently slide the filter cube into (or out of)
its chamber, and then close the door. The barcode label will be scanned upon door closure.

Cleaning Filter Cubes

Do not disassemble filter cubes.

Refer to Inspect/Clean Filter Cubes in Preventive Maintenance.

Filter Cubes Available from BioTek

Preconfigured barcoded filter cubes are available for purchase from BioTek; see the list at
www.biotek.com/products/accessories. Please note that part numbers are subject to
change, and new filter cubes may become available. Custom filter cubes are also available.
Contact BioTek Customer Care with any questions.

Custom Filter Cubes

Custom barcoded filter cubes are assembled at BioTek. The information in this section is
for reference purposes.

Custom barcoded filter cubes support single PMT measurements. For dual
simultaneous-measurement filter cubes (e.g., FP, TR-FRET), please contact BioTek.

The Synergy Neo2 supports the use of custom filter cubes. Each custom cube has the same
ID: 255. It is the user's responsibility to ensure that the correct custom filter cube is installed
before performing a read.

The following drawings shows the orientation of the filters inside the cubes.
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Fluorescence Intensity Filter Cube: Use Position 1 or 2
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TRF Filter Cube: Use Position 1 or 2
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FP Filter Cube: Use both Positions 1 and 2
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Luminescence Filter Cube: Use Position 1 or 2
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Creating or Modifying Custom Barcoded Filter Cubes in Gen5

Each custom filter cube ordered from BioTek has the same barcode ID: "255." You must enter
the custom filter cube's information in Gen5.

If you define two or more filter cubes with ID 255, it is your responsibility to install the
correct filter cube when performing a read. To facilitate this, it is recommended to
match the Cube name field in Gen5with the name you write on the cube's label.

To create a new cube:

1. Click System > Optics Library > Filter Cubes > Create Cube.

2. Enter a unique Cube Name.

3. Select the detection type for Position 1 (away from the cube's handle), and then
click Edit.

4. Define information as applicable to the selected detection type. Click Help for
assistance. Click OK with finished.

5. Repeat steps 3 and 4 for Position 2 (closest to the cube's handle), if used.

To modify an existing cube:

1. Click System > Optics Library > Filter Cubes.

2. Select the desired cube and clickModify Cube.

3. Edit information as necessary.

Injector System

The tubing and injectors should be cleaned at least every threemonths. See Preventive
Maintenance, for instructions.

Inspect the injector system daily for leaks, preferably immediately after priming and
whenever tubing changes have been made.

If a syringe is leaking, it may need to be replaced. See As Needed Maintenance, for
instructions.
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Dispense Module

The dispensemodule sits on top of the reader and pumps fluid from the reagent bottles to
the injectors located inside the instrument. Fluid is injected into one well at a time. The
injectors support plate types from 6- to 384-wells.

1 Two 250 µL syringes draw fluid from the supply bottles.

2 Inlet tubes transport fluid from the supply bottles to the syringes.
These tubes are short pieces of opaque PTFE (Teflon) tubing
connected to stainless-steel probes on one end and threaded
fittings on the other end.

3 Solenoid valves allow the fluid drawn from the supply bottles by
the syringe pumps to flow into the outlet tubes.

4 Outlet tubes transport fluid from the syringes into the instrument,
through the tubing ports on the Synergy Neo2's top cover. The
outlet tubes are opaque PTFE tubes with threaded fittings on each
end.

Avoid continuous contact with harsh chemicals. Rinse the fluid path with deionized
water after contact with any strong acid, base, or solvent.

For information on thematerials used in the injection system, refer to Injection
System4Chemical Compatibility Technical Note on the USB flash drive supplied
with the Synergy Neo2.
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See the Preventive Maintenance chapter for cleaning instructions.

Priming the Injector System

Before running a dispense assay, prime the system with the reagent or dispensing fluid. In
addition, tip priming can be performed at the start of an assay and, sometimes, just before
each dispense to a well. The tip prime compensates for any fluid loss at the injector tip due
to evaporation since the last dispense. All priming activities are controlled via Gen5.

If the injector system is not primed adequately, air bubbles can get trapped in the
system and affect injection volumes. Air bubbles in the system can also result in fluid
spraying or scattering inside the reader.

Both types of primes require a fluid reservoir to be present on themicroplate carrier.

l The priming plate is placed on themicroplate carrier for a Prime operation (to
prime the dispense system with fluid).

l The tip priming trough is placed in the rear pocket of the carrier, and is used for
performing the Tip Prime before dispensing. The trough holds up to 1.5mL of
liquid and must be periodically emptied and cleaned by the user.

Do not perform tip priming when using tall plates. Generally, plates with fewer than
96wells are too tall for error-free tip priming; and, tip priming is rarely required for these
larger-volume plates.

The priming tray should be empty before priming and should contain fluid after
priming.

Shaking System
The user can choose six different shake rates from each of three different shake types:
linear, slow orbital, and fast orbital. Each shake rate corresponds to a specific carrier
displacement for one or both axes, ranging from 1mm to 6mm. A linear shake simply
moves the carrier's y-axis back and forth in a line, whereas an orbital shakemoves both
carrier axes to scribe a circle. Each orbital typemay also be selected in a double format, in
which the carrier scribes a figure-eight pattern instead.
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Carrier Shake Definitions

Shake
Type

Displacement
(mm/steps)

Period
(msecs)

Frequency
(Hz)

RPM
Ramp
Profile

Linear 1/6 54.8 18.3 1096 13

2/12 82.0 12.2 731 14

3/18 105.8 9.5 567 15

4/24 121.6 8.2 493 16

5/30 146.3 6.8 410 17

6/36 166.9 6.0 360 18

Slow
orbital

1/6 107.3 9.3 559 19

2/12 164.4 6.1 365 20

3/18 212.5 4.7 282 21

4/24 253.5 3.9 237 22

5/30 292.1 3.4 205 23

6/36 334.2 3.0 180 24

Fast
orbital

1/6 74.3 13.4 807 25

2/12 109.6 9.1 548 26

3/18 141.3 7.1 425 27

4/24 169.0 5.9 355 28

5/30 195.4 5.1 307 29

6/36 222.8 4.5 269 30

Each shake consists of a series of repeated ramped moves for one or both carrier axes. The
sinusoidally defined ramps are used for acceleration and deceleration only; the plateau
section of the ramp is skipped. When an axis reaches the end of the ramp profile, it simply
repeats the ramp in the opposite direction (except for double-orbital shakes, where the y-
axis repeats a ramp twice before changing directions).

The circular pattern of the orbital shake is achieved by starting the carrier's y-axis move
sequence first. When that axis reaches peak speed at the top of its ramp, the carrier's x-axis
begins its own series of repeated moves using the same profile. The axes remain in synch
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but out of phase, with themaximum speed of one always coinciding with theminimum
speed of the other, until the specified shake time has expired.

Maximum Shaking Amplitude Based on Assay Volume and Plate Type

The Synergy Neo2 offers a broad range of shaking speeds and amplitudes. If the wells of a
microplate are almost full, shaking can result in spillage inside the instrument. The following
table is designed to help avoid this issue. Select your microplate type and assay volume,
and you will get the acceptable shake amplitude on your instrument.

Sample
Volume

Linear
Orbital
Slow

Orbital
Fast

Double Orbital
Slow

Double Orbital
Fast

6-well Microplate

033mL
136
mm

136mm 136mm 136mm 136mm

334mL
136
mm

136mm 136mm 136mm 1mm

435mL 1mm 136mm 136mm 136mm 1mm

537mL 1mm 136mm 133mm 1mm No

738mL 1mm No 133mm No No

9mL 1mm No No No No

Sample
Volume

Linear
Orbital
Slow

Orbital
Fast

Double Orbital
Slow

Double Orbital
Fast

12-well Microplate

031.5mL
136
mm

136mm 136mm 136mm 136mm

1.532.5mL
132
mm

136mm 136mm 136mm 1mm

2.533mL
132
mm

136mm No No 1mm

334mL No 136mm No No No
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Sample
Volume

Linear
Orbital
Slow

Orbital
Fast

Double Orbital
Slow

Double Orbital
Fast

24-well Microplate

030.75mL
136
mm

136mm 136mm 136mm 136mm

0.7531mL 1mm 136mm 136mm 136mm 136mm

131.5mL 1mm 136mm 136mm 136mm No

1.532mL 1mm 136mm No 136mm No

Sample
Volume

Linear
Orbital
Slow

Orbital
Fast

Double Orbital
Slow

Double Orbital
Fast

48-well Microplate

030.5mL
136
mm

136mm 136mm 136mm 136mm

0.531mL 1mm 136mm 136mm 136mm 136mm

131.3mL No 136mm 136mm 136mm No

Sample
Volume

Linear
Orbital
Slow

Orbital
Fast

Double Orbital
Slow

Double Orbital
Fast

96-well Microplate

030.25mL
136
mm

136mm 136mm 136mm 136mm

Gen5 Software
BioTek Gen5 software supports all Synergy Neo2 reader models. Use Gen5 to control the
reader, the dispensemodule (if equipped), and the stacker (if equipped); perform data
reduction and analysis on themeasurement values; print or export results; and more. This
section provides brief instructions for working with Gen5 to create protocols and
experiments and read plates. Refer to the Gen5 Help system for more information.

Protocols and Experiments
In Gen5, a protocol contains instructions for controlling the reader and (optionally)
instructions for analyzing and reporting or exporting the data retrieved from the reader. At
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a minimum, a protocol must specify the procedure for the assay you wish to run. After
creating a protocol, create an experiment that references the protocol. You9ll run the
experiment to read plates and analyze the data.

These instructions briefly describe how to create a protocol in Gen5. See the Gen5 Help
system for complete instructions.

1. Create a new protocol.

2. Open the Procedure dialog. If prompted to select a reader, select the Synergy
Neo2 and click OK.

3. Select a Plate Type.

The Plate Type selected in Gen5must match the assay plate. Otherwise, the results of
the read may be invalid. Also, a collision may result with the transport system because
of differing plate dimensions. Be sure to select theUse lid check box, if applicable.

4. Add steps to the procedure for shaking or heating the plate, dispensing fluid,
reading the plate, and more. Click Validate to verify that the reader supports the
defined steps, and then click OK.

Optionally, perform the next steps to analyze and report the results:

5. Open the Plate Layout dialog and assign blanks, samples, controls, and/or
standards to the plate.

6. Open the Data Reduction dialog to add data reduction steps. Categories include
Transformation, Well Analysis, Curve Analysis, and Qualitative Analysis/QC.

7. Create a report or export template via the Report/Export Builders.

8. Select File > Save and give the file an identifying name.

These instructions briefly describe how to create an experiment and then read a plate in
Gen5. See the Gen5 Help system for complete instructions.

1. Create a new experiment using an existing protocol.

2. Select the desired protocol and click OK.

3. Select a plate in themenu tree and read it.

4. When the read is complete, measurement values appear in Gen5. Select the
desired data set from the Data list.

5. Select File > Save and give the file an identifying name.
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Dispense Module Control
This section applies only to models with injectors.

Gen5 is used to perform several dispense functions, such as initialize, dispense, prime, and
purge. The Prime and Purge functions are introduced here. See the Gen5 Help system for
more information.

Priming routines are used to fill the dispense tubing with fluid so that air is not
dispensed first, resulting in an incorrect dispense volume. The purging routines are
used to clean the fluid paths. See also Flushing/Purging the Fluid Path in the
Preventive Maintenance chapter.

Prime

Before running an experiment with a dispense step, prime the system with the fluid to be
used.

1. Place the priming plate on the carrier.

2. Fill the supply bottle with a sufficient volume of the fluid to be used for the prime
and the assay. Insert the appropriate inlet tube into the bottle.

3. In Gen5, select System > Instrument Control > Synergy Neo2 and click the Prime
tab.

4. Select the Dispenser number (1 or 2) associated with the supply bottle.

5. Enter the Volume to be used for the prime. Theminimum recommended prime
volume is 2000 µL.

6. Select a prime Rate, in µL/second.

7. Click Prime to start the process.

8. When finished, carefully remove the priming plate from the carrier and empty it.

If the priming plate is empty, the prime volumewas too low or there is a problem with
the dispense system.

Purge

To save reagent, Gen5 provides the option to purge fluid from the dispense tubing back into
the supply bottle.

1. In Gen5, select System > Instrument Control > Synergy Neo2 and click the Prime
tab.
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2. Select the Dispenser number (1 or 2) associated with the supply bottle.

3. Enter the desired purge Volume in µL (e.g., 2000).

4. Select a prime Rate in µL/second.

5. Click Purge to start the process.

Recommendations for Optimum Performance

General

l Microplates should be clean and free from dust or bottom scratches. Use new
microplates from sealed packages. Do not allow dust to settle on the surface of the
solution; usemicroplate covers or seals when not reading the plate. If reading
plates with covers still installed, do not forget to compensate for this. See the Gen5
Help.

l Filter solutions to remove particulates that could cause erroneous readings.

l Although the Synergy Neo2 supports standard flat, U-bottom, and V-bottom
microplates, the reader achieves optimum performance with flat-bottomed wells
when running in Absorbancemode. See Appendix A, Specifications for more
information on the supported plates.

l Non-uniformity in the optical density of the well bottoms can cause loss of
accuracy, especially with U- and V-bottom polyvinyl microplates. Check for this by
reading an empty microplate. Dual wavelength readings can eliminate this
problem, or bring the variation in density readings to within acceptable limits for
most measurements.

l Inaccuracy in pipetting has a large effect on measurements, especially if smaller
volumes of liquid are used. For best results in most cases, use at least 100 µL per
well in a 96-well plate and 25 µL in a 384-well plate.

l Pipetting solution into 384-well plates often traps air bubbles in the wells, which
may result in inaccurate readings. A dual-wavelength reading method usually
eliminates these inaccuracies. For best results, however, remove the air bubbles
by degassing the plate in a vacuum chamber or spinning the plate in a centrifuge
before reading.

l The inclination of themeniscus can cause loss of accuracy in some solutions,
especially with small volumes. Shake themicroplate before reading to help bring it
within acceptable limits. Use Tween 20, if possible (or some other wetting agent) to
normalize themeniscus for absorbancemeasurements. Some solutions develop
menisci over a period of several minutes. This effect varies with the brand of
microplate and the solution composition. As the center of themeniscus drops and
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shortens the light path, the density readings change. Themeniscus shape will
stabilize over time.

l It is the user9s responsibility to understand the volumetric limits of the plate type
in use as it applies to the assay being run.

l Use UV transparent microplates for UV wavelength reads.

l Use of liquids with concentrations of acids, corrosives, or solvents of 3 percent and
greater can begin attacking thematerials inside the instrument's chamber.
Running multiple plates with concentrations < 3 percent in long kinetics may also
have a destructive effect. If the experiment is incubated, it will accelerate the
deterioration of chamber components. When in doubt about the use of acids,
corrosives, or solvents, please contact TAC@biotek.com.

Read Direction
The Synergy Neo2 performs most reads in a column-wise direction,that is, moving from well
A1, to B1, then C1, and so on. The exception to this is for reads that use sweep speed and
random well reads, which are read in a row-wise fashion.

Luminescence Measurements
For highly sensitive luminescence assays using white plates, add a Delay step to your
procedure to "dark adapt" the plates in the Synergy Neo2's reading chamber before taking
measurements.

Monochromator-Based Fluorescence Systems
Although Time-Resolved Fluorescence can be performed with themonochromator, the
filter-based fluorescence system is more sensitive for TRF and is the better choice.

Models with Injectors

l To keep the dispense system in top condition, flush and purge the fluid lines with
deionized (DI) water every day or upon completion of an assay run, whichever is
more frequent. Some reagents may crystallize or harden after use, clogging the
fluid passageways. Flushing the tubing at the end of each day, letting the DI water
soak, and then purging the lines at the beginning of each day ensures optimal
performance of the dispense system. See the Preventive Maintenance chapter for
more information.

l When dispensing volumes less than or equal to 20 µL/well, we recommend
specifying a tip prime volume that is equal to the dispense volume. For dispense
volumes greater than 20 µL/well, we recommend a tip prime volume of 20 µL.

l To avoid spillage and possible contamination of the instrument, empty the tip
prime trough frequently and do not exceed the total fluid volume of the plate well
when dispensing.
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Using 384-Well Microplates
When using a 384-well microplate, you can use the Gen5 Auto Map feature to ensure you
are using an accurate platemap for your reads. See the Gen5 Help for more information.

Incubation and Partial Plates
When performing a partial plate read that includes an incubation step, the following
recommendations can reduce the effects of evaporation of your samples:

l Usemicroplate lids.

l Fill unused wells with fluid.

l Cluster your sample wells rather than spacing them throughout the plate.

l Place your sample wells in the center of the plate. This placement may lead to less
evaporation than if you place the samples in wells on the edge of the plate.

Alpha Laser Detection
When using alpha detection, ensure that the relative humidity remains below 85% and the
ambient temperature is less than 30°C.
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Preventive Maintenance

This chapter provides instructions for maintaining the Synergy Neo2 and
external dispensemodule (if used) in top condition, to ensure that they
continue to perform to specification.
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Preventive Maintenance Overview
A general preventivemaintenance regimen for all Synergy Neo2models includes periodically
cleaning all exposed surfaces and inspecting/cleaning the filter cubes.

For models with the external dispensemodule, additional tasks include flushing/purging the
fluid path and cleaning the tip prime trough, priming plate, supply bottles, dispense tubing,
and injectors.

Daily Cleaning for the Dispense Module
To ensure accurate performance and a long life for the dispensemodule and injectors, flush
and purge the fluid lines with deionized (DI) water every day or after completing an assay
run, whichever is more frequent. Some reagents may crystallize or harden after use and clog
the fluid passageways. Take special care when using molecules that are active at very low
concentrations (e.g., enzymes, inhibitors). Remove any residual reagent in the dispense
lines using a suitable cleaning solution (review the reagent9s package insert for specific
recommendations).

Flushing the tubing at the end of each day, letting the DI water soak overnight, and then
purging the lines at the beginning of each day ensures optimal performance of the dispense
system. BioTek recommends performing a visual inspection of the dispense accuracy before
running an assay protocol that includes dispense steps.

BioTek also recommends flushing themodule with DI water before conducting the
decontamination procedure described in the As Needed Maintenance chapter.

Models with injectors: Accumulated algae, fungi, or mold may require
decontamination. See the As-Needed Maintenance chapter for complete
decontamination instructions.

Preventive Maintenance Schedule

The risk and performance factors associated with your assays may require performing
some of all of the procedures more frequently than presented in this schedule.
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Task Page Daily Quarterly As Needed

All models:

Clean exposed surfaces page 58 x

Inspect/clean filter cubes page 58 x

Decontamination see note below before shipment or storage

Models with injectors:

Flush/purge the fluid path page 59 x

(Optional) Run Dispense protocol page 60 x

Empty/clean tip prime trough page 61 x

Clean priming plate page 62 x

Clean dispense tubes and injectors page 62 x x

Find decontamination instructions in the As-Needed Maintenance chapter.

Warnings and Precautions
Read the following before performing any maintenance procedures:

Warning! Internal Voltage. Turn off and unplug the instrument for all maintenance
and repair operations.

Important! Do not immerse the instrument, spray it with liquid, or use a dripping-
wet cloth on it. Do not allowwater or other cleaning solution to run into the interior
of the instrument. If this happens, contact BioTek9s Technical Assistance Center.

Important! Do not apply lubricants to themicroplate carrier or carrier track.
Lubricant attracts dust and other particles, which may obstruct the carrier path and
cause errors.

Warning!Wear protective gloves when handling contaminated instruments.
Gloved hands should be considered contaminated at all times; keep gloved hands
away from eyes, mouth, nose, and ears.
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Warning! Mucous membranes are considered prime entry routes for infectious
agents. Wear eye protection and a surgical mask when there is a possibility of
aerosol contamination. Intact skin is generally considered an effective barrier
against infectious organisms; however, small abrasions and cuts may not always be
visible. Wear protective gloves when handling contaminated instruments.

Caution! The buildup of deposits left by the evaporation of spilled fluids within the
read chamber can impact measurements. Be sure to keep System Test records
before and after maintenance so that changes can be noted.

Warning! The instrument with all availablemodules weighs up to 85 lbs. (38.6 kg).
Use two people when lifting and carrying the instrument.

Clean Exposed Surfaces
Exposed surfaces may be cleaned (not decontaminated) with a cloth moistened (not
soaked) with water or water and a mild detergent. You9ll need:

l Deionized or distilled water

l Clean, lint-free cotton cloths

l Mild detergent (optional)

1. Turn off and unplug the instrument.

2. Moisten a clean cotton cloth with water, or with water and mild detergent, then
thoroughly wring it out so that liquid does not drip from it. Do not soak the cloth.

3. Wipe the plate carrier and all exposed surfaces of the instrument.

4. Wipe all exposed surfaces of the dispensemodule (if used).

5. If detergent was used, wipe all surfaces with a cloth moistened with water.

6. Use a clean, dry cloth to dry all wet surfaces.

Models with injectors: If the Tip Priming Trough overflows or other spills occur inside
the instrument, wipe the carrier and the surface beneath the carrier with a dry cotton
cloth. The internal chamber and probes are not customer-accessible. If overflow is
significant, contact BioTek9s Technical Assistance Center with any questions about your
particular model.

Inspect/Clean Filter Cubes
Ambient laboratory air is used to cool the flash bulb, and the filter cubes can become dusty
as a result. Filters should be inspected and cleaned at least every threemonths. You9ll need:
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l Isopropyl, ethyl, or methyl alcohol

l 100% pure cotton balls or high-quality lens-cleaning tissue

l Cloth gloves

l Magnifying glass

Do not touch the filters with your bare fingers!

1. Open the access door on the front of the instrument, and the side door, if
equipped with a bottom filter cube. Slide the filter cubes out of their
compartments.

2. Inspect the glass filters for speckled surfaces or a <halo= effect. This may indicate
deterioration due to moisture exposure over a long period of time.

If you have any concerns about the quality of the filters, contact BioTek TAC.

3. Using cotton balls or lens-cleaning tissuemoistened with a small amount of high-
quality alcohol, clean each filter by lightly stroking its surface in one direction.

4. Use a magnifying glass to inspect the surface; remove any loose threads left from
the cotton ball.

5. Replace the filter cubes and close the door.

Flush/Purge the Fluid Path
Applies only to Synergy Neo2models with injectors.

At the end of each day that the dispensemodule is in use, flush the fluid path using the
Gen5 priming utility. Leave the fluid to soak overnight or over a weekend, and then purge
the fluid before using the instrument again.

This flushing and purging routine is also recommended before disconnecting the outlet
tubes from the reader to prevent a spill. It is required before decontamination to
remove any assay residue prior to applying isopropyl alcohol or sodium hypochlorite.

To flush the fluid path:

1. Fill two supply bottles with deionized or distilled water. Insert the supply (inlet)
tubes into the bottles.

2. Place the priming plate on the carrier.

3. From the Gen5main screen, select System > Instrument Control > Synergy Neo2.
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4. Click the Prime tab and select Dispenser 1.

5. Set the Volume to 5000 µL. Keep the default prime rate.

6. Click Prime to start the process. When the process is complete, carefully remove
the priming plate from the carrier and empty it.

7. Repeat the process for Dispenser 2.

Leave the water in the system overnight or until the instrument will be used again. Purge
the fluid from the system (see below) and then primewith the dispense reagent before
running an assay.

To purge the fluid from the system:

1. Place the inlet tubes in empty supply bottles or a beaker.

2. Select System > Instrument Control > Synergy Neo2.

3. Click the Prime tab and select Dispenser 1.

4. Set the Volume to 2000 µL.

5. Click Purge to start the process.

6. When the purge is complete, repeat the process for Dispenser 2.

After purging the system, you may wish to run a quick Dispense protocol to visually
verify the dispense accuracy (see below) or themore thorough Dispense Accuracy and
Precision Tests (see Instrument Qualification).

Run a Dispense Protocol (Optional)
Applies only to Synergy Neo2models with injectors.

After flushing/purging the system and before running an assay that requires dispense,
visually verify the dispense function.

1. Create a Dispense protocol in Gen5:

a. Create a new protocol with the plate type set to match the plate you will use.

b. Add a Dispense step with the following parameters:

l Select Dispenser 1.

l Set Tip Priming to Before this dispense step and Volume to 10 µL.

l Set the Dispense Volume to 100 µL (or an amount to match your assay
protocol).
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l Adjust the Rate to support the dispensing volume.

l Click OK to close the dialog and add the Dispense step to the procedure.

c. Add another Dispense step with the same parameters; select Dispenser 2.

d. Add a Read step with the following parameters (Gen5 requires a Read step in a
Dispense protocol):

l Select any Detection Method.

l Set the Read Type to Endpoint.

l Click Full Plate, click Clear All, then select wellA1. Click OK.

l Select any wavelength or define one Filter Set.

l Click OK to close the dialog and add the Read step to the procedure.

e. Click OK to close the procedure.

f. Select File > Save and give the protocol an identifying name, such as <Dispense
Observation.=

2. Fill the reagent bottles with a DI water3Tween solution (e.g., add 1mL Tween 20 to
1000mL of deionized water).

3. Create a new experiment using the "Dispense Observation" protocol.

4. Click Read and follow the prompts.

5. When the procedure is complete, visually assess the fluid level in the wells for
accuracy. If the well volume appears to be unevenly distributed, clean the internal
dispense tubes and injectors.

Empty/Clean the Tip Priming Trough
Applies only to Synergy Neo2models with injectors.

The tip priming trough is a removable cup located in the rear pocket of themicroplate
carrier, used for performing the Tip Prime. The trough holds about 1.5mL of liquid and must
be periodically emptied and cleaned by the user. Gen5will instruct you to do this at the
start of an experiment that requires dispensing.

1. Extend themicroplate carrier and carefully remove the tip priming trough from the
carrier.

2. Wash the trough in hot, soapy water. Use a small brush to clean in the corners.

3. Rinse the trough thoroughly and allow it to dry completely.

4. Replace the trough in themicroplate carrier.

Synergy Neo2Operator's Manual



62 | Chapter 4: Preventive Maintenance

Clean the Priming Plate
Applies only to Synergy Neo2models with injectors.

Clean the priming plate regularly to prevent bacteria growth and residue buildup. Wash the
plate in hot, soapy water, using a small brush to clean in the corners. Rinse thoroughly and
allow it to dry completely.

Clean the Dispense Tubes and Injectors
Applies only to Synergy Neo2models with injectors.

The Synergy Neo29s dispense tubes and injectors require routine cleaning, at least quarterly
and possibly more frequently depending on the type of fluids dispensed.

Required Materials

l Protective gloves

l Safety glasses

l Mild detergent

l Clean, lint-free cotton cloths

l Deionized or distilled water

l Stylus (stored in a plastic cylinder affixed to the rear of the dispensemodule or
reader) (PN 2872304)

Remove the Dispense Tubes and Injector Holders

1. Open the door on the front of the reader.

2. Grasp the injector tip holder by the tab and pull it up out of its socket.

3. Using your fingers, remove the thumbscrews securing the light shield to the top of
the reader and slide the shield up the outlets tubes.

4. Slide the injector tip holder through the hole in the top of the reader.

5. Turn each tube9s thumbscrew counterclockwise and gently pull each tube from its
injector tip.

6. On the dispensemodule, turn each outlet tube9s thumbscrew counterclockwise to
disconnect it from the injector.
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Clean the Dispense Tubes and Injectors
Some reagents can crystallize and clog the tubing and injectors. Daily flushing and purging
can help to prevent this, but more rigorous cleaning may be necessary if reagent has dried
in the tubing or injectors.

To clean the dispense tubes, soak them in hot, soapy water to soften and dissolve any
hardened particles. Flush each tube by holding it vertically under a stream ofwater.

To clean the injectors:

1. Gently insert the stylus into each injector tip to clear any blockages. (The stylus is
stored in a plastic cylinder affixed to the rear of the dispensemodule.)

2. Stream water through the pipe to be sure it is clean. If the water does not stream
out, try soaking in hot, soapy water and then reinserting the stylus.

Be careful not to bend the injector tips. A bent tip might not dispense accurately.
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Decontamination
Any laboratory instrument that has been used for research or clinical analysis is considered
a biohazard and requires decontamination prior to handling.

Decontamination minimizes the risk to all who come into contact with the instrument
during shipping, handling, and servicing. Decontamination is required by the U.S.
Department of Transportation regulations.

Persons performing the decontamination process must be familiar with the basic setup and
operation of the instrument.

BioTek Instruments, Inc., recommends the use of the following decontamination
solutions and methods based on our knowledge of the instrument and
recommendations of the Centers for Disease Control and Prevention (CDC). Neither
BioTek nor the CDC assumes any liability for the adequacy of these solutions and
methods. Each laboratory must ensure that decontamination procedures are
adequate for the biohazard(s) they handle.

Wear prophylactic gloves when handling contaminated instruments. Gloved hands
should be considered contaminated at all times; keep gloved hands away from
eyes, mouth, and nose. Eating and drinking while decontaminating instruments is
not advised.

Mucous membranes are considered prime entry routes for infectious agents. Wear
eye protection and a surgical mask when there is a possibility of aerosol
contamination. Intact skin is generally considered an effective barrier against
infectious organisms; however, small abrasions and cuts may not always be visible.
Wear protective gloves when performing the decontamination procedure.

Required Materials
For all Synergy Neo2models:

l Sodium hypochlorite (NaClO, or bleach)

l 70% isopropyl alcohol (as an alternative to bleach)

l Deionized or distilled water

l Safety glasses

l Surgical mask

l Protective gloves

l Lab coat

l Biohazard trash bags
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l 125-mL beakers

l Clean, lint-free cotton cloths

Additional materials for models with the dispensemodule:

l Phillips screwdriver

l Small brush for cleaning the tip priming trough and priming plate

l (Optional)Mild detergent

Procedure for Models without a Dispenser

The sodium hypochlorite (bleach) solution is caustic; wear gloves and eye
protection when handling the solution.

Do not immerse the instrument, spray it with liquid, or use a dripping-wet cloth. Do
not allow the cleaning solution to run into the interior of the instrument. If this
happens, contact the BioTek Service Department.

Turn off and unplug the instrument for all decontamination and cleaning
operations.

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects
of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial bleach is typically
10.0%NaClO; prepare a 1:20 dilution. Household bleach is typically 5.0%NaClO; prepare
a 1:10 dilution.

3. Wet a cloth with the bleach solution or alcohol, then thoroughly wring it out so
that liquid does not drip from it. Do not soak the cloth.

4. Open the plate carrier door and slide out the plate carrier.

5. Wipe the plate carrier and all exposed surfaces of the instrument.

6. Wait 20minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces of the instrument that have been cleaned with the bleach solution or
alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. Reassemble the instrument as necessary.
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9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Procedure for Models with a Dispenser

Perform the Routine Procedure when the Synergy Neo2 is functioning normally. If you
are unable to perform a prime due to a system failure, perform the Alternate Procedure
described on page 70.

Routine Procedure

If disinfecting with sodium hypochlorite (bleach), be sure to flush repeatedly with
deionized water to remove the bleach. After disinfecting with sodium hypochlorite,
perform the rinse procedure provided on page 69.

If disinfecting with alcohol, do not immediately primewith deionized water,
because the drying effect of the alcohol is an important aspect of its disinfectant
properties.

Clean Exposed Surfaces

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects
of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial bleach is typically
10.0%NaClO; prepare a 1:20 dilution. Household bleach is typically 5.0%NaClO; prepare
a 1:10 dilution.

3. Open the plate carrier door and slide out the plate carrier.

4. Wet a cloth with the bleach solution or alcohol, then thoroughly wring it out so
that liquid does not drip from it. Do not soak the cloth.

5. Wipe the plate carrier and the exposed surfaces of the dispenser.

6. Wait 20minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. If the dispenser is installed, purge any fluid (see Flush/Purge the Fluid Path on
page 59) and detach the outlet tubes from the instrument. If it is not installed,
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attach only the dispenser9s communication cable to the instrument. Remove the
supply bottles and their holders.

9. Perform the decontamination procedures described below through page 70.

Decontaminate the Fluid Lines

1. Place a beaker with 20mL of 0.5% sodium hypochlorite solution or 70% isopropyl
alcohol near SYRINGE 1 on the dispenser.

2. Place the SYRINGE 1 inlet tube in the beaker.

3. If you have not already done so, detach the dispenser9s outlet tubes from the
instrument. Place the ends of the outlet tubes in an empty beaker and set the
beaker next to the dispenser.

4. Launch Gen5 and from themain screen select System > Instrument Control, and
click the Prime tab.

5. Select Dispenser 1, enter a Volume of 5000 µL, and keep the default dispense Rate.

6. Place the priming plate on the carrier.

7. Run two prime cycles, for a total of 10,000 µL.

8. Wait at least 20minutes to allow the solution to disinfect the tubing.

9. Remove the inlet tube from the beaker of disinfectant solution.

10. From the Instrument Control dialog, change the Volume to 1000 µL.

11. Run one prime cycle, to flush the disinfectant out of the fluid lines.

12. Empty the beaker containing the outlet tubes. Put the tubes back in the empty
beaker.

13. If sodium hypochlorite (bleach) was used, perform Rinse the Fluid Lines.

Otherwise (or after performing the Rinse procedure), repeat steps 1313 for SYRINGE
2/Dispenser 2.

Rinse the Fluid Lines

Perform this procedure only if decontamination was performed using sodium hypochlorite.

1. Place a beaker containing at least 30mL of deionized water on the dispenser.

2. Place the SYRINGE 1 or 2 inlet tube in the beaker.

3. If you have not already done so, place the outlet tubes in an empty beaker.

4. From the Instrument Control dialog, select Dispenser 1 or 2, set the Volume to
5000 µL, and keep the default dispense Rate.
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5. Run five prime cycles, for a total of 25,000 µL.

6. Pause for 10minutes and then run one prime cycle with 5000 µL. This delay will
allow any residual sodium hypochlorite to diffuse into the solution and be flushed
out with the next prime.

7. Empty the beaker containing the outlet tubes.

8. Wipe all surfaces with deionized water.

9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Clean the Tubing and Injectors

Perform the procedures under Clean the Dispense Tubes and Injectors in Preventive
Maintenance.

Decontaminate the Tip Priming Trough and Priming Plate

1. Remove the tip priming trough from the instrument9s microplate carrier.

2. Wash the tip priming trough and priming plate in hot, soapy water. Use a small
brush or cloth to clean the corners of the trough and plate.

3. To decontaminate, soak the trough and plate in a container of 0.5% sodium
hypochlorite or 70% isopropyl alcohol for at least 20minutes.

l If decontaminating in a bleach solution, thoroughly rinse the trough and
plate with DI water.

l If decontaminating with alcohol, let the trough and plate air dry.

4. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Alternate Procedure
If you are unable to prime the Synergy Neo2 due to a system failure, decontaminate the
instrument and the dispenser as follows:

1. Perform the procedures under Clean the Dispense Tubes and Injectors in
Preventive Maintenance.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects
of bleach are a concern, 70% isopropyl alcohol may be used.
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Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0%NaClO; prepare a 1:20 dilution. Household bleach is typically 5.0%
NaClO; prepare a 1:10 dilution.

3. Slide themicroplate carrier out of the instrument.

4. Wet a cloth with the bleach solution or alcohol, then thoroughly wring it out so
that liquid does not drip from it. Do not soak the cloth.

5. Use the cloth to wipe:

l All exterior surfaces of the instrument

l All surfaces of the plate carrier

l The exposed surfaces of the dispenser, including the syringe valves

6. Remove the tubing and the syringes from the dispenser and soak them in the
bleach or alcohol solution. Wait for 20minutes.

7. Moisten a cloth with DI or distilled water and wipe all surfaces that have been
cleaned with the bleach solution or alcohol.

8. Rinse all tubing and the syringes with DI water.

9. Use a clean, dry cloth to dry all surfaces on the instrument and the dispenser.

10. Reassemble the dispenser as necessary.

11. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Dispenser Syringe Replacement
Refer to the Preventive Maintenance chapter for cleaning procedures you must perform
regularly and also in the case of poor performance (for example, when Dispense Accuracy
and Precision tests fail). If cleaning the dispenser does not eliminate performance problems,
or if a syringe is obviously leaking, perform these instructions to replace a faulty syringe.
Contact BioTek TAC to order replacement syringes.

To change a syringe, first use Gen5 to put the syringe in its maintenance position.

Syringe Maintenance Position

Do not change the syringe position or calibrate the dispensers unless instructed to do
so as part of installation, upgrade, or maintenance.
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Gen5 provides access to syringe setup functions for maintenance and calibration purposes.
When a syringe needs to be installed or replaced, it must first bemoved to its <maintenance
position.=

1. From the Gen5main screen, select System > Instrument Control > Synergy Neo2
and click the Prime tab.

2. Select the appropriate Dispenser number (1 or 2) associated with the syringe.

3. ClickMaintenance. The syringe plunger will move to its furthest-from-home
position. The syringe can then be disconnected from the drive bracket and
unscrewed from the valve.

Replace the Syringe
After using Gen5 to move the syringe into its maintenance position:

1. Using your fingers, unscrew the bottom thumbscrew that secures the syringe,
underneath the bracket. Retain this bottom thumbscrew; it is needed for the
replacement syringe.

2. Unscrew the top thumbscrew to disengage the syringe from the valve.

3. Remove the new syringe from its protective box. (The syringe should already be
assembled in one piece; if it is not, see <Install the Dispenser= in the Installation
chapter.

4. Hold the syringe vertically with the threaded end at the top. Screw the top of the
syringe into the bottom of the syringe valve. Finger-tighten only.

5. Carefully pull down the bottom of the syringe until it rests inside the hole in the
bracket.

6. Pass the thumbscrew (used to hold the old syringe) up through this hole and
thread it into the bottom of the syringe. Hold the syringe from rotating while
tightening the thumbscrew. Finger-tighten only.

7. From the Gen5main screen, select System > Instrument Control > Synergy Neo2.
Click the Prime tab and click Initialize.
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Instrument Qualification Process

This chapter describes the tests that BioTek Instruments, Inc., has
developed for complete qualification of all models of the Synergy Neo2. This
chapter introduces the various test methods, describes thematerials and
relevant Gen5 protocols used to execute the tests, explains how to analyze
test results, and provides troubleshooting tips in the event of a failure.

Instrument Qualification Procedures, starting on page 109, contains the
actual step-by-step test procedures.

System Test 74

Plate Shaker Test 74

Absorbance Testing Overview 74

Luminescence Test 84

Fluorescence Testing 86

Injection System Testing 104

Alpha Detection Test 106
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System Test
Each time the Synergy Neo2 is turned on, it automatically performs a series of tests on the
reader9s motors, lamp, the PMTs, and various subsystems. The duration of this system test
depends on the reader model, and can take a fewminutes to complete. If all tests pass, the
microplate carrier is ejected and the green LED on the carrier switch remains on.

If any test results do not meet the internally coded FailureMode Effects Analysis (FMEA)
criteria established by BioTek, the reader beeps repeatedly and the red LED on the carrier
switch flashes. If this occurs, press the carrier eject button to stop the beeping. If necessary,
initiate another system test using Gen5 to try to retrieve an error code from the reader.

Refer to Appendix B, Error Codes starting on page 157, for information on error codes and
for troubleshooting tips.

Refer to Sample Reports, on page 173, to see a sample System Test Report for Synergy
Neo2.

Plate Shaker Test

This test verifies that themultispeed plate shaker is operating properly. The test involves
creating and running a protocol with shaking enabled for a duration of 30 seconds. The sound
of the carrier shaking is all that needs to be confirmed to verify that the plate shaker is
operating properly.

Absorbance Testing Overview
For models with absorbance capability, BioTek developed a series of tests for the
absorbance system using a combination of solid-state Absorbance Test Plates and liquid
plates. The test plates and thematerials used for creating the liquid plates are available for
purchase from BioTek.

To qualify the absorbance system for the Synergy Neo2, you should perform:

l Absorbance Liquid Test 1 and Absorbance Plate Test (using BTI #7260522) or

l Absorbance Liquid Test 2

Optionally, to qualify operation in the UV range, you should also perform:

l Absorbance Liquid Test 3 or Absorbance Plate Test at 340 nm (using BTI #7260551)

BioTek Absorbance Test Plates
Absorbance Test Plate PN 7260522 uses NIST-traceable neutral density filters to confirm
absorbance specifications in the visible range (4003800 nm). This test plate also contains
precision-machined holes to verify mechanical alignment, and a glass filter in position C6 to
test the wavelength accuracy of themonochromator-based absorbance system.
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Absorbance Test Plate PN 7260551 uses NIST-traceable neutral density filters to confirm
absorbance specifications in the UV range (340 nm).

Every test plate comes with a Test Plate Calibration Certificate, containing a table with
Absorbance OD Standards for each filter at each wavelength supported by the plate. The
certificate for test plate PN 7260522 also contains Wavelength Accuracy Standards tables
with Expected Peak (nm) values with Test Ranges for the C6 glass filter.

Before the Absorbance Plate Test can be performed, the OD Standard values and Expected
Peak/Test Range combinations must be entered into Gen5. Enter and save these values
once initially, and then update them annually when the test plate is recertified by BioTek.

Test Methods
The Absorbance Plate Test is conducted using Gen5 software (System > Diagnostics > Test
Plates) to confirm wavelength accuracy ("Peak Absorbance"); mechanical alignment; and
optical density accuracy, linearity, and repeatability. When complete, Gen5 generates a
results report displaying Pass or Fail for each individual test.

l Peak Absorbance: The BTI #7260522 test plate contains a glass filter in position C6
that is used to check the wavelength accuracy of the absorbancemonochromator.
The filter is scanned across a specified wavelength range in 1-nm increments. The
wavelength(s) ofmaximum absorbance are compared to the expected peak
wavelength(s) supplied on the test plate9s data sheet. The accuracy of the
wavelength should be ± 3 nm (±2 nm instrument, ±1 nm filter allowance).

l Alignment: The test plate has precisely machined holes to confirm mechanical
alignment. The amount of light that shines through these holes is an indication of
whether themicroplate carrier is properly aligned with the absorbance optical
path. A reading ofmore than 0.015 OD for any of the designated alignment holes
indicates that the light is being <clipped= and the reader may be out of alignment.

l Accuracy: The test plate contains NIST-traceable neutral-density glass filters of
known OD values at one or more wavelengths. Actual measurements are
compared against the expected values provided in the test plate9s data sheet.
Since there are several filters with differing OD values, the accuracy across a range
of ODs can be established. Once it is proven that the reader is accurate at these OD
values, the reader is also considered to be linear. To further verify this, you can
perform a linear regression analysis on the test plate OD values in a program such
as Microsoft Excel; an R2 value of at least 0.9900 is expected.

l Repeatability: This test ensures the instrument meets its repeatability
specification by conducting repeated reads of each neutral-density filter on the
test plate and comparing the results.
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Sample Test Report
Refer to the Sample Reports appendix to see a sample Absorbance Plate Test Report for
Synergy Neo2.

Troubleshooting
If a test fails, try the troubleshooting tips below. If the test continues to fail, contact BioTek
TAC.

Important! Do not remove filters from the Absorbance Test Plate. Do not use
alcohol or other cleaning agents, and do not touch the filters with your bare fingers.

If a higher-OD well reports "#N/A" for Min/Max Limit and Result, themeasured OD is
beyond the specified range for Accuracy or Repeatability used with this test, and
therefore no pass/fail determination is made. It does not indicate a test failure.

Peak Absorbance Test

l Check the filter in the C6 position to ensure it is clean. If needed, clean the filter
with lens paper. Do not remove the filter, and do not use alcohol or other cleaning
agents.

l Verify that the Peak wavelength information entered for the plate in Gen5matches
the information provided on the test plate's data sheet.

l Check the calibration due date on the test plate's label. If the test plate is overdue
for recalibration, contact BioTek to schedule service.

l Check themicroplate carrier to ensure it is clear of debris.

Alignment Test

l Ensure that the test plate is properly seated in themicroplate carrier.

l Check the four alignment holes (A1, A12, H1, H12) to ensure they are clear of
debris.

l Check themicroplate carrier to ensure it is clear of debris.

Accuracy Test

l Check the neutral-density filters to ensure they clean (positions C1, D4, E2, F5, G3,
H6). If needed, clean the filters with lens paper. Do not remove any filters, and do
not use alcohol or other cleaning agents.
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l Verify that the wavelength/expected OD values entered for the plate in Gen5
match the information provided on the test plate's data sheet.

l Check the calibration due date on the test plate's label. If the test plate is overdue
for recalibration, contact BioTek to schedule service.

Repeatability Test

l Check the neutral-density filters to ensure there is no debris that may have shifted
between readings and caused changes.

l Check themicroplate carrier to ensure it is clear of debris.

Absorbance Liquid Tests
BioTek Instruments, Inc., has developed a series of liquid test procedures for testing your
reader's absorbance system.

Test Methods

Absorbance Liquid Test 1 confirms repeatability and alignment of the reader when a
solution is used in themicroplate. If these tests pass, then the lens placement and optical
system cleanliness are proven. For the Repeatability portion of this test, two columns
containing a color-absorbing solution are read five times at 405 nm. For each well, an
"allowed deviation" is determined based on its Mean OD and the reader's repeatability
specification. Each well's Standard Deviation must be less than its Allowed Deviation to pass.
To confirm the reader9s mechanical alignment, the plate is rotated 180 degrees in the carrier
(e.g., A1 is now in the H12 position) and the same two columns are read. The initial and new
OD readings are compared, using the reader's accuracy specification. If the two readings in
the samewell do not meet specification, the reader may be out of alignment.

If an Absorbance Test Plate is not available, Absorbance Liquid Test 2may be conducted to
test the instrument's alignment, repeatability, and accuracy by preparing a series of
solutions of varying OD values as described on page 118.

Absorbance Liquid Test 3 is an optional test offered for those sites that must have proof of
linearity at 340 nm. (Alternatively, the BioTek 340 nm Absorbance Test Platemay be used;
see page 74) This test is optional since the Synergy Neo2 has good <front-end= linearity
throughout the specified wavelength range. While the absolute values of the OD cannot be
determined by this test, the results will indicate if there is adequate repeatable absorbance
and a linear slope. This method is dependent upon proper dye dilution and a skilled
pipetting technique. It is expected that the first dilution (mid-level solution) will have an
absorbance value near 75% of that of the stock (high-level) solution, and that the second
dilution (low-level solution) will have an absorbance value near 50% of that of the stock
solution.
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Gen5 Protocol Parameters
The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s). It is possible that your tests will requiremodifications to some
of these parameters, such as the Plate Type.

The Plate Type setting in each Gen5 protocol should match the actual plate in use.

Synergy Neo2 Abs Test 1.prt

Parameter Setting

Plate Type 96WELL PLATE

Two Read Steps

Kinetic loop (one per Read step)
Set a Run Time/Interval combination to read
the plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromators

Read wells
First Read step: A1..H2
Second Read step: A11..H12

Wavelength 405 nm

Read Speed Normal

Delay after platemovement 100msec

Plate Out,In step between loops Text "rotate the plate 180 degrees"
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Synergy Neo2 Abs Test 2.prt

Parameter Setting

Plate Type 96WELL PLATE

Shake Step Linear, 4minutes, default frequency

Two Read Steps

Kinetic loop (one per Read step)
Set a Run Time/Interval combination to read
the plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromators

Step labels
First Read step: "Normal"
Second Read step: "Turnaround"

Read wells Full plate

Wavelength 2 (450 nm, 630 nm)

Read Speed Normal

Delay after platemovement 100msec

Data Reduction
Define two Delta OD transformations (450 3
630 nm), one per Read data set
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Synergy Neo2 Abs Test 3.prt

Parameter Setting

Plate Type 96WELL PLATE

Two Read Steps

Kinetic loop (one per Read step)
Set a Run Time/Interval combination to read
the plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromators

Read wells A1..H6

Wavelength 340 nm

Read Speed Normal

Delay after platemovement 100msec

Results Analysis
The Absorbance Liquid Test Procedures begin on page 116.

Absorbance specifications used with the liquid tests:

Repeatability Specification:

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD

± 3.0% ± 0.005 OD from 2.000 OD to 2.500 OD

Accuracy Specification:

± 1.0% ± 0.010 OD from 0.000 to 2.000 OD

± 3.0% ± 0.010 OD from 2.000 OD to 2.500 OD

Absorbance Liquid Test 1

1. The plate is read five times in the <Normal= position at 405 nm. Calculate theMean
OD and Standard Deviation of those five reads for each well in columns 1 and 2.

2. For each well in columns 1 and 2, calculate the Allowed Deviation using the
repeatability specification for a 96-well plate: ± 1% ± 0.005 OD from 0.000 to 2.000
OD (Mean * 0.010 + 0.005). For each well, its standard deviation should be less than
its allowed deviation.
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Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result in a
mean of 0.8004 and a standard deviation of 0.0018. Themean multiplied by 1.0%
(0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this is the
allowed deviation for well A1. Since the standard deviation for well A1 is less than
0.013, the well meets the test criteria.

3. The plate is read five times in the <Turnaround= position at 405 nm. Calculate the
Mean OD of those reads for each well in columns 11 and 12.

4. Perform a mathematical comparison of theMean values for each microwell in its
Normal and Turnaround positions (that is, compare A1 to H12, A2 to H11, B1 to
G12,& H2 to A11). To pass the test, the differences in the compared mean values
must be within the accuracy specification for a 96-well microplate: ± 1.0% ± 0.010
OD from 0.000 to 2.000 OD.
Example: If themean value for well A1 in the Normal position is 1.902with a specified
accuracy of ± 1.0% ± 0.010 OD, then the expected range for themean of the well in its
Turnaround (H12) position is 1.873 to 1.931 OD. 1.902 x 0.010 + 0.010 = 0.029; 1.902 -
0.029 = 1.873; 1.902 + 0.029 = 1.931.

Absorbance Liquid Test 2

1. The plate is read five times at 450/630 nm ("Normal" position), resulting in five sets
of Delta OD data. Calculate results for Linearity:

a. Calculate themean absorbance for each well, and average themeans for each
concentration.

b. Perform a regression analysis on the data to determine if there is adequate
linearity. Since it is somewhat difficult to achieve high pipetting accuracy when
conducting linear dilutions, an R2 value of at least 0.9900 is considered
adequate.

2. Calculate the results for Repeatability:

a. Calculate theMean and Standard Deviation for the five readings taken at each
concentration. Only one row of data needs to be analyzed.

b. For each Mean below 2.000 OD, calculate the Allowed Deviation using the
Repeatability specification for a 96-well plate of ±1.0% ±0.005 OD. (If above 2.000
OD, apply the ±3.0% ±0.005 specification.)

c. The Standard Deviation for each set of readings should be less than the Allowed
Deviation.

d. Example: Readings of 1.950, 1.948, 1.955, 1.952, and 1.950will result in a Mean of
1.951, and a Standard Deviation of 0.0026. TheMean (1.951)multiplied by 1.0%
(1.951 x 0.010) = 0.0195, which, when added to the 0.005 (0.0195 + 0.005) =
0.0245OD, which is the Allowed Deviation. Since the Standard Deviation is less
than this value, the reader meets the test criteria.
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3. After gathering data for the Linearity Test, the plate is read fivemore times with the
A1well in the H12 position ("Turnaround" position). This results in values for the
four corner wells that can be used to assess alignment. Calculate results for the
Alignment Test:

a. Calculate themeans of the wells A1 and H1 in the Normal plate position (data
from Linearity Test) and in the Turnaround position.

b. Compare themean reading for well A1 to its mean reading when in the H12
position. Next, compare themean values for the H1well to the samewell in the
A12 position. The difference in the values for any two corresponding wells
should be within the Accuracy specification for 96-well plates. If the four corner
wells are within the accuracy range, the reader is in alignment.

Example: If themean of well A1 in the normal position is 1.902, where the
specified accuracy is ±1.0% ±0.010 OD, then the expected range for themean of
the samewell in the H12 position is 1.873 to 1.931 OD. (1.902 x 1.0% = 0.019 +
0.010 = 0.029, which is added to and subtracted from 1.902 for the range.)

Absorbance Liquid Test 3

1. The plate is read five times at 340 nm. For each well, calculate theMean OD and
Standard Deviation of the five readings.

2. For each Mean calculated in step 1, calculate the Allowed Deviation using the
Repeatability specification for a 96-well plate (Mean OD x 0.010 + 0.005). For each
well, its Standard Deviation should be less than its Allowed Deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result in a
Mean of 0.8004 and a Standard Deviation of 0.0018. TheMean multiplied by 1.0%
(0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this is the
Allowed Deviation for well A1. Since the Standard Deviation for well A1 is less than
0.013, the well meets the test criteria.

3. Calculate results for Linearity:
l For each of the three test solutions, calculate the averageMean OD for

the wells containing that solution (mean of wells A1 to H2, A3 to H4,
and A5 to H6).

l Perform a regression analysis on the data to determine if there is
adequate linearity. The three averageMean OD values are the <Y=
values. The solution concentrations are the <X= values (1.00, 0.75,
0.50). Since it is somewhat difficult to achieve high pipetting accuracy
when conducting linear dilutions, an R2 value of at least 0.9900 is
considered adequate.
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Troubleshooting
If an absorbance liquid test fails, try the following. If a test continues to fail, contact BioTek
TAC.

l Check themicrowells and plate carrier for debris that may have shifted and caused
changes.

l Ensure themicroplate is properly seated in the carrier.

l As applicable, confirm that the plate was properly oriented in the "Normal" and
"Turnaround" positions.

l Liquid Test 1 can fail due to themeniscus effect, which can cause readings to
decrease over time. If you suspect this may be the case, include a shake step
between the read steps in the protocol.
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Luminescence Test
For models with luminescence capability, BioTek uses the Harta Luminometer Reference
Microplate to test the luminescence system. The test plate is LED-based and NIST-traceable.
Contact BioTek to purchase a plate (BTI #8030015; includes microplate carrier adapters) or
visit www.HartaInstruments.com to learn more.

Test Method
The Harta Luminometer ReferenceMicroplate is used to determine a detection limit by
leveraging a known correlation of 35 photons per attomole of ATP. By using the NIST data
provided with the Harta plate in photons/s, a conversion factor of 0.02884
attomole/photon is applied to determine an ATP concentration and subsequent limit of
detection for the instrument under test.

Gen5 Protocol Reading Parameters

The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s).

Neo 2_LumTest_Harta.prt

Parameter Default Setting

Plate Type: 8030015 Harta - w/o 8032028 adapater

Delay Step: 3minutes

Read Step 1:

Detection Method: Luminescence

Read Type: Endpoint

Step Label: Reference well A2

Read Wells: A2

Light path 1: LUM (Single PMT)

Optics position: Top

Gain: 200

Integration Time: 0:10.00MM:SS.ss

Delay After PlateMovement: 0msec

Read Height: 10.00mm

Read Step 2:
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Parameter Default Setting

Detection Method: Luminescence

Read Type: Endpoint

Step Label: Background

Read Wells: D1..G4

Light path 1: LUM (Single PMT)

Optics Position: Top

Gain: 200

Integration Time: 0:10.00MM:SS.ss

Delay After PlateMovement: 0msec

Read Height: 10.00mm

Read Step 3:

Detection Method: Luminescence

Read Type: Endpoint

Read Wells: A73A8

Step Label: Battery Check

Light path 1: LUM (Single PMT)

Optics Position: Top

Gain: 60

Integration Time: 0:01.00MM:SS.ss

Delay After PlateMovement: 0msec

Read Height: 10.00mm

Results Analysis

The Luminescence Test procedure is described on page 121.

1. Determine if the plate9s battery is functioning properly:

n If A8 > (0.2 * A7), the battery is good. Otherwise, it requires replacement.

A replacement battery is included with each Harta plate. A new spare battery will
be supplied when the plate is recertified.
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2. On the Harta plate9s Calibration Certificate, locate the NIST measurement for the
A2 position and convert it to attomoles: (A2 NIST measurement*0.02884)

3. Calculate the signal-to-noise ratio:
(A23Mean of the buffer cells)/(3 * Standard deviation of buffer cells)

4. Calculate the detection limit:
A2NIST measurement in attomoles/signal-to-noise ratio

Pass/Fail Criteria

n If the reader is equipped with the low-noise PMT, the detection limit must be
f 50 amol to pass.

n If the reader is equipped with the red-shifted PMT, the detection limit must
be f 500 amol to pass.

If you do not knowwhich PMT is installed, (#49984 = low-noise PMT; #49721 = red-
shifted PMT, please contact BioTek TAC.

Troubleshooting
If the luminescence test fails, try the following suggestions. If it continues to fail, print the
results and contact BioTek TAC.

l Ensure that the reading is performed through a hole in the filter cube, not through
a glass filter.

l Verify that the filter cube settings in Gen5match the physical cube.

l If the test continues to fail, the optical probe(s) may need to be cleaned. Contact
BioTek TAC for instructions.

Fluorescence Testing
For models with fluorescence capability, BioTek provides two options for testing the
fluorescence system. One uses a solid state Fluorescence Test Plate (package BTI# 1400006*;
contact BioTek Customer Care regarding availability). The other uses liquid plates, the
materials for which are available for purchase from BioTek (seeMaterials for Conducting
Liquid Tests on page 5).

*Fluorescence Test Plate BTI# 7092092 cannot be used for these tests.

BioTek Fluorescence Test Plate
The Fluorescence Test Plate simplifies the process for conducting fluorescence intensity,
fluorescence polarization, and time-resolved fluorescence qualification tests on the Synergy
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Neo2. The test plate is solid and therefore immune to the pipetting errors, evaporation
issues, and costs experienced with conventional Liquid Tests.

The test plate package includes Gen5 protocols designed specifically for use with the test
plate. The protocols include embedded Microsoft Excel spreadsheets to automatically
calculate results and determine pass/fail. The protocols and their spreadsheets were fully
validated in accordance with BioTek Instruments' Product Validation policies and
procedures.

The package also contains a user guide that describes the test methods, helps you get
started with using the plate, and provides important information for cleaning and
maintaining the test plate. The guide also provides troubleshooting tips and information on
the annual recalibration program.

Results Analysis
Refer to the Fluorescence Test Plate User Guide for descriptions of the data reduction
calculations for each test. The tests must meet the following criteria to pass:

Fluorescence Intensity (FI) Tests

Corners %CV < 3.0

Linearity R2 >= 0.9500

Sensitivity, filter-based system:

Top optics, Sodium Fluorescein analogue Detection Limit <= 5.0 pM

Bottom optics, Sodium Fluorescein analogue Detection Limit <= 5.0 pM

Top optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Bottom optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Sensitivity, monochromator-based system:

Top optics, Sodium Fluorescein analogue Detection Limit <= 20.0 pM

Bottom optics, Sodium Fluorescein analogue Detection Limit <= 20.0 pM

Top optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Bottom optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Time-Resolved Fluorescence (TRF) Test Detection Limit <= 250.0 fM

Fluorescence Polarization (FP) Test (filter-based system, dual
PMT)

HPR Polarization > 340 mP
LPR Standard Deviation < 5

Fluorescence Polarization (FP) Test (filter-based system, single
PMT)

HPR Polarization > 340 mP
LPR Standard Deviation < 5
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Fluorescence Liquid Tests

Test Methods

l The Corners Test uses fluorescence compounds to verify that the plate carrier is
properly aligned in relation to the fluorescence probe(s).

l The Sensitivity Test uses a fluorescence compound and buffer solution to test the
fluorescence reading capability of the instrument. The ability to detect specific
compounds at the required limit of detection ensures that the filters, optical path,
and PMT(s) are all in working order. This test verifies that the difference between
the concentration well under investigation and themean of themedian buffer well
is statistically distinguishable.

l The Linearity Test verifies that the system is linear, that is, the signal changes
proportionally with changes in concentration (R2 value). Proving that the system is
linear allows the Sensitivity Test to be run on two points instead of using serial
dilutions.

l The FP Test verifies the ability of the instrument to measure polarization of the
solution. It verifies the polarizers are installed in the proper orientation and the
mechanism is in proper order.

l The TRF Test verifies the performance of the xenon flash bulb and that the filters,
optical path, and PMTs are all in working order.

Gen5 Protocol Reading Parameters
The information in the following tables represents the recommended reading parameters. It
is possible that your tests will requiremodifications to some of these parameters, such as
the Plate Type (see Troubleshooting Tips on page 102).

The Plate Type setting in each Gen5 protocol should match the plate you are actually
using.

Synergy Neo 2_FI_T_SF.prt/Synergy Neo 2_FI_B_SF.prt

Parameter Default Setting

Detection Method: Fluorescence intensity

Read Type: Endpoint

Plate Type: Top Read: Costar 96 black opaque (#3915)
Bottom Read: Greiner Sensoplate

Read Step 1:
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Parameter Default Setting

Kinetic: Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read

Read Well: D7

Filter Sets: Single PMT
Filter set 1: 485/528
Optics position: Top/Bottom
Gain: (top and bottom optics) Auto, Scale to
High Wells, D7, 50000

Read Speed: Normal
Delay after platemovement: 350msec
Measurements per data point: 50

Read Height: 5.75mm (top read); 9.25mm (bottom read)

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)

Read Step 2:

Kinetic: Run Time: 0:01:35
Interval: 0:00:06
Reads: 16

Step Label: Sensitivity Read Buffer

Read Wells: C9..E9

Filter Sets: Single PMT
Filter set 1: 485/528
Optics position: Top/Bottom
Gain: (top and bottom optics) Auto, Use first
filter set gain from FIRST Read Step

Read Speed: Normal
Delay after platemovement: 350msec
Measurements per data point: 50

Read Height: 5.75mm (top read); 9.25mm (bottom read)

Dynamic Range: Standard

Light source: Xenon Flash
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Parameter Default Setting

Lamp energy: Low (faster)

Read Step 3:

Step Label: Corners Read

Read Wells: A13A3, A103A12, H13H3, H103H12

Filter Sets: Single PMT
Filter set 1: 485/528
Optics position: Top/Bottom
Gain: (top and bottom optics) Auto, Scale to
High Wells, A3, 50000

Read Speed: Normal
Delay after platemovement: 350msec
Measurements per data point: 50

Read Height: 5.75mm (top read); 9.25mm (bottom read)

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)

Read Step 4:

Step Label: Linearity Read

Read Wells: C13F5

Filter Sets: Single PMT
Filter set 1: 485/528
Optics position: Top/Bottom
Gain: (top and bottom optics) Auto, Scale to
High Wells, C1, 50000

Read Speed: Normal
Delay after platemovement: 350msec
Measurements per data point: 50

Read Height: 5.75mm (top read); 9.25mm (bottom read)

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)
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Synergy Neo 2_Single PMT_FP.prt and Synergy Neo 2_Dual PMT_FP.prt

This procedure contains one Read step using filters with Fluorescence Polarization
enabled, inside a PlateMode block.

Parameter Default Setting

Detection Method: Fluorescence polarization

Read Type: Endpoint

Plate Type: Costar 96 black opaque (#3915)

Synchronized Mode: PlateModewith Timing Control

Read Wells: A63H9

Filter Sets: Single/Dual PMT
FP 485/528
Optics position: Top
Gain: Single PMT4Auto, Scale to well: A9,
Scale value: 20000
Gain: Dual PMT4Side PMT1/Top PMT2: Auto,
Scale to well: A9, Parallel scale value: 20000,
Requested polarization: 20

Read Speed: Normal

Delay After PlateMovement: 0msec

Measurements Per Data Point: 50

Read Height: 6.50mm

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)

Synergy Neo 2_TRF.prt

Parameter Default Setting

Detection Method: Time-resolved fluorescence

Read Type: Endpoint

Plate Type: Costar 96-well white opaque

Delay Step: 3minutes
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Parameter Default Setting

Read Step 1:

Kinetic: Run Time: 0:00:15
Intervale: 0:00:01
Reads: 16

Step Label: Sensitivity Read

Read Well: A8

Filter Sets: Single PMT
360/620
Optics position: Top
Gain: Auto, Scale to High Wells, A8, 50000

Read Speed: Normal

Delay after platemovement: 100msec

Measurements per data point: 50

Read Height: 4.50mm

Light source: Xenon Flash

Lamp energy: Low (faster)

Dynamic Range: Standard

Delay: 300 µsec

Data collection time: 1000 µsec

Read Step 2:

Kinetic: Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read Buffer

Read Wells: A63C6

Filter Sets: Single PMT
360/620
Optics position: Top
Gain: Auto, Use first filter set gain from
FIRST Read Step

Read Speed: Normal

Delay after platemovement: 100msec

Measurements per data point: 50
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Parameter Default Setting

Read Height: 4.50mm

Light source: Xenon Flash

Lamp energy: Low (faster)

Dynamic Range: Standard

Delay: 300 µsec

Data collection time: 1000 µsec

Synergy Neo 2_M_FI_T_SF.prt and Synergy Neo 2_M_FI_B_SF.prt

Parameter Default Setting

Detection Method: Fluorescence

Read Type: Endpoint

Plate Type: Top: Costar 96 black opaque
Bottom: Greiner SensoPlate

Read Step 1:

Kinetic: Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read

Read Well: D7

Wavelength: Excitation: 485/14, Emission: 528/14

Optics Position: Top/Bottom

Gain Top: Auto, Scale to High Wells, D7, 50000

Read Speed: Normal

Delay after platemovement: 100msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height (for top optics): 5.00mm

Read Step 2:
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Parameter Default Setting

Kinetic: Run Time: 0:01:35
Interval: 0:00:06
Reads: 16

Step Label: Sensitivity Read Buffer

Read Wells: C93E9

Wavelengths: Excitation: 485/14, Emission: 528/14

Optics Position: Top/Bottom

Gain: Top: Auto, Use first filter set gain from
FIRST Read Step

Read Speed: Normal

Delay after platemovement: 100msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height (for top optics): 5.00mm

Read Step 3:

Step Label: Corners Read

Read Wells: A13A3, A103A12, H13H3, H103H12

Wavelengths: Excitation: 485/14, Emission: 528/14

Optics Position: Top/Bottom

Gain: Top: Auto, Scale to High Wells, A3, 50000

Read Speed: Normal

Delay after platemovement: 100msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height (for top optics): 5.00mm

Read Step 4:

Step Label: Linearity Read

Read Wells: C13F5
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Parameter Default Setting

Wavelengths: Excitation: 485/14, Emission: 528/14

Optics Position: Top

Gain: Top: Auto, Scale to High Wells, C1, 50000

Read Speed: Normal

Delay after platemovement: 100msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height (for top optics): 5.00mm

Neo 2_FI_T_MUB.prt and Neo 2_FI_B_MUB.prt

Parameter Default Setting

Plate Type: Top Optics: Costar 96-well black opaque (#3915)
Bottom Optics: Greiner Sensoplate

Detection Method: Fluorescence

Read Type: Endpoint

Read Step 1:

Kinetic Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read

Read Well: D7

Filter Sets: Single PMT
360/460
Optics position: Top/Bottom
Gain: Auto, Scale to High Wells, D7, 80000

Read Speed: Normal
Delay after platemovement: 350msec
Measurements per data point: 50

Read Height: 4.50mm (top read); 8.75mm (bottom read)

Dynamic Range: Standard

Light Source: Xenon Flash
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Parameter Default Setting

Lamp Energy: Low (faster)

Read Step 2:

Kinetic: Run Time: 0:01:35
Interval: 0:00:06
Reads: 16

Step Label: Sensitivity Read Buffer

Read Well: C9, D9, E9

Filter Sets: Single PMT
360/460
Optic position: Top/Bottom
Gain: Auto, Use first filter set gain from FIRST Read Step

Read Speed: Normal
Delay after platemovement: 350msec
Measurements per data point: 50

Read Height: 4.50mm (top read); 8.75mm (bottom read)

Dynamic Range: Standard

Light Source: Xenon Flash

Lamp Energy: Low (faster)

Read Step 3:

Step Label: Linearity Read

Read Well: C13F5

Filter Sets: Single PMT
360/460
Optics position: Top/Bottom
Gain: Auto, Scale to High Wells, C1, 80000

Read Speed: Normal
Delay after platemovement: 350msec
Measurements per data point: 50

Read Height: 4.50mm (top read); 8.75mm (bottom read)

Dynamic Range: Standard

Light Source: Xenon Flash

Lamp Energy: Low (faster)
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Neo 2_M_FI_T_MUB.prt

Parameter Default Setting

Plate Type: Costar 96-well black opaque (#3915)

Detection Method: Fluorescence

Read Type: Endpoint

Read Step 1:

Kinetic: Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read

Read Wells: D7

Wavelengths: Excitation: 360/14, Emission: 460/14

Optics Position: Top

Gain: Auto, Scale to High Wells, D7, 80000

Read Speed: Normal

Delay after platemovement: 100msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height: 4.50mm

Read Step 2:

Kinetic: Run Time: 0:01:35
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read Buffer

Read Wells: C9, D9, E9

Wavelengths: Excitation: 360/14, Emission: 460/14

Optics Position: Top

Gain: Auto, Use first filter set gain from FIRST Read Step

Read Speed: Normal

Delay after platemovement: 100msec
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Parameter Default Setting

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height: 4.50

Read Step 3:

Step Label: Linearity Read

Read Wells: C13F5

Wavelengths: Excitation: 360/14, Emission: 460/14

Optics Position: Top

Gain: Auto, Scale to High Wells, C1, 80000

Read Speed: Normal

Delay after platemovement: 100msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height: 4.50 nm

Results Analysis
The Fluorescence Liquid Test procedures begin on page 128.

Corners Test

1. Calculate theMean of the 12 "corner" wells (A13A3, A103A12, H13H3, and H103
H12).

2. Calculate the Standard Deviation for the same 12wells.

3. Calculate the %CV: (Standard Deviation / Mean) * 100

The %CVmust be < 3.0 to pass.

Sensitivity Test

1. Calculate theMean and Standard Deviation of the 16 reads for each of the buffer
wells (C9, D9, E9).
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2. Among the three buffer wells, find theMedian Standard Deviation and
corresponding Mean.

3. Calculate theMean for the 16 reads of the SF Concentration well (D7).

4. Calculate the Signal-to-Noise Ratio (SNR) using theMean SF Concentration, Buffer
Media STD with its corresponding Buffer Mean: 
(SF Mean 3 Buffer Mean)/3 * Buffer STD)

5. Calculate the Detection Limit:

Sodium Fluorescein: Using the known concentration value of SF and the calculated
SNR: 1000/SNR

Filter-Based Fluorescence System

Optics Filter Cube
To pass, the Detection Limit

must be:

Top
Cube 107 (or

equivalent): 485/20, 528/20,
510 nm dichroic mirror

< 5 pM (<1 pM typical)

Bottom
Cube 107 (or

equivalent): 485/20, 528/20,
510 nm dichroic mirror

< 5 pM (<2 pM typical)

Monochromator-Based Fluorescence System

Optics Wavelength
To pass, the Detection Limit

must be:

Top/Bottom EX 485 nm, EM 528 nm <=20 pM (<=5 pM typical)

Methylumbelliferone: Using the known concentration value ofMUB and the calculated
SNR: 17/6.SNR

Filter-Based Fluorescence System:

Filter Cube Optic Position
To pass, the Detection Limit must
be:

Cube 107 (or
equivalent)4360/40,
460/40, 400 nm dichroic
mirror

Top/Bottom <= 0.16 ng/mL (0.91 nM)
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Monochromator-Based Fluorescence System:

Wavelengths Optic Position
To pass, the Detection Limit must
be:

Excitation4360 nm
Emission4460 nm

Top <= 0.16 ng/mL (0.91 nM)

Linearity Test

1. Calculate theMean of the four wells for each concentration in columns 135.

2. Perform linear regression using these values as inputs:

Sodium Fluorescein: Filter- and Monochromator-Based Fluorescence System

x y

1000 Mean of the 1000 pM wells

500 Mean of the 500 pM wells

250 Mean of the 250 pM wells

125 Mean of the 125 pM wells

62.5 Mean of the 62.5 pM wells

Methylumbelliferone: Filter- and Monochromator-Based Fluorescence
System

x y

100 Mean of the 100 nM wells

50 Mean of the 50 nM wells

25 Mean of the 25 nM wells

12.5 Mean of the 12.5 nM wells

6.25 Mean of the 6.25 nM wells

3. Calculate the R2 value; it must be >= 0.9500 to pass.
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Fluorescence Polarization (FP) Test

1. Using the raw data from the Parallel read:

l Calculate theMean Blank (wells A63H6).

l Calculate the Signal for each HPR well: Subtract theMean Blank from its
measurement value.

l Calculate the Signal for each LPR well: Subtract theMean Blank from its
measurement value.

2. Using the raw data from the Perpendicular read:

l Calculate theMean Blank (wells A63H6)

l Calculate the Signal for each HPR well: Subtract theMean Blank from its
measurement value.

l Calculate the Signal for each LPR well: Subtract theMean Blank from its
measurement value.

3. Calculate the G-Factor for each LPR well:
(Parallel LPR Sign * (130.02)) / (Perpendicular LPR Signal * (1+0.02))

4. Calculate theMean G-Factor.

5. Calculate the Polarization value in mP for each HPR well (<PHPR=):

Parallel HPR Signal 3 MeanG-Factor *
Perpendicular HPR Signal * 1000

Parallel HPR Signal + MeanG-Factor *
Perpendicular HPR Signal

6. Calculate theMean PHPR, in mP.

Filter Cubes To pass, the Mean PHPR must be:

Dual PMT4Cube 61 (or
equivalent);

Single PMT4Cube 108 (or
equivalent): 

485/20, 528/20, 510 nm,
dichroic mirror

> 340mP
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7. Calculate the Polarization value in mP for each LPR well (<PLPR=):

Parallel LPR Signal 3 MeanG-Factor *
Perpendicular LPR Signal * 1000

Parallel LPR Signal + MeanG-Factor *
Perpendicular LPR Signal

8. Calculate the Standard Deviation of the <PLPR,= in mP.

Filter Cubes
To pass, the Standard Deviation of

the PLPR::

Dual PMT4Cube 61 (or equivalent);
Single PMT4Cube 108 (or

equivalent): 485/20, 528/20, 510 nm
dichroic mirror

< 5

Time-Resolved Fluorescence (TRF) Test

1. Calculate theMean and Standard Deviation of the 16 reads for each of the buffer
wells (A6, B6, C6).

2. Among the three buffer wells, find theMedia Standard Deviation and
corresponding Mean.

3. Calculate theMean for the 16 reads of the Eu Concentration well (A8).

4. Calculate the Signal-to-Noise Ratio (SNR) using theMean Eu Concentration and
Buffer Median STD with its corresponding Buffer Mean:
(Eu Mean 3 Buffer Mean)/(3 * Buffer STD)

5. Calculate the Detection Limit, in fM:
20000/(Mean Eu 3 Mean DI water)/(3 * Standard Deviation DI water)

Filter Cube To pass, the Detection Limit must be:

Cube 112 (or equivalent): 360/40,
620/40, 400 nm dichroic mirror

<= 250 fM

Troubleshooting
If any tests fail, please try the following suggestions. If the test(s) continue to fail, print the
results and contact BioTek9s Technical Assistance Center.
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l Are the solutions fresh? Discard the plate and any opened, unused test solutions
after seven days.

l Are the excitation/emission filters clean?

l Are you using the proper filter cube?

l If the Corners Test continues to fail, the hardwaremay bemisaligned. Contact
BioTek TAC.

l Are you using new/clean plates? If the base of a clear-bottom plate is touched,
clean the entire base with alcohol (95% ethanol) and then wipe with a lint-free
cloth. Before placing the plate in the instrument, blow the bottom of the plate with
an aerosol duster. If the test fails again, the optical probe(s) may need to be
cleaned. Contact BioTek TAC.

l Review the pipetting instructions to verify the plate was correctly prepared.

l Does the Plate Type setting in the Gen5 protocol match the plate you used?

l For models with a dispenser, spilled fluid inside the reader may be fluorescing,
which can corrupt your test results. If you suspect this is a problem, contact
BioTek TAC.

l When testing Fluorescence Polarization capability using a solid black plastic
microplate, if the standard deviation for the buffer wells is too high, try moving the
buffer wells to another column. With some black plastic plates, the wells in the
center of the platemay be slightly distorted due to the platemolding process, and
this can affect the standard deviation.

l The Read steps in the protocols use the Gen5 Automatic Gain Adjustment feature
to determine optimum sensitivity values for the plate. If an Auto Gain Result value
is outside the range of 303200, this may indicate a problem.
If the value is less than 30:
n The stock solution/dilution concentrations may be too high. Try creating

fresh solutions/dilutions, and rerun the test using a new, clean plate.

n If all of the tests are passing but the Gain value is low, a PMT in your reader
may just be very sensitive. Contact BioTek9s Technical Assistance Center to
confirm that this may be the case.

If the value is greater than 200:
n The stock solution/dilution concentrations may be too low. Try creating

fresh solutions/dilutions, and rerun the test using a new, clean plate.

n For injector models, spilled fluid inside the reader may be fluorescing, which
can corrupt your test results. If you suspect this is a problem, contact
BioTek TAC.

n The PMTs or optical path(s) may be deteriorating, or the optics or other
hardwaremay bemisaligned. Contact BioTek9s Technical Assistance Center.
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Injection System Testing
For models equipped with injectors and an external dispensemodule, BioTek has
developed a set of tests to ensure that the injection system performs to specification.

Test Method

l The Accuracy Test is a measure of themean volume per well for multiple
dispenses. The actual weight of the dispensed fluid is compared to the expected
weight and must be within a certain percentage to pass. Pass/Fail criteria depends
on the per-well volume dispensed: 2.0% for 80 µL, 5.0% for 20 µL, and 20.0% for 5
µL. It is assumed that one gram is equal to onemilliliter.
The test uses a single green dye test solution and a 96-well microplate (per injector)
to test the three different volumes. The balance is tared with the empty plate, and
then the 80 µL dispense is performed for columns 134. The fluid is weighed and the
balance is tared again (with the plate on the balance). This process is repeated for the
20 µL and 5 µL dispenses. It is assumed that the solutions used are at room
temperature. A precision balance (three-place) is used to weigh the plate.

l The Precision Test is a measure of the variation among volumes dispensed to
multiple wells. For each volume dispensed (80 µL, 20 µL, and 5 µL) to four columns,
the %CV (coefficient of variation) of 32 absorbance readings is calculated. Pass/Fail
criteria depends on the per-well volume dispensed: 2.0% for 80 µL, 7.0% for 20 µL,
and 10.0% for 5 µL. The plate is read in an absorbance reader at 405/750 nm for
columns 134 and at 630/750 nm for columns 5312.

The two tests are performed simultaneously and use the same plate.

Gen5 Parameters
The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s). It is possible that your tests will requiremodifications to some
of these parameters, such as the Plate Type.

The Plate Type setting in each Gen5 protocol should match the actual plate in use.

Synergy Neo2 Disp 1 Test.prt and Synergy Neo2 Disp 2 Test.prt

Parameter Setting

Plate Type 96WELL PLATE
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Parameter Setting

Dispense Step Dispenser <select 1 or 2, depending on the protocol>
Dispense to wells A1..H4
Tip prime before this dispense step, 20 µL
Dispense 80 µL at rate 275 µL/sec

Plate Out,In Suggested comment: Weigh the plate (80 µL test). RECORD the
weight, TARE the balance. Place the plate back on the carrier.
Click OK to continue.

Dispense Dispenser <select 1 or 2, depending on the protocol>
Dispense to wells A5..H8 |
Tip prime before this dispense step, 20 µL
Dispense 20 µL at rate 250 µL/sec

Plate Out,In Suggested comment: Weigh the plate (20 µL test). RECORD the
weight and TARE the balance. Place the plate back on the carrier.
Click OK to continue.

Dispense Dispenser <select 1 or 2, depending on the protocol>
Dispense to wells A9..H12
Tip prime before this dispense step, 5 µL
Dispense 5 µL at rate 225 µL/sec

Plate Out,In Suggested comment: Weigh the plate (5 µL test). RECORD the
weight. PIPETTE 150 µL/well of DI water into all 12 columns.
Place the plate back on the carrier. Click OK to perform the Read
steps.

Shake Orbital at 425 cpm (3mm) for 30 seconds.

Read Step label: <80 ul Read_Disp 1= (or _Disp 2)
Wells: A1..H4
Detection Method: Absorbance
Read Type: Endpoint
Read Speed: Normal
Two Wavelengths: 405 and 750 nm

Read Step label: <20 and 5 ul Read_Disp 1= (or _Disp 2)
Wells: A5..H12
Detection Method: Absorbance
Read Type: Endpoint
Read Speed: Normal
Two Wavelengths: 630 and 750 nm

Results Analysis
The Injection System Test procedure begin on page 138.
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When the experiment for one injector is complete, 32 delta OD values are reported for each
of the three dispense volumes. The pass/fail criteria for each set of 32wells with the same
dispense volume is based on the calculated coefficient of variation (% CV) and Accuracy %
Error.

For each volume dispensed (80 ¿L, 20 ¿L, 5 ¿L), for each injector (1, 2):

1. Calculate the Standard Deviation of the 32wells.

2. Calculate theMean of the 32wells.

3. Calculate the %CV: (Standard Deviation/Mean) * 100

4. Calculate the Accuracy % Error:
((ActualWeight 3 Expected Weight)/Expected Weight) * 100

Expected Weights for 32wells: 80 ¿L (2.560 g), 20 ¿L (0.640 g), 5 ¿L (0.160 g). It is
assumed that one gram is equal to onemilliliter.

Dispense Volume To pass, %CV must be
To pass, Accuracy % 

Error must be:

80 µL f 2.0% f 2.0%

20 µL f 7.0% f 5.0%

5 µL f 10.0% f 20.0%

If any tests fail, prime the fluid lines and rerun the tests. If the tests fail again, the injectors
may require cleaning; see Clean the Dispense Tubes and Injectors on page 62. If tests
continue to fail, contact BioTek TAC.

Alpha Detection Test
The alpha laser has been factory-calibrated to meet specification. BioTek Instruments, Inc.,
has developed a set of test protocols that can be used with Alphascreen Omnibeads to
verify the functionality of the alpha laser system. Because the detector for the alpha system
is functionally and optically identical to the luminescence system, the luminescence test
may be used to verify detector functionality.

The Crosstalk test is a measure of howwell the optical system can distinguish the signals
emitted from the well being read from those of any adjacent well. This test also determines
the signal-to-noise ratio (SNR) of the test plate and verifies that the signal is at an acceptable
level for the samplematerial used. The test is designed for use with Alphascreen
Omnibeads, and it is assumed that 96-well plates are used with 100 µL well volumes.
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Gen5 Protocol Reading Parameters
The information in the following table represents the recommended reading parameters. It
is possible that your tests will requiremodifications to some of these parameters, such as
Plate Type or Gain value (see Troubleshooting Tips above).

The Plate Type setting in the Gen5 protocol should match the plate you are actually
using.

Synergy Neo2_AlphaTest_Crosstalk.prt

This procedure contains one read step and calculates crosstalk based on the full plate data.

Parameter Default Setting

Plate Type 96-well

Detection Method Alpha

Read Type Endpoint

Read Wells Full plate

Gain 120

Delay after platemovement 0msec

Excitation time 100msec

Delay after excitation 120msec

Integration time 100msec

Read height 7.00mm

Results Analysis

1. Calculate the crosstalk for each of the four wells of Omnibead solution by dividing
the background-subtracted Mean value of the surrounding adjacent wells by the
background-subtracted Omnibead suspension well.

2. Average the % crosstalk of the four test wells to determine level of crosstalk
(Crosstalk Mean).

3. Verify that the % crosstalk is less than 0.1%

4. Calculate the signal-to-noise ratio (SNR) by using the following equation:
SNR = (signal mean 3 backgroundmean)/(SQRT(signal STD² + background STD²))

5. Verify that SNR is greater than 10.
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Troubleshooting Alpha Tests
If the test fails, please try the following suggestions. If the test(s) continue to fail, print the
results and contact BioTek9s Technical Assistance Center.

l Are the solutions fresh?

l Have the solutions been stored properly (between +2°C and +6°C)?

l Has the kit been exposed to excessive light (in excess of 100 lux)?

l If the Crosstalk test continues to fail, the laser may not be firing. Contact BioTek
TAC.
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Instrument Qualification Procedures

This chapter contains the step-by-step procedures for verifying that the
Synergy Neo2 and its various subsystems are performing to specification.

Instrument Qualification Process, starting on page 73, introduces the
various test methods, describes thematerials and relevant Gen5 protocols
used to execute the tests, explains how to analyze test results, and provides
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Instrument Qualification Overview
This chapter contains BioTek Instrument's recommended qualification procedures for all
Synergy Neo2models.

Every Synergy Neo2 reader and external dispensemodule is fully tested at BioTek prior to
shipment and should operate properly upon initial setup. If you suspect that a problem
occurred during shipment, if you have received the equipment after returning it to the
factory for service, and/or if regulatory requirements dictate that you qualify the equipment
on a routine basis, perform the procedures outlined in this chapter.

See the Recommended Qualification Schedule on page 111 to determine which
qualification tests shall be conducted for your Synergy Neo2model and to meet your site's
regulatory requirements.

A Product Qualification Package (BTI # 1350526) for the Synergy Neo2 is available for
purchase. The package contains complete procedures, Gen5 protocols, checklists, and
logbooks for performing Installation Qualification, Operational Qualification,
Performance Qualification, and PreventiveMaintenance. Contact your local BioTek
dealer for more information.

If the gas controller module is used with the Synergy Neo2, refer to theGas Controller
User Guide (BTI #1211000) or Gas Controller Product Qualification Package
(BTI #1210512) for qualification procedures.

IQ/OQ/PQ Description
Installation Qualification confirms that the reader and its components have been supplied
as ordered and ensures that they are assembled and configured properly for your lab
environment.

l The recommended IQ procedure consists of setting up the instrument and its
components as described in the Installation chapter, and performing the System
Test. For models with injectors, a quick test with fluid is also performed, to ensure
that the dispensemodule is properly installed and there are no leaks.

l The IQ procedure should be performed before the reader is used for the first time).
The successful completion of the IQ procedure verifies that the instrument is
installed correctly.

Operational Qualification confirms that the equipment operates according to specification
initially and over time.

l The recommended OQ procedure consists of performing the system test,
Absorbance Plate Test, a series of Fluorescence Tests, and, if the external dispense
module is used, Dispense Accuracy and Precision Tests.
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l The OQ procedure should be performed initially (before first use) and then
routinely; the recommended interval is annually. It should also be performed after
any major repair or upgrade to the hardware or software.

l Although out-of-tolerance failures will be detected by the OQ tests, results should
be compared with those from the routine Performance Qualification tests and
previous OQ tests to monitor for trends.

l The successful completion of the OQ procedure, in combination with results that
are comparable to previous PQ and OQ tests, confirms that the equipment is
operating according to specification initially and over time.

Performance Qualification confirms that the reader consistently meets the requirements of
the tests performed at your laboratory.

l The recommended PQ procedure consists of performing the System Test,
Absorbance Plate Test, a series of fluorescence tests, and, if the external dispense
module is used, Dispense Accuracy and Precision Tests. Your facility9s operating
policies may also require that you routinely perform an actual assay, to confirm
that the reader will consistently give adequate results for the assays to be run on
it.

l These tests should be performed routinely; the recommended interval is monthly
or quarterly, depending on the test. This frequency may be adjusted depending
on the trends observed over time.

l The successful completion of the PQ procedure confirms that the equipment is
performing consistently under normal operating conditions.

Recommended Qualification Schedule
This table defines BioTek-recommended intervals for qualifying a Synergy Neo2 used two to
five days a week. The actual frequency, however, may be adjusted depending on your
usage of the instrument and its various models. The schedule assumes that the instrument
is properly maintained as outlined in the Preventive Maintenance chapter.
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Tasks/Tests
IQ OQ PQ

Initially Initially/
Annually Monthly Quarterly

All models:

Installation,
setup, and
configuration of
the reader, host
computer, and
Gen5 software

ü

System Test ü ü ü

Models with absorbance capability:

Absorbance
Plate Test

ü ü

Absorbance
Liquid Test 1 or
Liquid Test 2*

ü ü

(Optional)
Absorbance
Liquid Test 3 or
340 nm
Absorbance
Plate Test (using
BTI #7260551)

ü ü

Models with fluorescence capability:

Corners,
Sensitivity,
Linearity (FI)
Tests

ü ü

Fluorescence
Polarization (FP)
Test

ü ü

Time-Resolved
Fluorescence
(TRF) Test

ü ü

Models with luminescence capability:
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Tasks/Tests
IQ OQ PQ

Initially Initially/
Annually Monthly Quarterly

Luminescence
Test

ü ü

Models with injectors and an external dispense module:

Installation and
setup of external
dispensemodule

ü

Injection System
Test

ü

Dispense
Accuracy/Precisi
on Test

ü ü

Alpha Laser capability:

Alpha Detection
Test

ü

* If you have Absorbance Test Plate BTI #7260522, perform Liquid Test 1. Otherwise,
perform Liquid Test 2.

System Test

Instrument System Test, starting on page 74, describes this test and explains where to
find information on error codes and troubleshooting tips, as well as sample test reports
for Synergy Neo2.

Setup
If your assays use incubation, we recommend enabling temperature control for at least 37°C
and allowing the incubator to reach its set point before running the System Test. To access
this feature, select System > Instrument Control and click the Pre-Heating tab.

Test Procedure

1. From the Gen5main screen, select System > Diagnostics > Run System Test.
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The duration of the test depends on the reader model; it can take a fewminutes to
complete.

If the test fails during execution, a message box appears in Gen5. Close the box; the
System Test Report will contain the error code that was generated by the failure.

2. When the test is complete, a dialog appears, requesting additional information.
Enter any required information and then click OK.

3. The test report appears; it shows either "SYSTEM TEST PASS" or
"SYSTEM TEST FAIL *** ERROR (error code) DETECTED."

If the test failed, go to page 157 to look up the error code and determine its cause.
If the cause is something you can fix, turn off the reader, fix the problem, and then
turn the reader back on and retry the test. If the test continues to fail, or if the
cause is not something you can fix, contact BioTek TAC.

4. If required, print, sign, and date the report, and store it with your test
documentation.

5. If applicable, turn off the incubator.

Absorbance Plate Tests

BioTek Absorbance Test Plates, starting on page 74, describes the test methods and
provides troubleshooting tips in the event of a test failure.

Requirements
To perform this test, you will need:

l Absorbance Test Plate, BTI #7260522

l (Optional) 340 nm Absorbance Test Plate, BTI #7260551

l Current Absorbance Test Plate Calibration Certificate(s)

Setup
Before an Absorbance Test Plate can be used for qualification, you must enter information
from its Calibration Certificate into Gen5. Perform these steps initially, and then repeat
them annual after the test plate is recertified by BioTek:

BioTek Instruments, Inc.



Absorbance Plate Tests | 115

1. Obtain the current Test Plate Calibration Certificate.

2. Start Gen5 and select System > Diagnostics > Test Plates > Add/Modify Plates.

3. Click Add. The Absorbance Test Plate dialog appears.

4. Select the appropriate Plate Type and then enter the plate9s serial number.

5. Enter the Last Certification and Next Certification dates from the calibration label
on the Test Plate.

6. If the wavelength values in the top row of the grid in Gen5 are appropriate for your
tests, enter the OD Standard values from the Calibration Certificate into the grid.
Make sure you enter the correct value for each well/wavelength combination.

If you need to change the wavelength values, clickWavelength List. Add,
change, or delete the values as needed and click OK.

7. If applicable: Select the number of Peak Wavelength tests to run (up to 4), based
on the desired Expected Peak wavelengths provided on the Calibration Certificate.
Enter the Expected Peak value(s) from the Certificate and set the Test Range 3 and
+ values.

Depending on themanufacture date of the test plate, the glass typemay be
Erbium, Holmium, or Didymium. Contact BioTek TAC if you are not sure which
glass type is used in your plate.

l If the C6 filter is Erbium or Holmium glass, the certificate contains two
Spectral Bandpass tables. For wavelengths greater than 285 nm, we
recommend performing the test using the 5.0 nm table. For wavelengths in
the 2303285 nm range, we recommend using the 2.4 nm table.

Erbium: Any peak value in the table can be used.

Holmium: For best results, use the expected peak values closest to 242, 279,
362, 417, and 538 nm.

l If the C6 filter is Didymium glass, the certificate provides a single peak
wavelength value. Enter this value into Gen5 and set the Test Range 3 and +
values so the range displayed in parentheses is "(580 to 590)".

8. Review all of the values that you entered. When finished, click OK to save the
information.
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Test Procedure

1. In Gen5, select System > Diagnostics > Test Plates > Run. If prompted, select the
desired Test Plate and click OK.

2. When the Absorbance Test Plate Options dialog appears, enter any required
information.

3. If applicable, check Perform Peak Wavelength Test.

4. Highlight the wavelength(s) to be included in this test. Select only those
wavelengths most appropriate for your use of the reader.

5. (Optional) Enter a comment.

6. Click Start Test.

7. Place the Absorbance Test Plate on themicroplate carrier, with A1 in the proper
location.

8. Click OK to run the test.

9. When the test completes, the results report will appear. Scroll down through the
report; every result should show "PASS".

l Troubleshooting tips are provided on page 76.

l Test descriptions are provided on page 75.

Absorbance Liquid Tests

Absorbance Liquid Tests, starting on page 77, describes the test methods, lists the
Gen5 protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.
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Absorbance Liquid Test 1

The tests in this section require specific microplates, solutions, and wavelengths. Your
laboratory may require a deviation from some of these tests. For example, you may
wish to use a different plate, test solution, and/or wavelength. If deviation from the
tests as presented in this section is required, perform the following steps the first time
each test is run:

l Perform the tests exactly as described in the following pages.

l Rerun the tests using your particular plates, solutions, wavelengths, and
so on. If results are comparable, then the results from these tests will be
your baseline for future tests.

l Document your new test procedure(s) and save all test results.

Materials

Manufacturer part numbers are subject to change.

l New96-well, clear, flat-bottom microplate (Corning Costar #3590 recommended)

l Stock Solution A or B, which may be formulated by diluting a dye solution available
from BioTek (A) or from thematerials listed below (B)

l Gen5 protocol Synergy Neo2 Abs Test 1.prt, described on page 78

Solution A

l BioTek QC Check Solution No. 1 (PN 7120779, 25mL; PN 7120782, 125mL)

l Deionized water

l 5-mL Class A volumetric pipette

l 100-mL volumetric flask

1. Pipette a 5-mL aliquot of BioTek QC Check Solution No. 1 into a 100-mL volumetric
flask.

2. Add 95mL of DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 µL in a flat-bottom microwell.

Solution B

l Deionized water

l FD&C YellowNo. 5 dye powder (typically 90% pure)
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l Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting agent
(PN 7773002) (a 10% Tween solution)

l Precision balance with capacity of 100 g minimum and readability of 0.001 g

l Weigh boat

l 1-liter volumetric flask

1. Weigh out 0.092 g of FD&C YellowNo. 5 dye powder into a weigh boat.

2. Rinse the contents into a 1-liter volumetric flask.

3. Add 0.5mL of Tween 20, or 5mL of BioTek9s wetting agent.

4. Fill to 1 liter with DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 µL in a flat-bottom microwell.

Test Procedure

Be sure to use a newmicroplate. Debris, fingerprints, or scratches may cause variations
in readings.

1. Using freshly prepared stock solution (Solution A or B), prepare a 1:2 dilution using
deionized water (one part stock, one part deionized water; the resulting solution is
a 1:2 dilution).

2. Pipette 200 µL of the concentrated solution (A or B) into the first column of wells in
themicroplate.

3. Pipette 200 µL of the diluted solution into the second column of wells.

4. Create a Gen5 experiment based on the Synergy Neo2 Abs Test 1 protocol and
read the plate. When prompted, rotate the plate 180 degrees and continue.

5. When the experiment is finished:

l Save the experiment. Refer to the instructions on page 80 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 83.

l Test descriptions are provided on page 77.

Absorbance Liquid Test 2

The recommended method for testing the instrument9s alignment, repeatability, and
accuracy is to use Absorbance Test Plate BTI #7260522 (see page 74). If the test plate is
not available, however, Liquid Test 2 can be used for these tests.
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Materials

Manufacturer part numbers are subject to change.

l A new 96-well, clear, flat-bottom microplate (Corning Costar #3590 is
recommended)

l Ten test tubes, numbered consecutively, set up in a rack

l Calibrated hand pipette (Class A volumetric pipette recommended)

l Solution A or B (see the instructions for Liquid Test 1)

l A 0.05% solution of deionized water and Tween 20

l Gen5 protocol Synergy Neo2 Abs Test 2.prt, described on page 79

Test Procedure

1. Create a percentage dilution series, beginning with 100% of the original
concentrated stock solution (A or B) in the first tube, 90% of the original solution in
the second tube, 80% in the third tube, all the way to 10% in the tenth tube. Dilute
using the 0.05% solution of deionized water and Tween 20. This solution can also
bemade by diluting the BioTek wetting agent 200:1.

Tube Number 1 2 3 4 5 6 7 8 9 10

Volume of original concentrated
solution (mL)

20 18 16 14 12 10 8 6 4 2

Volume of 0.05% Tween solution
(mL)

0 2 4 6 8 10 12 14 16 18

Absorbance expected if original
solution is 2.0 at 200 ¿L

2.0 1.8 1.6 1.4 1.2 1.0 0.8 0.6 0.4 0.2

The choice of dilutions and the absorbance of the original solution can be varied. Use
this table as a model for calculating the expected absorbances of a series of dilutions,
given a different absorbance of the original solution.

2. Pipette 200 µL of the concentrated solution from Tube 1 into each well of the first
column, A1 to H1, of a new flat-bottom microplate.

3. Pipette 200 µL from each of the remaining tubes into the wells of the
corresponding column of themicroplate (Tube 2 into wells A2 to H2, Tube 3 into
wells A3 to H3, and so on).
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4. Create a Gen5 experiment based on the Synergy Neo2 Abs Test 2 protocol and
read the plate. When prompted, rotate the plate 180 degress.

5. When finished:

l Save the experiment. Refer to the instructions on page 81 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 83.

l Test descriptions are provided on page 77.

Absorbance Liquid Test 3

Absorbance Liquid Test 3 is provided for sites requiring proof of linearity at 340 nm. This
test is optional because the Synergy Neo2 has good "front end" linearity throughout its
wavelength range. As an alternative, the 340 nm Absorbance Test Plate (BTI #7260551)
may be used for this test.

Materials

Manufacturer part numbers are subject to change.

l New96-well, clear, flat-bottom microplate (Corning Costar #3590 recommended);
alternatively, a UV transparent microplatemay be used

l Calibrated hand pipette(s)

l Beakers and graduated cylinder

l Precision balance with readability to 0.01 g

l Buffer solution described below

l Gen5 protocol Synergy Neo2 Abs Test 3.prt, described on page 80

Buffer Solution

l Deionized water

l Phosphate-Buffered Saline (PBS), pH 7.237.6, Sigma tablets, #P4417 (or equivalent)

l ³-NADH Powder (³-Nicotinamide Adenine Dinucleotide, Reduced Form) Sigma bulk
catalog number N 8129, or preweighed 10-mg vials, Sigma number N6785-10VL (or
BioTek PN 98233). Store the powder according to the guidelines on its packaging.
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1. Prepare a PBS solution from the Sigma tablets.

2. In a beaker, mix 50mL of the PBS solution with 10mg of the ³-NADH powder and
mix thoroughly. This is the 100% Test Solution.

3. (Optional) Read a 150-µL sample of the solution at 340 nm; it should be within
0.700 to 1.000 OD. If low, adjust up by adding more powder. Do not adjust if
slightly high.

Prepare the PlateTest Procedure

1. Prepare the 75% Test Solution by mixing 15mL of the 100% Test Solution with 5mL
of the PBS Solution.

2. Prepare the 50% Test Solution by mixing 10mL of the 100% Test Solution with 10
mL of the PBS Solution.

3. Carefully pipette the three solutions into a new 96-well microplate:

l 150 µL of the 100% Test Solution into all wells of columns 1 and 2

l 150 µL of the 75% Test Solution into all wells of columns 3 and 4

l 150 µL of the 50% Test Solution into all wells of column 5 and 6

4. Create a Gen5 experiment based on the Synergy Neo2 Abs Test 3 protocol and
read the plate.

l Save the experiment. Refer to the instructions on page 82 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 83

l Test descriptions are provided on page 77.

Luminecence Test

Luminescence Testing, starting on page 84, describes the test method, lists the Gen5
protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

Required Materials

l Harta Luminometer ReferenceMicroplate, BTI #8030015 (which includes
microplate carrier adapter BTI #8042263)

l Gen5 protocol Synergy Neo2 LumTest_Harta.prt, described on page 84

l LUM Upper and Lower Top filter cubes (e.g., #3 and #112, or equivalent)
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Test Procedure

1. Turn on the Harta reference plate using the I/O switch on the back of the plate.

2. Check the plate9s battery by pressing the test button on the back of the plate and
ensuring that the test light turns on. If the light does not turn on, replace the
battery.

The test light may be difficult to see in bright light. Change your angle of view or move
to a darker environment if you cannot see it.

3. Place the Harta plate adapter on the reader9s carrier, then place the test plate on
top of the adapter.

4. Create an experiment based on the Synergy Neo2 LumTest_Harta protocol,
described on page 84, and read the plate.

5. When the experiment is complete, calculate and evaluate results as described
under Results Analysis on page 85.

6. When finished, turn off the Harta reference plate to preserve battery life.

Plate Layout
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Fluorescence Plate Tests

BioTek Fluorescence Test Plate on page 86 introduces the test plate and references its
user guide for the test methods. Use of the test plate is offered as an alternative to
conducting the fluorescence liquid tests described in the next section.

Requirements
Refer to theGetting Started section of the Fluorescence Test Plate User Guide for
information on the required materials and prerequisite tasks.

Test Procedure
TheQualification Tests section of the Fluorescence Test Plate User Guide contains a
procedure for cleaning the plate and then creating and running experiments based on
supplied Gen5 protocols.

As described in the user guide, when each experiment is finished, Gen5 exports the
measurement data to a prepared Microsoft Excel .xls file. The worksheet(s) within that file
calculate results and determine pass or fail. Identify the reader-specific Gen5 protocols on
the USB flash drive that camewith the test plate. Use only those protocols that apply to
your reader model and your organization's qualification requirements.

Fluorescence Liquid Tests

Fluorescence Liquid Tests, starting on page 88, describes the test methods, lists the
Gen5 protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

The tests presented in this section require specific microplates, solutions, and filters or
wavelengths. Your laboratory may require a deviation from some of these tests. For
example, you may wish to use a different fluorescing solution or microplate.

If deviation from the tests as presented in this section is required, the following steps
should be taken the first time each test is run:

l Perform the tests exactly as described on the following pages.

l Rerun the tests using your particular plates, solutions, and so on. If
results are comparable, then the results from these tests will be your
baseline for future tests.

l Document your new test procedure(s), and save all test results.
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Required Materials

Kits containing themicroplates and solutions required by the Liquid Tests are available
for purchase; seeMaterials for Conducting Liquid Tests on page 5.

Microplates should be perfectly clean and free from dust or bottom scratches. Use new
microplates from sealed packages.

Manufacturer part numbers are subject to change.

All Tests:

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes

l 95% ethanol (for cleaning clear-bottom plates)

l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l (Optional) Black polyethylene bag(s) to temporarily store plate(s)

l Gen5 protocols listed in the next table and described starting on page 125

For the Filter-Based Fluorescence System

Synergy Neo2_FI_T_SF.prt
Corners, Sensitivity, and Linearity tests for top optics, using
sodium fluorescein

Synergy Neo2_FI_B_SF.prt
Corners, Sensitivity, and Linearity tests for bottom optics, using
sodium fluorescein

Synergy Neo2_FI_T_
MUB.prt

Alternative top optics test, using methylumbelliferone

Synergy Neo2_FI_B_
MUB.prt

Alternative bottom optics test, using methylumbelliferone

Synergy Neo2_Dual PMT_
FP.prt

Fluorescence Polarization test using dual PMT

Synergy Neo2_Single
PMT_FP.prt

Fluorescence Polarization test using single PMT

Synergy Neo2_TRF.prt Time-Resolved Fluorescence test
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For the Monochromator-Based Fluorescence System

Synergy Neo2_M_FI_T_
SF.prt

Corners, Sensitivity, and Linearity tests for top optics, using
sodium fluorescein

Synergy Neo2_M_FI_B_
SF.prt

Corners, Sensitivity, and Linearity tests for bottom optics, using
sodium fluorescein

Synergy Neo2_M_FI_T_
MUB.prt

Alternative top optics test, using methylumbelliferone

Corners/Sensitivity/Linearity (FI) Tests

Manufacturer part numbers are subject to change.

Thematerials listed here are for use with Sodium Fluorescein. Methylumbelliferone can
be used as an alternate or supplemental method for performing these tests. See page
133.

If using test kit BTI #7160010 or #7160013 (see page 4), the buffer and SF are pre-diluted.

Buffer:

n NIST-traceable Sodium Borate Reference Standard (pH 9.18) (e.g., Fisher-
Scientific 1 L Sodium BorateMfr. #159532, or equivalent), or

n Phosphate-Buffered Saline (PBS), pH 7.237.6 (e.g., Sigma tablets, Mfr.
#P4417, or equivalent) and pHmeter or pH indicator strips with pH range 4
to 10

l Sodium Fluorescein Powder (1mg vial, BioTek PN 98155)

l If testing both Top and Bottom optics: A new, clean 96-well glass-bottom Greiner
SensoPlate (Mfr. #655892), a clean Hellma Quartz 96-well titration plate (Mfr.
#730.009.QG), or equivalent

l Top optics: A new, clean 96-well solid black microplate, such as Corning Costar
#3915, or equivalent

l Filter cubes:

n Upper Top: 3 or equivalent (dual PMT instruments)

n Lower Top: 107 or equivalent (485/528)

Fluorescence Polarization (FP) Test

l A new, clean, 96-well solid black microplate
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l The recommended test solutions are available from Invitrogen Corporation in their
<FP One-Step Reference Kit= (PN P3088) or from BioTek (PN 7160014). This kit
includes:

n (Green) Polarization Reference Buffer, 15mL

n Green Low Polarization Reference, 4mL

n Green High Polarization Reference, 4mL

The Invitrogen kit also includes two red polarization solutions; these are not used.

l Filter cubes:

n Upper Top: 4 or equivalent (dual FP)

n Lower Top: 61 or equivalent (FP 485/528) (dual FP)

n 108 or equivalent (single PMT)

Time-Resolved Fluorescence (TRF) Test

l 15-mL conical-bottom, polypropylene sample tube

l Filter cubes:

n Upper Top: 3 or equivalent (dual PMT instruments)

n Lower Top: 112 or equivalent (360/620)

l A new, clean 96-well solid whitemicroplate

l The recommended test solution (FluoSpheres carboxylate-modified microspheres,
0.2 µm europium luminescent, 2 ¿L) is available from Invitrogen Corporation (PN
F20881) or from BioTek (PN 7160011)

Test Solutions
Determine which tests to run for your reader model. Prepare the necessary test solutions
using thematerials described on the previous pages.
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Corners/Sensitivity/Linearity Tests

If using BioTek9s sodium fluorescein powder (PN 98155), be sure to hold the vial
upright and open it carefully; thematerial may be concentrated at the top. If a
centrifuge is available, spin down the tube before opening.

When diluting the sodium fluorescein powder in buffer, it takes time for the powder to
completely dissolve. Allow the solution to dissolve for fiveminutes, with intermittent
vortexing, before preparing the titration dyes.

Wrap the vial containing the stock solution in foil to prevent exposure to light. Discard
any open, unused solution after seven days.

1. The Sodium Borate solution does not require further preparation; proceed to step
2. If you are using PBS, prepare the solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200mL of
deionized or distilled water.

l Follow themanufacturer9s instructions on the PBS packaging to create 200
mL, dissolving the necessary amount of PBS into the filtered water.

l Stir the solution (preferably using a stir table) until the PBS is completely
dissolved.

l Check the pH; it should be between 7.2 and 7.6 at 25°C.

2. Prepare the sodium fluorescein stock solution:

l Add 2.0mL of the buffer solution to the 1mg Sodium Fluorescein (SF) vial.
This yields a 1.3288mM stock solution.

l Ensure that the dye has completely dissolved and is well mixed.

3. Carefully prepare the dilutions. Label each with <SF= and the concentration:

Mix This SF Solution: With Buffer: To Make:

0.53mL of 1.3288mM
stock solution

13.47mL 50.2 ¿M

110 µL of 50.2 ¿M SF 13.89mL 400 nM

3.5mL of 400 nM SF 10.5mL 100 nM

0.46mL of 100 nM SF 13.54mL 3.3 nM Corners Test

4.24mL of 3.3 nM SF 9.76mL 1 nM Sensitivity/Linearity
Tests
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Fluorescence Polarization (FP) Test

As described in Fluorescence Polarization (FP) Tests on page 125, the recommended test
solutions are available from Invitrogen Corporation or from BioTek. They do not require
additional preparation.

Time-Resolved Fluorescence (TRF) Test

As described in Time-Resolved Fluorescence (TRF) Tests on page 126, the recommended
test solutions are available from Invitrogen Corporation or from BioTek.

l Shake the FluoSpheres container vigorously for 30 seconds prior to pipetting.
Alternatively, sonicate or vortex the container.

l Mix 10 µL of FluoSpheres with 10mL of deionized water, in a 15mL conical-bottom,
polypropylene sample tube. This yields a 20 nM equivalent suspension.

l Shake the vial vigorously for 30 seconds prior to pipetting. Alternatively, sonicate
or vortex the container.

l Mix 10 µL of 20 nM suspension with 10mL of deionized water, in a 15mL conical-
bottom, polypropylene sample tube. This yields a 20 pM equivalent suspension.

l Refrigerate any unused portions of the FluoSpheres. The temperaturemust be
between +2°C to +6°C.

The prepared TRF plate can be kept for a maximum of seven days, if covered and stored
in the dark between +2°C to +6°C.

Allow the plate to sit at room temperature for approximately 15minutes prior to use.

Test Procedure

Top Optics

1. If you have not already done so, prepare the solutions for the tests you plan to
perform. See Fluorescence Test Solutions on page 126.

Refer to the pipettemaps starting on page 131 for the remaining steps.

2. Perform the Corners/Sensitivity/Linearity tests using the Top optics of the filter-
based fluorescence system:
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l Pipette the solutions for the Corners and Sensitivity/Linearity Tests into a
clean, new 96-well solid black plate.

l Create an experiment based on the Synergy Neo2_FI_T_SF.prt protocol.

l Perform the steps under Determine the Optimal Read Height to determine
and set the optimal read height for the filter cube/fluid height combinations.

l Read the plate, and then save the experiment.

l If you intend to run this test in the future with the same filter cube, select
File > Save Protocol As, and save the updated protocol with the adjusted
read height. You must, however, rerun these steps if you change the filter
cube used with this test.

3. Perform the Corners/Sensitivity/Linearity tests using the Top optics of the
monochromator-based fluorescence system:

l Create an experiment based on the Synergy Neo2_M_FI_T_SF.prt protocol.
Read the plate used in step 3, and then save the experiment.

4. To test Fluorescence Polarization capability:

l Pipette the solutions for the <FP= test into a new 96-well solid black plate.

l Create an experiment based on the Synergy Neo 2_Dual PMT_FP.prt or
Synergy Neo 2_Single PMT_FP.prt protocol. Read the plate and then save
the experiment.

5. To test the Time-Resolved Fluorescence capability:

l Pipette the solutions for the <TRF= test into a new 96-well solid white plate.

l Create an experiment based on the Synergy Neo2_TRF.prt protocol. Read
the plate and then save the experiment.

6. Refer to the instructions starting on page 98.

l Troubleshooting tips are provided on page 102.

l Test descriptions are provided on page 88.

Bottom Optics

1. If you have not already done so, prepare the solutions for the tests you plan to
perform. See Test Solutions on page 126.

Refer to the pipettemaps starting on page 131 for the remaining steps.
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2. If applicable, perform the Corners/Sensitivity/Linearity tests using the Bottom
optics of the filter-based fluorescence system:

l Pipette the solutions for the Corners and Sensitivity/Linearity Tests into a
clean, 96-well glass-bottom plate.

l Create an experiment based on the Synergy Neo2_FI_B_SF.prt protocol.

l Perform the steps under Determine the Optimal Read Height to determine
and set the optimal read height for the filter cube/fluid height combinations.

l Read the plate and then save the experiment.

l If you intend to run this test in the future with the same filter cube, select
File > Save Protocol As, and save the updated protocol with the adjusted
read height. You must, however, rerun these steps if you change the filter
cube used with this test.

3. Perform the Corners/Sensitivity/Linearity tests for themonochromator-based
fluorescence system:

l If you skipped step 3, pipette the solutions for the Corners and
Sensitivity/Linearity Tests into a clean, new 96-well glass-bottom plate.

l Create an experiment based on the Synergy Neo2_M_FI_B_SF.prt protocol.
Read the plate from step 3 (or the newly created plate described above) and
then save the experiment.

4. Refer to the instructions starting on page 98.

l Troubleshooting tips are provided on page 102.

l Test descriptions are provided on page 88.

Determine the Optimal Read Height

1. Select Protocol > Procedure, and open the "Sensitivity Read" step.

2. Click Options, clear Automatic Gain Adjustment, and click OK.

3. Click Show advanced options to display the Read Height information.

4. Click Auto-Adjust. Set the Test Well to D7, and click Start Calibration. When
prompted, place the plate on the carrier and click OK.

5. When calibration is complete, a graph appears. Click Select to use the Optimal
Height.

6. Click Options again, and select Automatic Gain Adjustment.

7. Record the optimal read height, then click OK to close the read step and return to
the Procedure dialog.
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8. Open the "Sensitivity Read Buffer" step. Set the read height to match the recorded
value from step 7 above, then return to the Procedure dialog.

9. Open the "Corners Read" step. Set the read height to match the recorded value
from step 7 above, then return to the Procedure dialog.

10. Open the "Linearity Read" step. Repeat steps 236 above; set the Test Well to C1 in
step 4.

11. Return to the Procedure dialog, then click OK to close the Procedure and return to
the experiment.

Pipette Maps

Seal the plates with foil or store them in black polyethylene bags until use. When using
a clear-bottom plate, if the base of the plate is touched, clean the entire base with
alcohol (95% ethanol) and then wipe with a lint-free cloth. Before placing the plate in the
instrument, blow the bottom of the plate with an aerosol duster.

Corners, Sensitivity, and Linearity (FI) Tests

Refer to the illustration on the next page.

Using a single-channel pipette:

l Pipette 200 ¿L of the 3.3 nM SF solution into the "corner" wells.

l Pipette 200 ¿L of buffer into the wells surrounding the SF. (Omit if using a solid
black plate or Greiner SensoPlate).

l Pipette 200 ¿L of the 1 nM SF solution into well D7.

l Pipette 200 ¿L of the buffer solution into wells C9, D9, and E9.

Using a multichannel pipette with just four tips installed:

l Pipette 150 ¿L of buffer solution into wells C23F5. Discard the tips.

l Pipette 150 ¿L of the 1 nM SF solution into column 1.

l Pipette 150 ¿L of the 1 nM SF solution into column 2. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 ¿L from column 2, and dispense into column 3. Mix the wells using
the pipette. Do not discard the tips.

l Aspirate 150 ¿L from column 3, and dispense into column 4. Mix the wells using
the pipette. Do not discard the tips.

l Aspirate 150 ¿L from column 4, and dispense into column 5. Mix the wells using
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the pipette. Do not discard the tips.

l Aspirate 150 ¿L from column 5, and discard the tips.

Fluorescence Polarization (FP) Test

l Pipette 200 µL of the (green) polarization buffer (BUF) into wells A63H6.

l Pipette 200 µL of the green high polarization reference (HPR) into wells A73B7.

l Pipette 200 µL of the green low polarization reference (LPR) into wells A83H9.
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Time-Resolved Fluorescence (TRF) Test

l Pipette 200 µL of deionized water into wells A63C6.

l If you have not already done so, shake the vial of 20 pM europium suspension
vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or vortex the
vial.

l Pipette 200 µL of the 20 pM europium suspension (Eu) into well A8.

Alternate/Supplemental Tests Using Methylumbelliferone (MUB)
As an alternative to using Sodium Fluorescein, Methylumbelliferone (<MUB=) can be used to
test the top and bottom optics for filter-based fluorescence systems and the top optics for
monochromator-based fluorescence systems.

Required Materials

Microplates should be perfectly clean and free from dust or bottom scratches. Use new
microplates from sealed packages.

Manufacturer part numbers are subject to change over time.

BioTek offers a liquid test kit (PN 7160012) containing themicroplates and solutions
used in theMUB fluorescence liquid tests for the Top optics. If also testing the Bottom
optics (filter-based system), you will need an additional microplate (see below).
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l Methylumbelliferone (<MUB=) (10-mg vial, BioTek PN 98156)

l Carbonate-Bicarbonate buffer (<CBB=) capsules (BioTek PN 98158)

l 100%methanol (BioTek PN 98161)

l Top optics: A new, clean 96-well solid black platemicroplate, such as Corning
Costar #3915 or equivalent. The same plate is used to test both filter- and
monochromator-based systems.

l Bottom optics: A new, clean 96-well glass-bottom Greiner SensoPlate (Mfr.
#655892), a clean Hellma Quartz 96-well titration plate (Mfr. #730.009.QG), or
equivalent

l Filter cube 107 or equivalent (360/460)

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes

l 95% ethanol (for cleaning clear-bottom plates)

l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l (Optional) Black polyethylene bag(s) to temporarily store plate(s)

l Gen5 protocols described on page 133:

n Synergy Neo 2_FI_T_MUB.prt tests the top filter-based fluorescence
system

n Synergy Neo 2_FI_B_MUB.prt tests the bottom filter-based fluorescence
system

n Synergy Neo 2_M_FI_T_MUB.prt tests the top optics of the
monochromator-based fluorescence system

Test Solutions

Filter solutions to remove particulates that could cause erroneous readings. Do not
allow dust to settle on the surface of the solution; usemicroplate covers or seals
when not reading the plate.

Wrap the vial containing theMUB stock solution in foil to prevent exposure to light.

Discard any open, unused solutions after seven days.

1. Prepare the buffer (CBB) solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200mL of
deionized or distilled water.
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l Open and dissolve the contents of two CBB capsules (do not dissolve the
outer gelatin capsule) into 200mL of the water.

l Stir the solution (preferably using a stir table) until the CBB is completely
dissolved.

2. Prepare theMUB stock solution:

l Add 1mL of 100%methanol to the 10mg vial ofMUB.

l Make sure all of the dye has completely dissolved and is well mixed. This
yields a 10mg/mL stock solution.

l Wrap the solution in aluminum foil to prevent exposure to light.

3. Prepare the dilutions. Label each with <MUB= and the concentration.

Mix This MUB Solution: With: To Make:

0.5mL of 10mg/mL stock solution 4.5mL of 100%methanol 1mg/mL

0.88mL of 1mg/mL solution 4.12mL of CBB 176 ¿g/mL

0.1mL of 176 ¿g /mL solution 9.9mL of CBB 1.76 ¿g /mL

0.5mL of 1.76 ¿g /mL solution 4.5mL of CBB 176 ng/mL

1mL of 176 ng/mL solution 9mL of CBB
17.6 ng/mL
(100 nM)

Test Procedure

1. If you have not already done so, prepare the test solutions. See page 134.

Refer to the pipettemap on the next page for the remaining steps.

2. Perform the Sensitivity and Linearity tests using the Top optics of the filter-based
fluorescence system:

l Pipette the solutions into a clean, 96-well plate.

l Create an experiment based on Synergy Neo 2 FI_T_MUB.prt.

l Perform the steps under Determine the Optimal Read Height to determine
and set the optimal read height for the filter cube/fluid height combination.

l Read the plate, and save the experiment.

l If you intend to run this test in the futurewith the same filter cube,
select File > Save Protocol As, and save the updated protocol with the
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adjusted read height. You must, however, rerun these steps if you change
the filter cube used with this test.

3. Perform the Sensitivity and Linearity tests for themonochromator-based
fluorescence system:

l Create an experiment based on Synergy Neo 2_M_FI_T_MUB.prt.

l Read the plate, and save the experiment

4. If applicable, perform the Sensitivity and Linearity tests using the Bottom optics of
the filter-based fluorescence system:

l Create an experiment based on Synergy Neo 2_FI_B_MUB.prt.

l Perform the steps under Determine the Optimal Read Height to determine
and set the optimal read height for the filter cube/fluid height combination.

l Read the plate, and then save the experiment.

l (Optional) Save the updated protocol with the adjusted read height.

5. Refer to the instructions starting on page 133

l Troubleshooting tips are provided on page 102.

l Test descriptions are provided on page 128.

Determine the Optimal Read Height

1. Select Protocol > Procedure, and open the "Sensitivity Read" step.

2. Click Options, clear Automatic Gain Adjustment, and click OK.

3. Click Show advanced options to display the Read Height information.

4. Click Auto-Adjust. Set the Test Well to D7, and click Start Calibration. When
prompted, place the plate on the carrier and click OK.

5. When calibration is complete, a graph appears. Click Select to use the Optimal
Height.

6. Click Options again, and select Automatic Gain Adjustment.

7. Record the optimal read height, then click OK to close the read step and return to
the Procedure dialog.

8. Open the "Sensitivity Read Buffer" step. Set the read height to match the recorded
value from step 7 above, then return to the Procedure dialog.

9. Open the "Linearity Read" step. Repeat steps 236 above; set the Test Well to C1 in
step 4.

10. Return to the Procedure dialog, then click OK to close the Procedure and return to
the experiment.
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Pipette Map

Seal the plate with foil or store it in a black polyethylene bag until use. When using a
clear-bottom plate, if the base of the plate is touched, clean the entire base with alcohol
(95% ethanol) and then wipe with a lint-free cloth. Before placing a plate in the
instrument, blow the bottom of the plate with an aerosol duster.

Using a single-channel pipette: 

l Pipette 200 µL of 17.6 ng/mL (100 nM)MUB solution into well D7.

l Pipette 200 µL of buffer into wells C9, D9, and E9.

Using a multichannel pipette with just four tips installed:

l Pipette 150 µL of buffer into columns 235 (not column 1). Discard the tips.

l Pipette 150 µL of the 17.6 ng/mL (100 nM) solution into column 1. Discard the tips.

l Pipette 150 µL of the 17.6 ng/mL (100 nM) solution into column 2. Do not discard
the tips.

l Aspirate 150 µL from column 2 and dispense it into column 3. Mix the wells using
the pipette. Do not discard the tips.

l Aspirate 150 µL from column 3 and dispense it into column 4. Mix the wells using
the pipette. Do not discard the tips.

l Aspirate 150 µL from column 4 and dispense it into column 5. Mix the wells using
the pipette. Do not discard the tips.

l Aspirate 150 µL from column 5. Discard the tips.
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Injection System Tests

Injection System Testing, starting on page 104, describes the test methods, lists the
Gen5 protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

Required Materials

Manufacturer part numbers are subject to change over time.

l Absorbance reader with capability of reading at 405, 630, and 750 nm. The reader
must have an accuracy specification of ± 1.0% ± 0.010 OD or better and a
repeatability specification of ± 1.0% ± 0.005 OD or better.

The Synergy Neo2may be used if it has passed the Absorbance Plate Test or
Absorbance Liquid Test 2, and Absorbance Liquid Test 1.

l Microplate shaker (if the absorbance reader does not support shaking)

l Precision balance with capacity of 100 g minimum and readability of 0.001 g

l 503200 µL hand pipette and disposable tips

l Deionized water
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l Supply bottles

l 250-mL beaker

l New96-well, clear, flat-bottom microplates

l BioTek9s Green Test Dye Solution (PN 7773003) undiluted, or one of the alternate
test solutions listed in the next section

l 100-mL graduated cylinder and 10-mL pipettes (if not using BioTek9s Green Test
Dye Solution)

l Gen5 software installed on the host PC

l Gen5 protocols listed below (as applicable to your reader model) and described in
detail under Gen5 Parameters, starting on page 104

Synergy Neo2 Disp 1 Test.prt
Synergy Neo2 Disp 2 Test.prt

Alternate Test Solutions
If you do not have BioTek9s Green Test Dye Solution (PN 7773003), prepare a dye solution
using one of the following methods:

80 µL of test solution with 150 µL of deionized water should read between 1.300 and
1.700 OD at 405/750 nm. The solutions should be at room temperature.

Using BioTek9s Blue and Yellow Concentrate Dye Solutions:

Item Quantity

Concentrate Blue Dye Solution (PN
7773001, 125mL)

4.0mL

QC (Yellow) Solution (PN 7120782, 125
mL)

5.0mL

Deionized water 90.0mL
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Using FD&C Blue and Yellow Dye Powder:

Item Quantity per Liter

FD&C Blue No. 1 0.200 grams

FD&C YellowNo. 5 0.092 grams

Tween 20 1.0mL

Sodium Azide N3Na 0.100 gram

Deionized water Make to 1 liter

Test Procedure

1. Prime both dispensers with 4000 µL of deionized or distilled water.

2. Remove the inlet tubes from the supply bottles. Prime both dispensers with the
Volume set to 2000 µL. This prevents the water from diluting the dye.

3. Fill a beaker with at least 20mL of the green dye solution. Prime both dispensers
with 2000 µL of the solution. When finished, remove the priming plate from the
carrier.

4. In Gen5, create an experiment based on Synergy Neo2_Disp 1 Test.prt.

5. Place a new 96-well microplate on the balance and tare the balance.

6. Place the plate on themicroplate carrier.

Running a dispense procedure without placing a plate in the reader will result in
contamination of the reader from spilled liquid.

When each dispense step is finished, you will weigh the plate, record the weight,
tare the balance with the plate on it, and then place the plate back on the carrier
for the next step.

7. Initiate a plate read. Gen5 prompts you to empty the tip priming trough.

8. When ready, click OK at the Load Plate dialog to begin the experiment. The
sequence is as follows:

a. Dispense 80 µL/well to columns 134.

b. Remove the plate and weigh it. Record the weight and tare the balance.

c. Place the plate on the carrier and dispense 20 µL/well to columns 538.

d. Remove the plate and weigh it. Record the weight and tare the balance.
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e. Place the plate on the carrier and dispense 5 µL/well to columns 9312.

f. Remove the plate and weigh it. Record the weight.

g. Manually pipette 150 µL of deionized or distilled water into all 12 columns, on
top of the green test dye solution.

h. Place the plate on the carrier for a 30-second shake, the <80 µL= read at 405/750
nm, and the <20 and 5 µL= read at 630/750 nm.

9. When finished, select File > Save As. Enter an identifying file name and click Save.

10. Remove the plate from the carrier and set it aside.

11. Repeat steps 439 using Synergy Neo2_Disp 2 Test.prt.

12. When the tests are complete:

l Refer to the instructions on page 105 to perform calculations and determine
pass/fail.

l Test descriptions are provided on page 104

When all tests are complete, prime both dispensers with at least 5000 µL of deionized
water to flush out the green dye solution.

For your convenience, worksheets are included at the end of this chapter for recording
the dispense weights, Delta OD values, calculations, and pass/fail.

Gen5 Test Protocols

1. Select System > Instrument Configuration, and add/configure the Synergy Neo2 (if
it is not already there).

2. Create a new protocol.

To edit a protocol category, double-click its <branch= in the tree.

3. Perform the steps in the following three sections to define the Procedure,
customize the Plate Layout, and add Data Reduction steps, to test Dispenser #1.

4. When finished, select File > Save As and save the file as Synergy Neo2_Disp 1
Test.prt.

5. Repeat steps 234 above to create Synergy Neo2_Disp 2 Test.prt to test Dispenser
2.
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Define the Procedure

In brief, the protocol9s procedure follows the sequence below. After each Dispense step, the
plate is ejected to allow the operator to weigh it and then tare the balance.

l Dispense 80 µL dye to columns 134

l Dispense 20 µL dye to columns 538

l Dispense 5 µL dye to columns 9312

l Shake the plate for 30 seconds

l Read columns 134 at 405/750 nm and calculate the Delta OD

l Read columns 5312 at 630/750 nm and calculate the Delta OD

The detailed procedure is described on the next page. To add a step to the procedure, click
the appropriate button on the left side of the Procedure dialog and define the required
parameters.

The comments suggested for use with the Plate Out/In steps are optional, but they
may be useful for the person running the test. When the Plate Out/In step is executed,
Gen5 displays its comment in a message box.

Gen5 Procedure Steps

Step Type Details

1. Dispense Dispenser <select 1 or 2, depending on the protocol>

Dispense to wells A1..H4

Tip prime before this dispense step, 20 µL

Dispense 80 µL at rate 275 µL/sec

2. Plate Out,In Suggested comment: Weigh the plate (80 µL test).
RECORD the weight, TARE the balance. Place the plate
back on the carrier. Click OK to continue.

3. Dispense Dispenser <select 1 or 2, depending on the protocol>

Dispense to wells A5..H8

Tip prime before this dispense step, 20 µL

Dispense 20 µL at rate 250 µL/sec

4. Plate Out,In Suggested comment: Weigh the plate (20 µL test).
RECORD the weight and TARE the balance. Place the
plate back on the carrier. Click OK to continue.
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Gen5 Procedure Steps

Step Type Details

5. Dispense Dispenser <select 1 or 2, depending on the protocol>

Dispense to wells A9..H12

Tip prime before this dispense step, 5 µL

Dispense 5 µL at rate 225 µL/sec

6. Plate Out,In Suggested comment: Weigh the plate (5 µL test).
RECORD the weight. PIPETTE 150 µL/well of DI water
into all 12 columns. Place the plate back on the carrier.
Click OK to perform the Read steps.

7. Shake Orbital at 425 cpm (3mm) for 30 seconds.

8. Read Step label: <80 ul Read_Disp 1= (or _Disp 2)

Wells: A1..H4

Detection Method: Absorbance

Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 405 and 750 nm

9. Read Step label: <20 and 5 ul Read_Disp 1= (or _Disp 2)

Wells: A5..H12

Detection Method: Absorbance

Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 630 and 750 nm

Customize the Plate Layout (Optional)
The results analysis worksheet at the end of this chapter requires the calculation of the
Standard Deviation, Mean, and %CV of the ODs read for each dispense volume in each
plate (six sets of calculations). By identifying the wells by their dispense volumes in the Plate
Layout, Gen5will calculate these values for you.
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1. In the protocol, open the Plate Layout dialog.

2. Set the Type set to Assay Control and define three control types: Disp_80, Disp_20,
and Disp_5.

3. In the Plate Layout, select Disp_80 and highlight wells A1 to H4.

4. Select Disp_20 and highlight wells A5 to H8.

5. Select Disp_5 and highlight wells A9 to H12.

6. Click OK to save the changes and close the dialog.

After running the experiment, view the Statistics for each Delta OD Data Set to view the
calculations

Add Data Reduction Steps
Each Read step is performed using two wavelengths, so you will create two data reduction
steps to calculate the Delta OD values.

1. In the protocol, open the Data Reduction dialog and click Custom. Transformation.

2. Click Select multiple data sets and then select DS2.

3. Set the Data In for DS1 to the 80 µL Read step at 405 nm.

4. Set the Data In for DS2 to the 80 µL Read step at 750 nm.

5. Click OK to return to the Transformation dialog.

6. In the NewData Set Name field, type an identifying name such as Delta OD 80 ul_
Disp 1.

7. ClearUse single formula for all wells.

8. In the Current Formula field, type DS13DS2 and then highlight wells A1 to H4 to
assign the formula.

9. Click OK to add the transformation to the Data Reduction list.

10. Create another Transformation similar to the above, with these characteristics:

n DS1 set to the 20 and 5 µL Read step at 630 nm

n DS2 set to the 20 and 5 µL Read step at 750 nm

n NewData Set Name resembling Delta OD 20 and 5 uL_Disp 1

n Remember to clearUse single formula for all wells

n Formula DS13DS2 applied to wells A5 to H12
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11. When you are finished, the Data Reduction Steps list shows two Delta OD
transformations:

12. Click OK to close the Data Reduction dialog.

Alpha Detection Testing

Alpha Detection Test, starting on page 106, describes the test methods, lists the Gen5
protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

1. Pipette 100 µL of PBS in wells A13A12, B1, B33B4, B63B7, B93B10, B12, C13C12, and
G13H12 (see pipettemap, <BUF< wells).

2. Pipette 100 µL of 20 µg/mL Omnibead suspension into wells B2, B5, B8, and B11
(see pipettemap, <20 µg/mL OMB= wells).

Allow the plate to sit at room temperature for approximately 15minutes prior to use.

3. Create an experiment based on the Synergy Neo2 AlphaTest_Crosstalk.prt
protocol. Read the plate and then save the experiment.

4. When the test is complete:

l Refer to the instructions on page 106 to perform calculations and determine
pass/fail.

l Test descriptions are provided on page 106.

Required Materials

Manufacturer part numbers are subject to change over time.

l Recommended test solution, Alphascreen Omnibead Assay kit, available from
PerkinElmer (PN 6760626)

l Buffer: Phosphate-Buffered Saline (PBS), pH 7.237.6 (e.g., Sigma tablets, Mfg.
#P4417 or equivalent)

l Clean 96-well solid whitemicroplate, Costar #3912

l 15-mL conical-bottom, polypropylene sample tube

l Filter cubes:
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n Dual PMT system: 2 or equivalent (Alpha Top)

n 1 or equivalent (Alpha Bottom)

l Gen5 protocol Synergy Neo2_AlphaTest_Crosstalk.prt, described in detail on page
106

Test Solutions

Alphascreen Omnibeads are light sensitive. All tests should be performed under
subdued laboratory lighting of less than 100 lux.

1. Prepare the PBS buffer solution:

a. (Optional, but recommended) Using a 0.45-micron filter, filter 200mL of
deionized or distilled water.

b. Follow themanufacturer's instructions on the PBS packaging to create 200mL,
dissolving the necessary amount of PBS into the filtered water.

c. Stir the solution (preferably using a stir table) until the PBS is completely
dissolved.

d. Check the pH; it should be between 7.2 and 7.6 at 25°C.

2. Prepare the Omnibead suspension:

a. Shake the container of 5mg/mL Omnibead suspension vigorously for 30
seconds prior to pipetting. Alternatively, sonicate or vortex the container.

b. Mix 20 µL of 5mg/mL Omnibead suspension with 4.98mL of PBS in a 15mL
conical bottom, polypropylene sample tube. This yields a 20 µg/mL Omnibead
suspension.

c. Refrigerate any unused portions of the Omnibeads. The temperaturemust be
between +2°C and +6°C.
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Pipette Map

Test Procedure

1. Pipette 100 µL of PBS in wells A13A12, B1, B33B4, B63B7, B93B10, B12, C13C12, and
G13H12 (see pipettemap, <BUF< wells).

2. Pipette 100 µL of 20 µg/mL Omnibead suspension into wells B2, B5, B8, and B11
(see pipettemap, <20 µg/mL OMB= wells).

3. Allow the plate to sit at room temperature for approximately 15minutes prior to
use.

4. Create an experiment based on the Synergy Neo2 AlphaTest_Crosstalk.prt
protocol. Read the plate and then save the experiment.

5. Open the Platemenu and export the data to the embedded Power Export
spreadsheet. The spreadsheet reports pass or fail for the test performed.

6. Print the spreadsheet and store it with your test records.
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General Specifications

Microplates

The Synergy Neo2 accommodates standard 6-, 12-, 24-, 48-, 96-, 384-, and 1536-well microplates
with 128 x 86 mm geometry and the Take3 and Take3 Trio Micro-Volume Plates.

Maximum Plate Height: 0.89"

Hardware and Environmental

Light Source

Absorbance, Fluorescence
(FI), monochromator-
based:

Xenon flash light source, 20Wmaximum average power (not
user-changeable)

Fluorescence (FI/FP), filter-
based:

Xenon flash light source, 5Wmaximum average power (not user-
changeable)

TRF (filter-based):
Xenon flash light source, 5Wmaximum average power (not user-
changeable)

Dimensions
20.7" D x 15.5" W x 16.1" H

52.5 cm D x 39 cmW x 41 cm H

Weight:
With all modules installed, without power supply or dispense
module attached, < 85 lbs. (38.6 kg)

Environment:
Power-up temperature 18º to 30ºC

Operational temperature 18º to 40ºC

Humidity: 10% to 85% relative humidity (non-condensing)

Power Supply:
24-volt external power supply compatible with 1003240 V~; +/-
10%@50360 Hz

Power Consumption: 250Wmaximum

Incubation:

Alphascreen only: Temperature control range from 3ºC over
ambient to 30ºC.
All other modes: Temperature control range from 4ºC over
ambient to 65ºC.
Temperature variation ± 0.5ºC across the plate@ 37ºC, tested
with Innovative Instruments, Inc. temperature test plate
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Dispense/Read Specifications

Maximum Delay between End of Dispense and Beginning of Read
96/384-Well Plates, Default Probe Heights

Bottom Mono Fluorescence T < 1.0 second

Luminescence T < 1.0 second

Top Filter Fluorescence T < 1.0 second

Top Mono Fluorescence T < 1.0 second

Absorbance T < 1.0 second

Bottom Filter Fluorescence T < 1.0 second

Dispense/Read, for Models with the Dual-Reagent Dispense Module

Plate Type
Both injectors dispense to standard height 6-, 12-, 24-,
48-, 96-, and 384-well microplates.

Detection Method Absorbance, Fluorescence (FI, FP, TRF), Luminescence

Volume Range 531000 µL with a 5320 µL tip prime

Reagent Dead Volume
< 1100 µL, with dead volume recovery function (back
flush)

Injection Speeds 225, 250, 275, 300 µL/second

Accuracy ± 1µL or 2.0%, whichever is greater

Precision

< 2.0% for volumes of 503200 µL

< 4.0% for volumes of 25349 µL

< 7.0% for volumes of 10324 µL

< 10.0% for volumes of 539 µL
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Absorbance Specifications

Optics

Wavelength Range 230 to 999 nm

Wavelength Bandpass < 4 nm (2303285 nm), < 8 nm (> 285 nm)

Measurement Range 0.000 to 4.000 OD

Resolution 0.0001OD

Increment 1 nm

Wavelength Accuracy ± 2 nm

Wavelength Precision ± 0.2 nm

Minimum kinetic interval (450 nm) < 12 seconds, sweep mode, 384-well microplate

Plate In/Plate Out Speed

< 20 seconds, 450 nm, sweep mode, 384-well microplate

BioTek Instruments, Inc.
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Accuracy, Linearity, Repeatability

Specifications apply from 2503999 nm, 200 µL (96-well microplates) and 80 µL (384-well
microplates).

Accuracy (tested with certified neutral density glass)

96-well plate, normal read speed

032OD: +/-1% +/-0.010 OD, delay after platemovement = 100ms

232.5 OD: +/-3% +/-0.010 OD, delay after platemovement = 100ms

384-well plate, normal read speed

032OD: +/-2% +/-0.010 OD, delay after platemovement = 100ms

232.5 OD: +/-5% +/-0.010 OD, delay after platemovement = 100ms

96-well and 384-well plate, sweep read speed

031OD: +/-2% +/-0.010 OD

Linearity (by liquid dilution)

96-well plate, normal read speed

032OD: +/-1% +/-0.010 OD, delay after platemovement = 100ms

232.5 OD: +/-3% +/-0.010 OD, delay after platemovement = 100ms

384-well plate, normal read speed

032OD: +/-2% +/-0.010 OD, delay after platemovement = 100ms

232.5 OD: +/-5% +/-0.010 OD, delay after platemovement = 100ms

96-well and 384-well plate, sweep read speed

031OD: +/-2% +/-0.010 OD

Repeatability (tested with certified neutral density glass/measured by one standard
deviation: 8 measurements per data point)

96-well and 384-well plate, normal read speed

032OD: +/-1% +/-0.005 OD, delay after platemovement = 100ms

232.5 OD: +/-3% +/-0.005 OD, delay after platemovement = 100ms

96-well and 384-well plate, sweep read speed

031OD: +/-2% +/-0.010 OD
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Take3 Plate

Detection Limit, 260 nm dsDNA < 5 ng/¿L

Fluorescence Specifications (Mono-Based)
The Synergy Neo2measures fluorescence with monochromators from the top and bottom
of 6- to 1536-well plates.

Monochromator-Based Fluorescence

Excitation
range

2503900 nm with red-shifted PMT

Emission
range

2503900 nm with red-shifted PMT; 300 nm minimum with EM scan.

Bandpass
Excitation and Emission: Variable, from 3 nm350 nm (wavelength dependent)
in 1 nm increments

Optical Probes

Top position 2.00mm diameter fixed

Bottom position 2.00mm diameter fixed

Plate In/Plate Out Speed

< 20 seconds for filter set, sweep mode, 384-well microplate

Sensitivity

96-/384-well
plates

Sodium Fluorescein in phosphate buffered saline (PBS)
DL <= 20 pM top or bottom read, 2 pM typical
Excitation 485 nm, Emission 528 nm
Methylumbelliferone (MUB) in carbonate-bicarbonate buffer (CBB)
DL <= 0.16 ng/mL (0.91 nM) top read
Excitation 360 nm, Emission 460 nm
Propidium Iodide (PI) in PBS
DL <= 62.5 ng/mL bottom read
Excitation 485 nm, Emission 645 nm
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Fluorescence Specifications (Filter-Based)
The Synergy Neo2measures fluorescence with filters from the top and bottom of 6- to 1536-
well plates.

Optical Probes

Top position 2.6-mm diameter fixed

Bottom position 2.6-mm diameter fixed

Top Single PMT

Plate In/Plate Out Speed

< 20 seconds for filter set, sweep mode, 384-well microplate

Sensitivity

96-/384-well plates

DL < 5 pM (< 1 pM typical) solution of Sodium Fluorescein in PBS
Excitation 485/20, Emission 528/20, 510 nm mirror

DL f 0.16 ng/mL (0.91 nM) solution ofMethylumbelliferone in
CBB, Excitation 360/40, Emission 460/40, 400 nm mirror

Time-Resolved Fluorescence

96-/384-well plates DL Europium f 250 fM (100 fM typical)

Excitation 360/40 nm,

Emission 620/40 nm 400 nm mirror

Integration Interval 20 to 2000 µs

Delay 0 to 2000 µs

Granularity 1-µs step

Top Double PMT

Plate In/Plate Out Speed

< 20 seconds for filter set, sweep mode, 384-well microplate

Fluorescence Polarization

96-/384-well plate
< 5mP standard deviation at 1 nM Sodium Fluorescein (1mP typical)
Excitation 485/20 nm, Emission 528/20 nm, 510 nm mirror
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Bottom Optics

Sensitivity

96-/384-well plates

DL < 5 pM (< 2 pM typical) solution of Sodium Fluorescein in PBS
Excitation 485/20, Emission 528/20, 510 nm mirror

DL f 0.16 ng/mL (0.91 nM) solution ofMethylumbelliferone in CBB,
Excitation 360/40, Emission 460/40, 400 nm mirror

Luminescence Specifications
The Synergy Neo2measures luminescence from the top of 6- to 384-well plates. The
following requirements apply to 96-well plates with 200 µL/well, at room temperature.

Production testing is performed using a Harta plate.

Luminescence

96-well plate, standard low-noise PMT f 50 amol/well, 10 amol typical

Integration Time 10 seconds

Blank Wells 16

Cross-talk
< 0.1% in 96-well plate

< 0.25% in low-volume 384-well plate

Alpha Detection Specifications

Alpha Laser

Laser Output Power 100mW ± 10%
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Error Codes

This appendix lists and describes Synergy Neo2 error codes that may appear
in Gen5.

Error Codes Overview 158

Error Codes 158
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Error Codes Overview
When a problem occurs during operation with the Synergy Neo2, an error code appears in
Gen5. Error codes typically contain four characters, such as <4168,= and in most cases are
accompanied by descriptive text, such as <PMT overload error.= With many errors, the
instrument will beep repeatedly; press the carrier eject button to stop this alarm.

Some problems can be solved easily, such as <2B0A: Priming plate not detected= (place a
priming plate on the carrier). Some problems can be solved only by trained BioTek service
personnel. This appendix lists themost common and easily resolved error codes that you
may encounter.

Error codes beginning with <A= (e.g., A100) indicate conditions that require immediate
attention. If this type of code appears, turn the instrument off and on. If the System
Test does not conclude successfully, record the error code and contact BioTek9s
Technical Assistance Center.

If an error code appears in Gen5, you may want to run a System Test for diagnostic
purposes. In Gen5, select System > Diagnostics > Run System Test.

If an error message appears while an experiment is in process and after
having received measurement data, it is your responsibility to
determine if the data is valid.

Contact Info: BioTek Service/TAC
Use this appendix to diagnose problems and solve them if possible. If you need further
assistance, contact BioTek9s Technical Assistance Center.

Phone: 800-242-4685 (toll free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-654-0638

E-Mail: tac@biotek.com

For errors that are displayed during operation of the Synergy Neo2with the stacker or
the BioStack 4, refer to the stacker's or Biostack's operator's manuals.

Error Codes
This table lists themost common and easily resolved error codes that you may encounter. If
an error code appears in Gen5, look for it here. If you find the code, follow the suggestions
provided for solving the problem. If you cannot find the code or if you are unable to solve
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the problem, please contact BioTek9s Technical Assistance Center. The Gen5 Help system
also provides troubleshooting tips.

Code Description and Possible Remedy

2353 Expected plug/hole/filter not found in filter cube

This error indicates that the filter cube is not installed and is required for the read.
Install the filter cube or check that it is installed correctly.

2700 Error attempting to run the barcode scanner SET command

A response returned from the scanner is invalid.

2701 Error attempting to run the barcode scanner SET command

The command message is calling out an invalid barcode location. Valid numbers
are 134.

2702 Error attempting to get barcode scanner information regarding one of the
barcode types

The barcode type returned by the scanner is not one of those expected.

2703 Barcode type is not supported

One of the four barcode types is not supported by the scanner.

2704 Error disabling start/stop character transmission

While attempting to tell the scanner to disable the transmission of start and stop
characters along with the barcode value for the Codebar barcode type, an error
occurred.

2B0A Priming plate not detected

2B0x Dispenser syringe 1 or 2 (respectively) did not home

x=133

Generally, this error indicates the syringe was not properly installed. Make sure
the syringe9s thumbscrews are properly threaded. (Refer to the Installation
chapter for instructions.) Restart the reader.

2B04 Dispenser syringe 1 or 2 (respectively) failed position verify

Generally, this error indicates the syringe was not properly installed. Make sure
the syringe9s thumbscrews are properly threaded. Restart the reader. (Refer to the
Installation chapter for instructions.)
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Code Description and Possible Remedy

37x0/47x0
38x0/48x0
39xy/49xy

Noise Test Errors
Offset Test Errors
Dark Range Errors

x=0, 1; y=036

This series of System Test errors may indicate too much light inside the chamber.
Make sure the plate carrier door and the front hinged door are properly closed.
For models with the dispensemodule, if the dispense tubes are not connected to
the reader, re-install the light shield that shipped with the instrument (or cover the
hole with black tape). Restart the reader.

4Fxy Fluorescence signal out of range.

x=0, 1; y=036

Too low of a reading indicates a light signal problem. Ensure that Gen5 Fluor/Lum
wavelengths tablematches the actual filter installed in the filter cube.

40xx PMT overload well error at <well #xxx>

This error typically means that the fluid in a well has oversaturated the PMT (i.e.,
the well is too bright). Try lowering the sensitivity value in the read step.

To identify the well:

Wells are counted starting at A1, moving left-to-right, row-by-row. The row and
column of the well can be extracted from the well number code by applying the
following formula (example uses 8 x 12 geometry, 96-well plate):

1. Convert the ASCII hex string to a decimal equivalent. Ex: <057= indicates 57 hex,
yielding a well code of 87 decimal.

2. Row = (well code) / (columns in plate), rounded up to a whole number. Ex: 87/12
= 7.25, indicating row 8 (or H).

3. Column = (well code) - ((row-1) * (columns in plate)). Ex: 87 - ((8 - 1) * 12) =
column 3.

NOTE: If this code is returned during an area scan, it indicates the scan point
corresponding to the row/column equivalent in the currently defined scan map,
NOT the actual well where the error occurred.
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Code Description and Possible Remedy

4Exy Detector saturated (too much light). Relative Fluorescing Units (RFU) reached
(99999).

X = Fluorescence channel

Fluorescence/Luminescence Channel Codes

Mono optics reference channel 0

Mono optics PMT channel 1

Top filter optics reference channel 2

Top filter optics, top PMT channel 3

Top filter optics, side PMT channel 4

Bottom filter optics reference channel 5

Bottom filter optics PMT channel 6

Y = PMT Test Type Code

Connection Test 0 PMT not connected

High Voltage Test 1 Failure during test at higher voltage

Low Voltage Test 2 Failure during test at lower voltage

Well Overload Test 5 Failure during test at well

Background Overload Test 8 Failure during background overload test

OR Y = filter readset

This error can indicate one of several scenarios. It is possibly due to incorrect
chemistry, e.g., the fluorescence standards dispensed to the plate exceed
expectations.

For models with the dispensemodule, the internal chamber may require cleaning
(contact BioTek TAC).

If a 4E18 error is detected during monochromator-based fluorescence, the
luminescence probemay be picking up stray light. Try installing a plug in the filter
cube. Restart the reader.

2D46 Fluorescence wavelength not found in table

This error indicates that the wavelength specified in the procedure is not detected
in the instrument9s filter table. In Gen5, verify the Fluorescence filter table has the
wavelengths loaded into the reader. Compare the contents of the table with the
filters installed in the filter cube (see the Gen5 Help system for more information).
Restart the reader.
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Code Description and Possible Remedy

50xx
510x

Axis failed to home

Top filter optics, lower filter/mirror slider 03

Top filter optics, upper filter/mirror slider 04

Bottom filter optics, filter/mirror slider 06

Generally, this error indicates the filter cube is not seated properly in the reader.
Remove it, ensure each filter or plug is properly positioned and reinstall it securely.
Restart the reader.

540x Filter cube failed positional verify

Top filter optics, lower filter/mirror slider 03

Top filter optics, upper filter/mirror slider 04

Bottom filter optics, filter/mirror slider 06

Generally, this error indicates the filter cube is not seated properly in the reader.
Remove it, ensure each filter or plug is properly positioned and reinstall it securely.
Restart the reader.
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Code Description and Possible Remedy

55xy <Motor> not homed successfully

xy=axis

Axis Codes

Carrier X 00

Carrier Y 01

Top probe Z 02

Top filter optics, lower filter/mirror slider 03

Top filter optics, upper filter/mirror slider 04

Bottom probe Z 05

Bottom filter optics, filter/mirror slider 06

Mono optics, excitation filter sector 07

Mono optics, excitation slit wheel 08

Mono optics, emission filter sector 09

Mono optics, emission slit wheel 0A

Mono optics, probe changer 0B

Excitation monochromator grating 0C

Emission monochromator grating 0D

Dispenser syringe 1 0E

Dispenser syringe 2 0F

This error indicates that an axis failed a previous verify function and nowneeds to
be homed. Check for any obstructions that may prevent the carrier, syringes, or
filter cube from moving normally. Restart the reader.

570x Area Scan matrix too large for perimeter wells

x=0, 1

For some plate type and read probe combinations, it might not be possible to
define the entire area scan matrix offered by Gen5 for some perimeter wells, due
to the physical limitations of carrier travel. Redefine the area scan to include a
smaller matrix or select wells in a different row or column.
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Code Description and Possible Remedy

5A0x Plate could not be moved inside

x=0, 1

Make sure the Plate Type defined in the Gen5 Protocol matches the plate you are
using. This error can also occur if the plate type is correct but the lid was left on the
plate. If you wish to read the plate with a lid on it, create a new plate type in Gen5
with the correct Plate Height. This error can also indicate that the plate is not
seated in the carrier correctly. Remove the plate and replace it securely in the
carrier.

Verify the tip priming trough has not become dislodged. Remove any plates from
the carrier and power cycle the instrument to see if the error is resolved.

5B00 Required carrier in when expected to be outside

Carrier is inside the chamber when it should be outside. This may occur if the read
was aborted and "home all axes" not performed.

This error can also occur if the carrier is inside and the newly defined plate height is
different from themost recently specified plate height.

To resolve the error, eject the carrier prior to running the experiment.

70xx Motor synchronization error

If at any time it is discovered that a motor is currently on the wrong microstep boundary
for a move of a specified microstep size, a motor synch error is flagged.

l Verify there is no binding of axis movement.

l Turn the instrument off and on to see if the error is
repeatable.

l Reload the basecode.
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Microplate Barcode Scanner

This appendix contains instructions for installing the optional microplate
barcode scanner and specifications for microplate barcode label format and
positioning. It also tells you how to set up Gen5 to view and use the scanned
barcodes.

Overview 166

Install the Microplate Barcode Scanner 166

About Barcode Labels 169

Placing a Barcode Label 170

Microplate Scanner Diagnostic Utility 171
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Overview
The BioTek external barcode scanner allows you to automate the reading ofmicroplate
barcode labels in a robotic system. If a valid barcode is read, the barcode value is
automatically passed to Gen5 for storage in the Gen5 experiment.

Warning! Laser Radiation. Do not look directly into the laser beam during
operation of the scanner. Serious eye injury may occur if you stare directly into
the beam. Please note the warning label on the outside of the scanner9s
protective cover.

The barcode scanner can be installed on either side of or in front of the reader, depending
on which side of themicroplate the barcode label is located.

Package Contents
BioTek PN 1030008 contains:

l Barcode scanner assembly: scanner (housed in a protective cover), scanner cable,
and mirror attached to a removablemounting bracket

l Scanner alignment bracket

Install the Microplate Barcode Scanner

Be very careful not to scratch or damage the scanner's mirror when unpacking or
installing themicroplate barcode scanner! If you are using a stacker, install the stacker
with the interfacing instrument before installing the barcode scanner. See Chapter 2,
Installation.

The barcode scanner can be placed to the left, the right, or in front of the reader's carrier.
Select themounting position based on the location of the barcode labels on your
microplates.

1. Lift the front of the Synergy Neo2, place themounting bracket under the locating
pins, and carefully lower the instrument into themounting bracket.
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2. Determine the appropriatemounting position for the barcode scanner: left, front,
or right.
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3. Mount the barcode scanner in the bracket, then tighten the thumbscrew.

4. Plug one end of the communications cable into the barcode reader and connect
the other end to the Synergy Neo2.
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About Barcode Labels
Barcode labels are available for purchase from BioTek, or they may be created using
barcode software and label products that meet the following specifications:

l Label format (<symbology=): Required formats are:

o Code 128 o Codebar

o Code 39 o UPS

o Datamatrix o QR

o PDF 417 o GS1 Databar

l Industry Standards: The labels should bemade in accordance with Automation
Identification Manufactures (AIM) uniform symbol specification for all codes
supported. Label decodability should meet ANSI Specification X2, 182-199 <Bar-
Code Print Quality Guideline= for a rating of A/05/880.

l Label quality: The labels should be printed on good-quality copier machines or
laserjet printers.

l Label position on plate: The labels should not extend above or below the edges of
the plate, because the plates may stick to one another when they are stacked.

See Placing a Barcode Label on page 170 for more information about where to place the
label on themicroplate.

The following figures contain barcode label artwork that may be submitted to a print vendor
for creating labels. The areas marked as quiet zones are critical for the reader to locate the
barcode image.
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Placing a Barcode Label
Barcode labels can be located on either the long sides of a microplate or the short side
opposite the well A1 location. The next figure shows the location on themicroplate where
the label must be placed in order to be read properly.

Label Placement Examples
Review the following examples of good label placement:
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These examples demonstrate poor placement of the barcode labels:

Microplate Scanner Diagnostic Utility
To ensure that themicroplate barcode scanner mirror is correctly positioned to scan the
barcodes, use the Barcode Scanner Diagnostic utility in Gen5.

1. Place a microplate with a barcode label on the Synergy Neo2 carrier.

2. From themain Gen5 screen, click System > Instrument Configuration, select the
Synergy Neo2, and click View/Modify > Setup.
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3. On the Barcode Scanner Diagnostic tab, click Start Diagnostic. You can see the
reflected red light from the laser shining toward themicroplate carrier.

4. If necessary, click Jog Carrier In to gradually move the carrier so that the barcode
label is within the range of the laser light. When the barcode scanner can read the
label, the results are displayed in the Reader Response area.

5. If the scanner is unable to read the label, adjust the scanner's mirror position using
themirror adjustment thumbscrew and run the utility again.

6. When themirror is set correctly, click Stop Diagnostic. The barcode scanner is now
ready to use.
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Appendix D

Sample Reports

This appendix contains sample System Test and Absorbance Plate Test
reports for the Synergy Neo2.
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Absor bance Test  Pl at e Resul t s

Reader : Syner gy Neo2  ( Ser i al  Number :  16060915)
Basecode: P/ N 1350200  ( v1. 14)
Dat e and Ti me: 6/ 8/ 2016 2: 51: 17 PM
Absor bance Pl at e: 7 Fi l t er  Test  Pl at e ( P/ N 7260522)  -  S/ N 210508
Last  Pl at e Cer t i f i cat i on: Sept ember  2015
Next  Pl at e Cer t i f i cat i on Due:  Sept ember  2016
User :                          Admi ni st r at or
Comment s:

Peak Absor bance Resul t s

Wel l C6 C6 C6 C6
Ref er ence   279 361 418 643
Tol er ance   3 3 3 3
Read 280 362 419 643
Resul t PASS PASS PASS PASS

Al i gnment  Resul t s

Wel l s A1 A12 H1 H12
Read 0. 000 0. 000 0. 000 0. 000
Tol er ance   0. 015 0. 015 0. 015 0. 015
Resul t PASS PASS PASS PASS

Wavel engt h = 450 nm

Accur acy Resul t s

Wel l s C1 E2 G3 H6 F5 D4
Ref er ence   0. 143 0. 580 1. 082 1. 645 1. 919 2. 496
Mi n Li mi t    0. 120 0. 548 1. 040 1. 592 1. 861 2. 376
Max Li mi t    0. 166 0. 612 1. 124 1. 698 1. 977 2. 616
Read 1 0. 140 0. 577 1. 083 1. 649 1. 919 2. 500
Resul t PASS PASS PASS PASS PASS PASS

Repeat abi l i t y  Resul t s

Wel l s C1 E2 G3 H6 F5 D4
Read 1 0. 140 0. 577 1. 083 1. 649 1. 919 2. 500
Mi n Li mi t    0. 133 0. 566 1. 067 1. 628 1. 895 2. 420
Max Li mi t    0. 146 0. 588 1. 099 1. 670 1. 943 2. 580
Read 2 0. 140 0. 578 1. 084 1. 650 1. 919 2. 499
Resul t PASS PASS PASS PASS PASS PASS

Wavel engt h = 630 nm

Accur acy Resul t s

Wel l s C1 E2 G3 H6 F5 D4
Ref er ence   0. 169 0. 589 1. 099 1. 673 1. 795 2. 337
Mi n Li mi t    0. 146 0. 557 1. 057 1. 620 1. 739 2. 224
Max Li mi t    0. 192 0. 621 1. 141 1. 726 1. 851 2. 450
Read 1 0. 166 0. 584 1. 094 1. 667 1. 793 2. 335
Resul t PASS PASS PASS PASS PASS PASS

Repeat abi l i t y  Resul t s

Wel l s C1 E2 G3 H6 F5 D4
Read 1 0. 166 0. 584 1. 094 1. 667 1. 793 2. 335
Mi n Li mi t    0. 159 0. 573 1. 078 1. 645 1. 770 2. 260
Max Li mi t    0. 172 0. 595 1. 110 1. 688 1. 815 2. 410



Read 2 0. 166 0. 584 1. 094 1. 667 1. 793 2. 335
Resul t PASS PASS PASS PASS PASS PASS

Wavel engt h = 750 nm

Accur acy Resul t s

Wel l s C1 E2 G3 H6 F5 D4
Ref er ence   0. 148 0. 474 0. 881 1. 339 1. 273 1. 657
Mi n Li mi t    0. 125 0. 445 0. 843 1. 292 1. 228 1. 604
Max Li mi t    0. 171 0. 503 0. 919 1. 386 1. 318 1. 710
Read 1 0. 147 0. 472 0. 878 1. 335 1. 270 1. 651
Resul t PASS PASS PASS PASS PASS PASS

Repeat abi l i t y  Resul t s

Wel l s C1 E2 G3 H6 F5 D4
Read 1 0. 147 0. 472 0. 878 1. 335 1. 270 1. 651
Mi n Li mi t    0. 141 0. 462 0. 865 1. 316 1. 252 1. 630
Max Li mi t    0. 154 0. 481 0. 892 1. 353 1. 288 1. 673
Read 2 0. 147 0. 472 0. 878 1. 335 1. 270 1. 651
Resul t PASS PASS PASS PASS PASS PASS

Dat e: _____________Revi ewed/ Appr oved By:  ____________________________

For  Techni cal  Suppor t

I n t he U. S. :
Bi oTek I nst r ument s,  I nc.
    Tel :  800 242 4685
    Fax:  802 654 0638

I n Eur ope:
    Bi oTek I nst r ument s GmbH
    Tel :  49( 0) 7136- 9680
    Fax:  49( 0) 7136- 968- 111

Al l  Ot her s:
    Tel :  802 655 4040
    Fax:  802 654 0638

emai l :  TAC@bi ot ek. com
Pr oduct  suppor t  cent er :  ht t p: / / www. bi ot ek. com/ ser v i ce



Absor bance Test  Pl at e Resul t s

Reader : Syner gy Neo2  ( Ser i al  Number :  16060915)
Basecode: P/ N 1350200  ( v1. 14)
Dat e and Ti me: 6/ 8/ 2016 2: 57: 23 PM
Absor bance Pl at e: 6 Fi l t er  Test  Pl at e ( P/ N 7260551)  -  S/ N 283921
Last  Pl at e Cer t i f i cat i on: Oct ober  2015
Next  Pl at e Cer t i f i cat i on Due:  Oct ober  2016
User : Admi ni st r at or
Comment s:

Al i gnment  Resul t s

Wel l s A1 A12 H1 H12
Read 0. 000 0. 000 0. 000 0. 000
Tol er ance   0. 015 0. 015 0. 015 0. 015
Resul t PASS PASS PASS PASS

Wavel engt h = 340 nm

Accur acy Resul t s

Wel l s C1 E2 G3 H6 F5 D4
Ref er ence   0. 651 0. 642 0. 925 0. 927 1. 263 1. 273
Mi n Li mi t    0. 618 0. 609 0. 887 0. 888 1. 218 1. 228
Max Li mi t    0. 684 0. 675 0. 964 0. 966 1. 308 1. 318
Read 1 0. 658 0. 646 0. 931 0. 934 1. 272 1. 281
Resul t PASS PASS PASS PASS PASS PASS

Repeat abi l i t y  Resul t s

Wel l s C1 E2 G3 H6 F5 D4
Read 1 0. 658 0. 646 0. 931 0. 934 1. 272 1. 281
Mi n Li mi t    0. 646 0. 634 0. 917 0. 919 1. 254 1. 263
Max Li mi t    0. 669 0. 657 0. 946 0. 948 1. 290 1. 299
Read 2 0. 658 0. 646 0. 931 0. 934 1. 273 1. 281
Resul t PASS PASS PASS PASS PASS PASS

Dat e:  __________________Revi ewed/ Appr oved By: _________________________

For  Techni cal  Suppor t

I n t he U. S. :
Bi oTek I nst r ument s,  I nc.
    Tel :  800 242 4685
    Fax:  802 654 0638

I n Eur ope:
    Bi oTek I nst r ument s GmbH
    Tel :  49( 0) 7136- 9680
    Fax:  49( 0) 7136- 968- 111

Al l  Ot her s:
    Tel :  802 655 4040
    Fax:  802 654 0638

emai l :  TAC@bi ot ek. com
Pr oduct  suppor t  cent er :  ht t p: / / www. bi ot ek. com/ ser v i ce



Gen5 Syst em Test  Repor t

Reader : Syner gy Neo2  ( Ser i al  Number :  16060915)
Basecode: P/ N 1350200  ( v1. 14)
Gen5 Ver si on: 2. 09. 1
Dat e and Ti me: 6/ 8/ 2016 2: 45: 26 PM
User : Admi ni st r at or
Company:
Comment s:

Test  Resul t s
SYSTEM TEST PASS

Oper at or  I D: ______________________________________________________________

Not es: ____________________________________________________________________

__________________________________________________________________________

SYSTEM SELF TEST

1350200  Ver si on 1. 14 16060915 S1   S2   S3
1011 1000 0000 
M BA

Vol t age Ref er ence Test Mi n    Low   Hi gh    Max
   Mono Syst em Fl ash 1416   1751   2103   3089
   Top Fi l t er  Fl ash 2332   2915   3498
   Bot t om Fi l t er  Fl ash    2346   2930   3514
   Swi t ched 24V Power 1875

ABSORBANCE

Opt i cs Test Ref    Meas   Gai n  Reset s  R/ G
   #1: 230 1. 67    1    0. 597
    Test ed 2. 02    1    0. 496

Li ght 13537  39855
Dar k 10609  10632
Del t a 2928  29223

   #2: 285 2. 70    4    1. 483
    Test ed 2. 94    4    1. 358

Li ght 13140  39784
Dar k 10616  10659
Del t a 2524  29125

   #3: 405 2. 03    8    3. 936
    Test ed 2. 21    8    3. 623

Li ght 12998  39974
Dar k 10593  10649
Del t a 2405  29325

   #4: 630 2. 07    8    3. 873
    Test ed 2. 35    8    3. 404

Li ght 12752  39909
Dar k 10596  10651
Del t a 2156  29258

   #5: 800 2. 49    4    1. 608
    Test ed 1. 62    2    1. 234

Li ght 12651  39981
Dar k 10584  10632
Del t a 2067  29349



   #6: 999 2. 49    2    0. 804
    Test ed 2. 03    1    0. 492

Li ght 12683  39712
Dar k 10608  10631
Del t a 2075  29081

Noi se Test Ref    Meas
   Gai n 1. 00

Max 10571  10619
Mi n 10571  10618
Del t a 0 1

   Gai n 2. 03
Max 10610  10631
Mi n 10609  10630
Del t a 1 1

FLUORESCENCE/ LUMI NESCENCE

Monochr omat or  Syst em
   Bi as cur r ent  of f set 0. 0 count s   PASS  
   Of f set  vol t age 1664 count s   PASS  
   750V measur ement 159. 2 count s   PASS  
   750V noi se 38 count s  
   750V of f set 1678 count s  
   Reset  of f set 1717 count s  
   Ref er ence bi as 0. 0 count s   PASS  
   Ref er ence of f set 10543 count s   PASS  
   Ref er ence noi se 0. 2 count s   PASS  

Top Fi l t er  Syst em -  Top
   Bi as cur r ent  of f set     - 1. 1 count s   PASS  
   Of f set  vol t age 1665 count s   PASS  
   750V measur ement 543. 5 count s   PASS  
   750V noi se 221 count s  
   750V of f set 1693 count s  
   Reset  of f set 1729 count s  
   Ref er ence bi as - 2. 6 count s   PASS  
   Ref er ence of f set 10562 count s   PASS  
   Ref er ence noi se 0. 2 count s   PASS  

Top Fi l t er  Syst em -  Si de
   Bi as cur r ent  of f set     - 2. 0 count s   PASS  
   Of f set  vol t age 1653 count s   PASS  
   750V measur ement 98. 5 count s   PASS  
   750V noi se 25 count s  
   750V of f set 1660 count s  
   Reset  of f set 1716 count s  

Bot t om Fi l t er  Syst em
   Bi as cur r ent  of f set     - 0. 6 count s   PASS  
   Of f set  vol t age 1669 count s   PASS  
   750V measur ement 158. 8 count s   PASS  
   750V noi se 38 count s  
   750V of f set 1680 count s  
   Reset  of f set 1723 count s  
   Ref er ence bi as 0. 9 count s   PASS  
   Ref er ence of f set 10564 count s   PASS  
   Ref er ence noi se 0. 2 count s   PASS  

Fi l t er  Fl uor escence
Top Pr obe
   Ref er ence 400V   500V   600V   

Gai n 1. 00   1. 00   1. 00



Li ght 12699  14206  16003
Dar k 10562  10562  10562
Del t a 2137   3644   5441

Bot t om Pr obe
   Ref er ence 400V   500V   600V   

Gai n 1. 00   1. 00   1. 00
Li ght 12268  13488  14958
Dar k 10565  10565  10565
Del t a 1703   2923   4393

Mono Fl uor escence -  Opt i cs Test  -  500V
Top Pr obe
   Bandpass 17nm 40nm
   Sensi t i v i t y : 42   Ref    Meas    Ref    Meas 
   #1: 300

Li ght 14936   4270  15754   8023
Dar k 10631   1663  10587   1663
Del t a 4305   2607   5167   6360
Max 4396   2645   5271   6458
Mi n 4195   2544   5063   6259
St dDev 56 36 56 54

   #2: 485
Li ght 27204  11894  28436  21522
Dar k 10631   1663  10588   1663
Del t a 16573  10231  17848  19859
Max 16862  10361  18068  20048
Mi n 16174  10061  17778  19746
St dDev 231    105 90 93

Bot t om Pr obe
   Bandpass 17nm 40nm
   Sensi t i v i t y : 38   Ref    Meas    Ref    Meas 
   #1: 300

Li ght 14919   2611  15729   4020
Dar k 10631   1663  10588   1662
Del t a 4288    948   5141   2358
Max 4350    965   5249   2385
Mi n 4191    916   5013   2302
St dDev 48 14 67 24

   #2: 485
Li ght 27283  14459  28480  25465
Dar k 10631   1663  10588   1661
Del t a 16652  12796  17892  23804
Max 16816  12892  18080  23970
Mi n 16481  12707  17731  23583
St dDev 117 67    105    109

CALI BRATI ON

Car r i er  -  Top Mono Fl uor escence
   Upper  Lef t x=  - 98   y= 8597
   Lower  Lef t x= - 100   y= 2381
   Lower  Ri ght x= 9663   y= 2379
   Upper  Ri ght x= 9664   y= 8598
   Del t a 1 - 98 -  - 100=   +2
   Del t a 2 9664 -  9663=   +1
   Del t a 3 8598 -  8597=   +1
   Del t a 4 2379 -  2381=   - 2

Car r i er  -  Bot t om Mono Fl uor escence
   Upper  Lef t x= 1933   y=10487
   Lower  Lef t x= 1931   y= 4277
   Lower  Ri ght x=11697   y= 4275



   Upper  Ri ght x=11700   y=10489
   Del t a 1 1933 -  1931=   +2
   Del t a 2 11700 - 11697=   +3
   Del t a 3 10489 - 10487=   +2
   Del t a 4 4275 -  4277=   - 2

Car r i er  -  Absor bance
   Upper  Lef t x= 1899   y= 8588
   Lower  Lef t x= 1897   y= 2375
   Lower  Ri ght x=11662   y= 2373
   Upper  Ri ght x=11666   y= 8588
   Del t a 1 1899 -  1897=   +2
   Del t a 2 11666 - 11662=   +4
   Del t a 3 8588 -  8588=   +0
   Del t a 4 2373 -  2375=   - 2

Car r i er  -  Top Fi l t er  Fl uor escence
   Upper  Lef t x=- 3659   y= 6621
   Lower  Lef t x=- 3667   y=  414
   Lower  Ri ght x= 6105   y=  405
   Upper  Ri ght x= 6104   y= 6622
   Del t a 1 - 3659 - - 3667=   +8
   Del t a 2 6104 -  6105=   - 1
   Del t a 3 6622 -  6621=   +1
   Del t a 4 405 -   414=   - 9

Car r i er  -  Bot t om Fi l t er  Fl uor escence
   Upper  Lef t x=- 3161   y=10042
   Lower  Lef t x=- 3158   y= 3835
   Lower  Ri ght x= 6604   y= 3830
   Upper  Ri ght x= 6610   y=10048
   Del t a 1 - 3161 - - 3158=   - 3
   Del t a 2 6610 -  6604=   +6
   Del t a 3 10048 - 10042=   +6
   Del t a 4 3830 -  3835=   - 5

Car r i er  -  I nj ect or s
   Upper  Lef t x= 2197   y= 6621
   Lower  Lef t x= 2189   y=  414
   Lower  Ri ght x=11961   y=  405
   Upper  Ri ght x=11960   y= 6622
   Del t a 1 2197 -  2189=   +8
   Del t a 2 11960 - 11961=   - 1
   Del t a 3 6622 -  6621=   +1
   Del t a 4 405 -   414=   - 9

Car r i er  -  Test  Sensor s
   Mi ddl e Sensor 23151
   Test ed 23151
   Del t a +0

Top Pr obe Hei ght 26. 60 mm

Bot t om Pr obe Hei ght    14. 09 mm

Cube Sl i der s
   Top Lower 6440
   Top Upper 7184
   Bot t om 6372

Exci t at i on Monochr omat or
   Sl i t  Wheel 8568
   Pr obe Changer 4172



Backl ash 36
   305LP Edge - 942. 15
   Test ed - 943. 54
   Top Fl uor escence    B=+0. 00021273 C=+0. 06942856
   Bot t om Fl uor escence B=+0. 00045812 C=+0. 30668175
   Absor bance B=+0. 00069251 C=- 0. 21832025

Emi ssi on Monochr omat or
   Sl i t  Wheel 8656
   Pr obe Changer 4128

Backl ash 28
   629nm Peak +27. 00
   Test ed +26. 61
   Top Fl uor escence    B=+0. 00037734 C=- 1. 17780030
   Bot t om Fl uor escence B=- 0. 00088149 C=- 0. 58775091

Cube Scanner s Mi n Max
   Top Lower 32 32
   Top Upper 27 27
   Bot t om 26 26

Al pha Laser  Modul e 1030201  Ver si on 2. 05. 0 
   Cur r ent  DAC 114
   PD Thr eshol d 0000, 0118
   St at us 0005 * TEC DI SABLED*

I NCUBATI ON

Temper at ur e Set poi nt :  37. 0  Cur r ent  Aver age:  37. 0   A/ D Test :  PASS  

Zone 1:  37. 0  Mi n:  36. 9  Max:  37. 1   Range:  PASS  Ther mi st or :  PASS  
Zone 2:  36. 9  Mi n:  36. 9  Max:  37. 1   Range:  PASS  Ther mi st or :  PASS  
Zone 3:  36. 9  Mi n:  36. 9  Max:  37. 1   Range:  PASS  Ther mi st or :  PASS  
Zone 4:  37. 0  Mi n:  36. 9  Max:  37. 0   Range:  PASS  Ther mi st or :  PASS  

0000

Di spenser  1:  005. 3, 010. 4, 020. 4, 040. 1, 080. 0, 199. 7
Di spenser  2:  005. 3, 010. 3, 020. 5, 040. 2, 080. 1, 200. 2

Exci t at i on monochr omat or  ser i al  number :  228816  
Emi ssi on monochr omat or  ser i al  number :    228817  

Revi ewed/ Appr oved By:  ________________________   Dat e:  ________________

For  Techni cal  Suppor t

I n t he U. S. :
Bi oTek I nst r ument s,  I nc.
    Tel :  800 242 4685
    Fax:  802 654 0638

I n Eur ope:
    Bi oTek I nst r ument s GmbH
    Tel :  49( 0) 7136- 9680
    Fax:  49( 0) 7136- 968- 111

Al l  Ot her s:
    Tel :  802 655 4040
    Fax:  802 654 0638

emai l :  TAC@bi ot ek. com
Pr oduct  suppor t  cent er :  ht t p: / / www. bi ot ek. com/ ser v i ce
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